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After purchasing the PXW-X320 Solid-State
Memory Camcorder, before operating, it is
necessary to set the area of use.

(Unless this setting is made, the camcorder will
not operate.)

For details of these settings, see “Setting the Area of
Use” (page 35).

Before attaching/removing optional components or
accessories to/from the PXW-X320 (referred to as “the
camcorder”), be sure to turn the power of the camcorder
off.



Locations and Functions
of Parts and Controls

Power Supply

Adaptor connector
(see page 10)

LIGHT switch

AUTO: When the POWER switch of the video
light is in the on position, the video light is
turned on automatically while the camcorder
is recording.

MANUAL: You can turn the video light on or off
manually, using its own switch.

When the camcorder is set for recording in Picture Cache
mode, it is not possible to turn on the light before
operation to start recording is carried out (or while data
is being stored in memory).

POWER switch

DC IN (DC power input) connector
(XLR type, 4-pin, male)

1 DC OUT 12V (DC power output)
connector (4-pin, female)

Supplies power for an optional WRR-860C/861/

862 UHF Synthesized Diversity Tuner

(maximum 0.5 A).

Do not connect any equipment other than the UHF
synthesized diversity tuner.

Battery attachment shoe

Attach a BP-L80S Battery Pack. Alternatively,
you can attach an AC-DN2B/DN10 AC Adaptor
to operate the camcorder on AC power supply.

For details, see“Preparing a Power Supply”
(page 29).

For your safety, and to ensure proper operation of the
camcorder, Sony recommends the use of the BP-L80S
Battery Pack.

Adaptor connector

Enables connection of a CA-FB70/TX70 HD
Camera Adaptor or an HDCA-702 MPEG TS
Adaptor. To connect an adaptor, remove the
cover from the connector and install the optional
CBK-CEO1 50 Pin Interface and Digital
Extender.



Accessory Attachments

Shoulder strap fitting (see page 42)
Accessory shoe (see page 42)

Viewfinder front-to-back positioning
lever

B Viewfinder left-to-right positioning ring
(see page 30)

Viewfinder attachment shoe

[ VF (viewfinder) connector (26-pin,
rectangular)

VF (viewfinder) connector (20-pin,
round)

Connect the cable of the optional DXF-C50WA

or DXF-20W viewfinder.

For connecting the DXF-C50WA, optional parts are

required (see page 34).

Bl Lens mount securing rubber

After locking the lens in position using the lens
locking lever, fit this rubber over the lower of the
two projections. This fixes the lens mount,
preventing it from coming loose.
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El Viewfinder front-to-back positioning
knob (LOCK knob) (see page 30)

Hi Fitting for optional microphone holder
(see page 39)

Shoulder pad

Raise the shoulder pad fixing lever to adjust the
position in the front-to-rear direction (see

page 43).

LIGHT (video light) connector (2-pin,
female)

A video light with a maximum power

consumption of 50 W, such as the Anton Bauer

Ultralight 2 or equivalent can be connected (see

page 42).

Lens cable clamp

MIC IN (microphone input) (+48 V)
connector (XLR type, 5-pin, female)
The power (+48 V) is supplied via this connector.

LENS connector (12-pin)

When connecting or disconnecting the lens cable to this
connector, power off the camcorder first.

16| Tripod mount

Lens mount (special bayonet mount)

Consult a Sony service representative for
information about available lenses.

The auto iris function does not operate when a
lens with 7-pin camera connector is attached.

B Lens locking lever

After inserting the lens in the lens mount, rotate
the lens mount ring with this lever to lock the lens
in position.

After locking the lens, be sure to use the lens
mount securing rubber to prevent the lens from
becoming detached.

[l Lens mount cap

Remove by pushing up the lens locking lever.
When no lens is mounted, keep this cap fitted for
protection from dust.



Operating and Connectors Section

Front

REC START (recording start) button
The effect is the same as that of the REC button
on the lens.

SHUTTER switch

Set to ON to use the electronic shutter. Push to
SELECT to switch the shutter speed or shutter
mode setting. When this switch is operated, the
new setting appears on the viewfinder screen for
about three seconds.

For details, see “Setting the Electronic Shutter”
(page 51).

When shutter is set to on while the flashband reduce
function is set to on, the flashband reduce function is set
to off and the FBR indication on the display disappears.
‘When shutter is set to off, the flashband reduce function
is set to on and the FBR indication appears on the
display.

FILTER selector

When this selector is used, the new setting
appears on the viewfinder screen for about three
seconds.
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FILTER ND filter

selector setting

1 CLEAR

2 17, ND (attenuates light to
approximately 1/4)

3 1/,6 ND (attenuates light to
approximately !/;4)

4 1764 ND (attenuates light to

approximately g,)

You can change the “MAINTENANCE” menu
setting so that different white balance settings can
be stored for different FILTER selector positions.
This allows you to automatically obtain optimum
white balance for the current shooting conditions
in linkage with the filter selection.

For details, see “Adjusting the White Balance”
(page 49).

1 MENU knob
Changes the item selection or a setting within the
menu (see page 110).

AUTO W/B BAL (automatic white/
black balance adjustment) switch

WHITE: Adjust the white balance automatically.
If the WHITE BAL switch (see page 14) is
set to A or B, the white balance setting is
stored in the corresponding memory. If the
WHITE BAL switch is set to PRST, the
automatic white balance adjustment function
does not operate.

BLACK: Adjust the black set and black balance
automatically.

You can use the AUTO W/B BAL switch even

when the ATW (Auto Tracing White Balance)

function is operating.

If you push the switch to the WHITE side once

more during the automatic white balance

adjustment, the adjustment is cancelled and the

white balance setting returns to the original

setting.

If you push the switch to the BLACK side once

more during the automatic black balance

adjustment, the adjustment is cancelled and the

black balance setting returns to the original

setting.

@ MIC (microphone) LEVEL control (see
page 56)



Right side (near the front)
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ASSIGN. (assignable) 1/2/3 switches
You can assign the desired functions to these
switches on “OPERATION” > “Assignable SW”
in the setup menu (see page 158).

The ASSIGN.1/3 switches are provided with an
indicator to show whether a function is assigned
to the switch (ON) or not (OFF).

COLOR TEMP. (color temperature)
button

You can also use this button as an assignable

switch (see page 159).

ALARM (alarm tone volume
adjustment) knob
Controls the volume of the warning tone that is
output via the built-in speaker or optional
earphones. When the knob is turned to the
minimum position, no sound can be heard.
However, if “MAINTENANCE” > “Audio” >
“Min Alarm Volume” in the setup menu is set to
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“Set,” the alarm tone is audible even when this
volume control is at the minimum position.

Maximum

Minimum

1 MONITOR (monitor volume
adjustment) knob

Controls the volume of the sound other than the

warning tone that is output via the built-in speaker

or earphones. When the knob is turned to the

minimum position, no sound can be heard.

MONITOR (audio monitor selection)
switches

By means of combinations of the two switches,

you can select audio that you want to hear through

the built-in speaker or earphones.

Position of lower switch: CH-1/2

Position of upper Audio output

switch

CH-1/CH-3 Channel 1 audio

MIX Channels 1 and 2 mixed
audio (stereo) ¥

CH-2/CH-4 Channel 2 audio

Position of lower switch: CH-3/4

Position of upper Audio output

switch

CH-1/CH-3 Channel 3 audio

MIX Channels 3 and 4 mixed
audio (stereo) ¥

CH-2/CH-4 Channel 4 audio

a) By connecting stereo headphones to the EARPHONE
jack, you can hear the audio in stereo.
(“MAINTENANCE” > “Audio” > “Headphone Out”
in the setup menu must be set to “Stereo.”)

E ASSIGN. (assignable) 0 switch

You can assign the desired function to this switch
on “OPERATION” > “Assignable SW” in the
setup menu (see page 158).

This is a momentary type switch. Each press of
the switch turns the function assigned to this
switch on or off.

GAIN selector
Switches the gain of the video amplifier to match
the lighting conditions during shooting. The gains



corresponding to the L, M, and H settings can be
selected on “OPERATION” > “Gain Switch” in
the setup menu (see page 123).

When this switch is adjusted, the new setting
appears on the viewfinder screen for about three
seconds.

El OUTPUT/DCC (output signal/dynamic
contrast control) switch

BARS: Output the color bar signal.

CAM: Output the video signal being shot. When
this is selected, you can switch DCCD on and
off.

1) DCC (Dynamic Contrast Control):

Against a very bright background with the iris opening
adjusted to the subject, objects in the background will
be lost in the glare. The DCC function will suppress
the high intensity and restore much of the lost detail. It
is particularly effective in the following cases.
 Shooting people in the shade on a sunny day
 Shooting a subject indoors, against a background
through a window
* Any high contrast scene

E WHITE BAL (white balance memory)
switch

PRST: Adjust the color temperature to the preset
value (the factory default setting: 3200K).
Use this setting when you have no time to
adjust the white balance.

A or B: Recall the white balance adjustment
settings already stored in A or B. Push the
AUTO W/B BAL switch (see page 12) on
the WHITE side, to automatically adjust the
white balance, and save the adjustment
settings in memory A or memory B.

B (ATW D): When this switch is set to B and
“OPERATION” > “White Setting” > “White
Switch<B>" is set to “ATW” in the setup
menu, ATW is activated.

You can use the AUTO W/B BAL switch
even when ATW is in use.

When this switch is adjusted, the new setting

appears on the viewfinder screen for about three

seconds.

1) ATW (Auto Tracing White Balance): The white

balance of the picture being shot is adjusted
automatically for varying lighting conditions.

MENU ON/OFF switch

This switch is used to display the menu on the
viewfinder screen or the test signal screen. Each
time the switch is pushed down, the menu screen
is turned on and off. The function of this switch is

the same as that of the MENU button in the
thumbnail screen operations section.

STATUS ON/SEL/OFF (menu display
on/page selection/display off) switch
MENU CANCEL/PRST (preset)/
ESCAPE switch

When the menu is not displayed, this switch

functions as the STATUS ON/SEL/OFF switch.

When the menu is displayed, the switch functions

as the MENU CANCEL/PRST/ESCAPE switch.

(To use the switch, open the cover.)

Use the STATUS ON/SEL/OFF switch in the

following way.

ON/SEL: Each time this switch is pushed
upward, a window to confirm the menu
settings and status of the camcorder appears
on the viewfinder screen (see page 60). Each
page is displayed for about 10 seconds.

OFF: To clear the page immediately after
display, push this switch down to the OFF
position.

Use the MENU CANCEL/PRST/ESCAPE

switch in the following way.

CANCEL/PRST: Pushing this switch up to this
position after a setting is changed in the setup
menu displays the message to confirm
whether the previous settings are cancelled.
Pushing this switch up to this position again
cancels the previous settings.

Pushing this switch up to this position before
a setting is changed in the setup menu or after
a setting change is cancelled in the setup
menu displays the message to confirm
whether the setting is reset to the initial
value. Pushing this switch up to this position
again resets the settings to the initial value.

ESCAPE: Use this switch when the menu page,
which has a hierarchical structure, is opened.
Each time the switch is pushed to this
position, the page returns to one stage higher
in the hierarchy.

Switch cover



Right side (near the rear)
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Built-in speaker

The speaker can be used to monitor E-EV) sound

during recording, and playback sound during

playback. The speaker also sounds alarms to

reinforce visual warnings (see page 181).

If you connect earphones to the EARPHONE

jack, the speaker output is suppressed

automatically.

1) E-E: Abbreviation of “Electric-to-Electric”. In E-E
mode, video and audio signals input to the camcorder
are output after passing through internal electric
circuits only. This can be used to check input signals.

Monochrome LCD panel

Displays remaining battery capacity, remaining
media capacity, audio levels, time data, and so on
(see page 20).
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WARNING indicator (see page 181)

] ACCESS lamp
Lights up in blue when data is written to or read
from the recording media.

Protective cover of the audio control
section (see page 16)

E Protective cover of the thumbnail
screen operations section (see page 16)

F REYV (fast reverse) button and
indicator

The playback speed changes in the order x4 —

x15 — x24 with each press of the button. The

indicator lights during high-speed playback in the

reverse direction.

El PLAY/PAUSE button and indicator
Press this button during playback to pause,
outputting a still image. At this time the indicator
flashes at a rate of once per second.

Pressing the F REV or F FWD button during
playback or pause starts high speed playback in
the forward or reverse direction.

E] F FWD (fast forward) button and
indicator

The playback speed changes in the order x4 —

x15 — x24 with each press of the button. The

indicator lights during high-speed playback in the

forward direction.

] PREV (previous) button

This jumps to the first frame of the current clip.
If you press this together with the F REV button,
the jump is to the first frame of the first recorded
clip on the recording media.

If you press this button twice in rapid succession,
the jump is to the first frame of the last preceding
clip (or the first frame of the current clip when no
preceding clips exist).

STOP button

NEXT button

This jumps to the first frame of the next clip.

If you press this together with the F FWD button,
the jump is to the first frame of the last recorded
clip on the recording media.



EXPAND (expand function) button

If you press this button when the thumbnail
screen is displayed, the duration of the selected
clip is divided into fractions, and the first frame of
each of the divisions is shown in a further
thumbnail display (expand function). For an HD
recorded MP4 clip, its duration is divided into 12.
If an SD recorded AVI clip comprises multiple
files, the divisions are displayed for the individual
files.

For MP4 clips, each time you press this button the
divisionis repeated. Hold down the SHIFT button
and press this button to step back through the
division process.

HOLD (display hold) button

Pressing this button instantly freezes the time data
displayed in the monochrome LCD panel (the
timecode generator continues running). Pressing
this button again releases the hold.

For details about the counter display, see page 20.

RESET/RETURN button

Resets the value shown in the time counter
display in the monochrome LCD panel.
According to the settings of the PRESET/
REGEN/CLOCK switch (see page 17) and the
F-RUN/SET/R-RUN switch (see page 17), this
button resets the display as follows.

RESET/RETURN
button operation

Settings of switches

DISPLAY switch:
COUNTER

Reset the counter to

0:00:00:00.

DISPLAY switch: TC
PRESET/REGEN/
CLOCK switch:
PRESET
F-RUN/SET/R-RUN
switch: SET

Reset the timecode to
0:00:00:00.

Reset the user bit data @
to 00 00 00 00.

DISPLAY switch:
U-BIT
PRESET/REGEN/
CLOCK switch:
PRESET
F-RUN/SET/R-RUN
switch: SET

a) Of the timecode bits for every frame recorded on the
media, those bits which can be used to record useful
information for the user such as scene number,
shooting place, etc.

For details, see “Setting Time Data” (page 57).
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This button returns to the previous screen when
pressed during thumbnail screen display, expand
thumbnail screen display, or shot mark thumbnail
screen display.

M DISPLAY switch

This cycles the data displayed in the time counter

display in the monochrome LCD panel through

the sequence COUNTER, TC, and U-BIT (see

page 20).

COUNTER: Display the elapsed recording/
playback time (hours, minutes, seconds,
frames).

TC: Display timecode.

U-BIT: Display user bits data.

BACKLIGHT button

Thumbnail screen operations section and audio
control section

M[Mu
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El THUMBNAIL indicator
This lights when thumbnail screen is displayed.

THUMBNAIL button

Press this button to display the thumbnail screen
(see page 96) and to carry out a thumbnail
operation.

Press once more to return to the original display.

SET button and arrow buttons

Use these buttons to make timecode and user bit
settings, and for thumbnail screen operations (see
page 101).

When the menu is displayed, press this button to
select an item or to confirm the setting change.

1 MENU button

Each press of this button turns the setup menu
display on and off.



The function of this button is the same as that of
the MENU ON/OFF switch.

F-RUN/SET/R-RUN (free run/set/
recording run) switch

Selects the operating mode of the internal

timecode generator. The operating mode is set as

explained below, depending on the position of the
switch.

F-RUN: Timecode keeps advancing, regardless
of whether the camcorder is recording. Use
this setting when synchronizing the timecode
with external timecode.

SET: Sets the timecode or user bits.

R-RUN: Timecode advances only during
recording. Use this setting to have a
consecutive timecode on the recording
media.

For details, see “Setting the Timecode” (page 57).
For details, see “Setting the User Bits” (page 58).

[@ AUDIO LEVEL CH1/CH2/CH3/CH4
(audio channel 1/2/3/4 recording level)
knobs

Adjust the audio levels to be recorded on channels

1, 2, 3, and 4 when the AUDIO SELECT CH1/

CH2 and AUDIO SELECT CH 3-4 switches are

set to MANUAL.

AUDIO SELECT CH 3-4 (audio
channel 3/4 adjustment method
selection) switch

Select the audio level adjustment method for each

of audio channels 3 and 4.

AUTO: Automatic adjustment

MANUAL: Manual adjustment

El ESSENCE MARK button

By pressing this button when the thumbnail

display of a clip is on the screen, you can view the

following thumbnail display of the shot-marked

frames of that clip, depending on the item

selected in a list displayed on the screen.

All: Thumbnail display of all frames marked with
essence marks.

Shot Mark1: Thumbnail display of the frames
marked with Shot Mark 1

Shot Mark2: Thumbnail display of the frames
marked with Shot Mark 2

You can also select Shot Mark 0 and Shot Mark 3

to Shot Mark 9.
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If you have recorded clips by using planning
metadata that defined names for Shot Mark 0 to
Shot Mark 9, the defined names are displayed
instead of the above item names in the list.

El SHIFT button
Use this in combination with other buttons.

[ PRESET/REGEN (regeneration)/
CLOCK switch

Selects the type of timecode to record.

PRESET: Record new timecode on the media.

REGEN: Record timecode continuous with the
existing timecode recorded on the media.
Regardless of the setting of the F-RUN/SET/
R-RUN switch, the camcorder operates in
R-RUN mode.

CLOCK: Record timecode synchronized to the
internal clock. Regardless of the setting of
the F-RUN/SET/R-RUN switch, the
camcorder operates in F-RUN mode.

AUDIO SELECT CH1/CH2 (audio
channel 1/2 adjustment method
selection) switches

Select the audio level adjustment method for each

of audio channels 1 and 2.

AUTO: Automatic adjustment

MANUAL: Manual adjustment

AUDIO IN CH1/CH2/CH3/CH4 (audio
channel 1/2/3/4 input selection) switches

Select the audio input signals to be recorded on

audio channels 1, 2, 3 and 4.

FRONT: Audio input signals from the
microphone connected to the MIC IN
connector

REAR: Audio input signals from an audio device
connected to the AUDIO IN CH-1/CH-2
connectors

WIRELESS: Audio input signals from the UHF
portable tuner if it is installed



Left side and upper section

ASSIGNABLE 4/5 switches

You can assign the desired function to this switch
on “OPERATION” > “Assignable SW” in the
setup menu (see page 159).

Off is assigned to these switches when the
camcorder is shipped from the factory.

PC connector

Used to put this camcorder into USB connection
mode and use it as an external storage device for
a computer. When a computer without

18

ExpressCard slot is connected to this connector,
every memory card inserted in the camcorder is
recognized as a drive for that computer.

External device connector

Connect an optional CBK-WA101 Wireless

Adapter, IFU-WLM3 USB Wireless LAN

Module, or USB flash drive.

When connecting the CBK-WA101/IFU-
WLMa3: You can connect the camcorder and
computer via wireless LAN connection.

When connecting a USB flash drive: You can
record, store, or load the following data.

* Planning metadata (see page 93)
« Setting data file (see page 164)

Use this connector only for connecting the CBK-
WAI101, IFU-WLM3, USB flash drive, or USB media.
Do not connect and use a USB hub or similar products.

For details about wireless LAN connection, see
“Using Wireless LAN Connection” (page 79).

A sxs memory card slots

These two slots (A and B) can receive SxS
memory cards or other recording media (see
page 61).

ACCESS lamps

Indicate the state of slots A and B (see page 61).
You can check whether the lamps are lit even
when the slot cover is closed.

A EJECT (SxS memory card eject)
buttons (see page 61)

Slot cover
Slide to the left and right to open and close.

E SLOT SELECT (SxS memory card
select) button (see page 61).

E]l HpMI output connector

When a video monitor provided with an HDMI
signal input connector is connected to this
connector, you can monitor picture being shot
(camera picture) or playback picture.



GENLOCK IN (genlock signal input)
connector (BNC type)

This connector inputs a reference signal when the

camcorder is to be genlocked or when timecode is

to be synchronized with external equipment.

Available reference signals vary depending on the

current system frequency as shown in the

following table.

System frequency

Available reference
signals

1080/59.94i 1080/59.94i, 480/59.94i
1080/29.97P 1080/59.94i, 480/59.94i
1080/23.98P (PsF 1080/23.98PsF, 480/59.94i
output)

1080/23.98P
(Pulldown output)

1080/59.94i, 480/59.94i

720/59.94P 1080/59.941, 720/59.94P,
480/59.94i

720/29.97P 1080/59.941, 720/59.94P,
480/59.94i

720/23.98P 1080/59.941, 720/59.94P,
480/59.94i

480/59.94i 1080/59.941, 480/59.941

480/29.97P 1080/59.941, 480/59.941

1080/50i 10807501, 576/50i

1080/25P 1080/50i, 576/50i

720/50P 10807501, 720/50P, 576/501

720/25P 10807501, 720/50P, 576/501

576/50i 1080/50i, 576/50i

576/25P 1080/50i, 576/50i

(Genlock for the camera module supports
horizontal sync signals only.) Adjust the genlock
H-phase (phase of horizontal sync signal) on
“MAINTENANCE” > “Genlock” in the setup

menu.

TC IN (timecode input) connector

(BNC type)

To apply an external lock to the timecode of the
camcorder, input the reference timecode.

For details, see “Setting the Timecode” (page 57).

VIDEO OUT connector (BNC type)
The output signals can be selected either
composite video or HD-Y depending on the
setting of “OPERATION” > “Input/Output” >
“Output&i.LINK” in the setup menu.

19

TC OUT (timecode output) connector
(BNC type)

To lock the timecode of an external VTR to the

timecode of this camcorder, connect this

connector to the external VTR’s timecode input

connector.

Rear

OB
d0H O 6

J

TALLY (back tally) indicators (red)
Light up during recording. They will not light if
the TALLY switch is set to OFF. These indicators
also flash to indicate warnings (see page 15). The
tally indicator on the front of the viewfinder and
the REC indication on the viewfinder screen light
or flash in the same manner.

For details, see “Error/Warning System”
(page 181).

TALLY switch
Set to ON to activate the TALLY indicator
function.

EARPHONE jack (stereo, minijack)
You can monitor the E-E sound during recording
and playback sound during playback. When an




alarm is indicated, you can hear the alarm sound
through the earphone. Plugging an earphone into
the jack automatically cuts off the built-in
speaker.

You can select monaural or stereo on
“MAINTENANCE” > “Audio” in the setup

menu.

B3 AUDIO IN selector switches

Select the audio source you connect to the

AUDIO IN CH-1/CH-2 connectors.

LINE: When connecting a stereo amplifier or
other external audio signal source

MIC: When connecting a microphone that does
not require 48 V power supply

+48V: When connecting a microphone that
requires 48 V power supply

HD/SD SDI OUT connectors (BNC
type)

The camcorder has two HD/SD SDI OUT

connectors.

These connectors output an HDSDI or SDSDI

signal (with embedded audio). The output from

these connectors can be turned on or off, on

“OPERATION” > “Input/Output” > “SDI

Output” in the setup menu.

[@ AUDIO IN CH-1/CH-2 (audio channel
1 and channel 2 input) connectors (XLR
type, 3-pin, female)

You can connect audio equipment or a

microphone.

Bottom cover

This is provided for protecting the cables
connected to the connectors on the rear panel.
By loosening the screws which retain the cover to
the bottom of the camcorder, you can adjust the
position of the cover depending on the size and
shape of the microphone or audio cable plugs.
After adjusting the position, tighten the screws to
secure the cover.

El AUDIO OUT connector (XLR type,
5-pin, male)

Outputs the audio signals recorded on audio

channels 1 and 2 or audio channels 3 and 4.

The audio signals are selected by the MONITOR

switch.
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El REMOTE connector (8-pin)

Before connecting/disconnecting the Remote Control
Unit to/from the camcorder, be sure to turn off the
camcorder POWER switch.

M i.LINK (HDV/DV) connector (6-pin,
IEEE1394 compliant, S400)

To input and output HDV/DV streams, connect to

an HDV/DV device.

Monochrome LCD Panel
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n Timecode status indicator

NDF: Appears when non-drop-frame timecode is
selected.

EXT-LK: Appears when the internal timecode
generator is locked to an external signal input
to the TC IN (timecode input) connector.

Counter display mode

Shows the type of information selected by the
DISPLAY switch to be displayed in the time
counter display.

COUNTER: Counter values

TC: Timecode

U-BIT: User bits data

Time counter display

Switches displays of time counter values,
timecode, and user bits data, depending on the
position of the DISPLAY switch.

When the HOLD button is pressed to hold the
timecode value, the timecode is displayed in the
format shown below. When the HOLD button is
pressed again to release the hold, the timecode is
displayed in the normal format.



OOE 00!00! 00

The three dots indicates that timecode is
displayed in the hold mode.

1 HOLD indicator
Appears when the timecode generator output is
displayed in the hold mode.

Audio level indicators
Indicate the audio recording or playback levels of
channels 1 to 4.

A Lock icon
Appears when the recording media is write-
protected.

Remaining media capacity indicator
Shows bar segments indicating the remaining
capacity of recording media in the slots.

B Remaining battery capacity indicator
Shows bar segments indicating the remaining
battery capacity.
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Auto Focus Lens
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PUSH AF (auto focus) button

When the focus adjustment is in the manual
mode, by pressing this button you can use the auto
focus for an instantaneous adjustment to the
subject.

When the button is pressed, the auto focus
operates until the image is in focus, then
disengages.

Even when the FOCUS switch is set to A (auto),
by pressing this button, you can restart the auto
focus.

FOCUS switch

A (auto): The auto focus function is constantly
active. Even with the switch in the A




position, you can manually adjust the focus
by operating the focus ring.

M (manual): The manual mode allows focusing
adjustment with the focus ring.
In manual mode, auto focus adjustment is
also possible, by pressing the PUSH AF
button.

MACRO switch

When this switch is in the ON position, the macro
mode is enabled, allowing focusing over the
whole range (5 cm D to =) including the macro
range (from 5 cm D to 90 cm from the front of the
lens).

This operation is independent of whether the
focus adjustment mode is auto or manual.

In the macro range, the auto focusing speed is
lower.

1) At the wide-angle setting

B Iris ring
For manual iris adjustment, set the IRIS switch to
the M (manual) position, then turn this ring.

Zoom ring

For manual zoom adjustment, set the ZOOM
switch to the MANUAL position, then turn this
ring.

A Focus ring

Turn this ring to adjust the focus.

This ring can be turned endlessly in both
directions. The faster you turn, the faster the
focusing mechanism operates, to minimize the
amount of turning required for focusing.

When you slide the focus ring back (toward the
camcorder), the focus mode becomes Full MF
mode, in which all focus adjustments are manual
(see page 55).

Flange focal length adjustment button
Press this to adjust the flange focal length (the
distance from the lens mounting flange plane to
the focusing plane) (see page 36).

Bl Zoom control connector (8-pin)
Connecting an optional zoom servo controller
allows remote control of zooming.

El ZOOM switch
SERVO: Motorized zoom. Operate the zoom
with the power zoom lever.
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MANUAL (manual): Manual zoom. Operate the
zoom with the zoom ring.

[l PUSH AUTO button

When the IRIS switch is in the M position for
manual adjustment, press this button for an
instantaneous auto adjustment. The iris is
automatically adjusted while the button is held
down.

IRIS switch
A (auto): The iris is adjusted automatically.
M (manual): Adjust the iris with the iris ring.

Power zoom lever

This is enabled when the ZOOM switch is in the
SERVO position. Push to the W (wide) side when
you want wide-angle, and push to the T
(telephoto) side when you want telephoto.

Press the lever harder for a faster zoom action, or
softer for slower zoom action.

Notes on auto focus

« In the following cases, it may be difficult to

focus on the subject. If this does happen, use

manual focusing.

- If the subject has no contrast

- If the subject is moving rapidly

- When shooting point light sources, under
street lighting or at night

- When there are very bright objects close to the
subject

- When shooting through a glass window

If there are a number of objects within the

screen at close and far range, the focus may not

be on the intended subject. In this case, with the

subject on which you want to focus in the center

of the screen, press the PUSH AF button.

After focusing with the PUSH AF button, if you

operate the zoom or adjust the iris, the depth of

field may become shallower, losing crisp focus.

In such cases, press the PUSH AF button once

more.

If you focus at wide-angle then zoom to

telephoto, the subject may no longer be in focus.

It may take time until the image is in focus

while using the slow shutter mode.

Note on zoom speed

Depending on the shooting distance, the zoom
speed may fall as the lens approaches the
telephoto end.



RET (return video) button

You can use this as an assignable switch (see
page 161).

Use this to check the video when Lens RET is
assigned to this button (factory default setting). If
you press this after recording stops, the last few
seconds recorded appear on the viewfinder screen
(recording review) (see page 84).

Pressing this button (single click) during
recording or playback records a Shot Mark 1
mark, and double-clicking records a Shot Mark 2
mark (see page 86).

VTR button
Use this to start and stop recording. Press once to
start recording, then press once more to stop.

Viewfinder

PEAKING D CONTRAST  BRIGHT
MIRROR  DISPLAY ZEBRA  TALLY

A OECED

Connector
Connect to the VF connector (26-pin) on the
camcorder.

Slide stopper
Prevents the viewfinder from coming off the
camcorder when it is slid from side to side.
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Eyecup

1 Diopter adjustment ring
Allows for optimal focus adjustment.

Eyepiece
You can raise this up when required by the
situation.

E Viewfinder barrel
You can raise this up or rotate when required by
the situation.

Tally indicator

Lights up when recording is started by a press of
the REC START button on this camcorder, the
VTR button on the lens, or the VTR button on the
remote control unit.

When an abnormality occurs, the tally indicator
flashes to indicate a warning.

El PEAKING control

Turning this knob clockwise adjusts the picture
sharpness, and makes focusing easier. This
control has no effect on the output signals of the
camcorder.

El CONTRAST control

Adjusts the contrast of the screen. This control
has no effect on the output signals of the
camcorder.

H BRIGHT control

Adjusts the brightness of the screen. This control
has no effect on the output signals of the
camcorder.

TALLY switch

Controls the tally indicator located on the front of

the viewfinder.

HIGH: The tally indicator brightness is set to
high.

OFF: The tally indicator is disabled.

LOW: The tally indicator brightness is set to low.

ZEBRA (zebra pattern) switch
Controls the zebra pattern display on the
viewfinder screen as follows.

ON: Display a zebra pattern.

OFF: Do not display a zebra pattern.

DISPLAY switch
ON: Display text information.



OFF: Do not display text information.

MIRROR switch

The image display on the monitor screen becomes
reversed horizontally or vertically when the
viewfinder barrel is raised up or rotated.

L/R: Reverse the image horizontally.

OFF: Do not reverse the image.

B/T: Reverse the image vertically.

Viewfinder cable

Microphone holder

24

Viewfinder Screen
Display

The viewfinder screen displays not only the video
picture but also characters and messages
indicating the camcorder settings and operating
status, a center marker, a safety zone marker, etc.
When the menu screen is not displayed and the
DISPLAY switch is set to ON, the items for
which an ON setting was made with
“OPERATION” > “Super Impose” in the setup
menu or with related switches are displayed at the
top and bottom of the screen.

Not only these indications are displayed on the
viewfinder screen, but a menu setting enables
them to be output as video signals.

Top of viewfinder screen
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Extender indicator

Indicates the setting of the digital extender

function (when optional CBK-CEOLI is installed)

of this camcorder and the setting of the lens

extender.

EX: The lens extender is on.

08: The lens shrinker is on.

x2D: The digital extender function of this
camcorder is on.

Ex2D: The lens extender and the digital extender
function of this camcorder are both on.
Digital extender function can be turned on or off
by an assignable switch to which Digital Extender

is assigned.



Zoom position (when the lens is
mounted)

Indicates the zoom position of the zoom lens in

the range from 0 to 99.

Focus position (when the serial lens is
mounted)

Indicates the focus position as distance to the

subject (in units of m).

B3 Green tally indicator

Lights when the camcorder is the following

states.

* “MAINTENANCE” > “Camera Config” > “HD
SDI Remote I/F” is set to “G-Tally” in the setup
menu and a recording control signal is output
from the HD/SD SDI OUT connector.

 Green tally signal received (when a camera
adaptor is mounted on the camcorder and a
camera control unit is connected)

H Media status
Displays the name of the currently active media
slot (A or B).

6] Recording mode/operation status

indicator

Indicator Meaning

OREC Recording in progress

STBY Standby for recording

@CACHE Standby in Picture Cache mode

@INT REC Recording in progress in
Interval Rec mode

@INT STBY Standby for next recording in
Interval Rec mode

INT STBY Standby in Interval Rec mode

@FRM REC Recording in progress in Frame
Rec mode

OFRM STBY Standby for next recording in
Frame Rec mode

FRM STBY Standby in Frame Rec mode

@S&Q REC Recording in progress in Slow
& Quick Motion mode

S&Q STBY Standby in Slow & Quick
Motion mode

OCALL Being called from a connected
device

»REVIEW During recording review
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Wireless receiver reception level

When a wireless receiver is installed in the

camcorder, “W” appears together with the

following four segment reception level indicators
for each of the channels (1 to 4) that can be used
by the receiver.

In normal situation: The number of white
segments indicates the strength of the signal
level.

Muting (for an analog receiver) or error rate
aggravation (for a digital receiver): The
number of gray segments indicates the
strength of the signal level.

Reception level over peak: “P” is displayed
instead of the indicators.!)

Tuner battery is low: The channel number and
indicator of the corresponding channel
flash. D)

1) When an optional DWR-S02D is used

Bl Battery remaining/voltage display

Type of power  Indicator

source

InfoLithium Remaining battery capacity

battery icon and remaining recording
time

Anton Bauer Remaining battery capacity (%

battery indication)

Other type than  Input voltage

above

El External power input
Appears when power is supplied from an external
power source connected to the DC IN connector.

im ALAC (automatic lens aberration
correction) status

Appears when “ALAC” (see page 145) of the

MAINTENANCE menu is set to “AUTO,” and

an ALAC compatible lens is attached to the

camcorder.

Color temperature

Displays a color temperature calculated from the

gain of R and B, in the range 1.5 K to 50.0 K (in

steps of 0.1 K). The +/- signs may be displayed

depending on the “Offset White” setting (see

page 127).

No display: “Offset White” is “Off.”

+: The value of “Offset White” is greater than
3200K.



—: The value of “Offset White” is less than
3200K.

Number of system lines

Indicates the number of system lines (1080/720/
576/480) of video currently being recorded or
played back.

Video format

Indicates the video format (see page 44).

The video aspect ratio (16:9 or 4:3) can also be
displayed when the recording format is set to
DVCAM.

Depth of field indicator (when the serial
lens is mounted)
Error/warning indicator
A bar indicates the depth of field. The display unit
is meters or feet, as selected on “OPERATION”
> “Display On/Off” > “Lens Info” in the setup
menu.
An error or warning message is displayed here
depending on the situation.

Under this area, you can also display the name of
the next clip to be recorded (see page 130).

Special recording mode indicator

The following is displayed when the camcorder is
in a special recording mode.

* Frame Rec (frame recording mode)

« Interval Rec (interval recording mode)

¢ S&Q Motion (Slow & Quick Motion mode)

Special recording mode settings
indicator

Appears when the camcorder is in a special

recording mode.
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Bottom of viewfinder screen

B
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TLCS iris control mode

Icon TLCS control mode

Backlight mode

Standard mode

S1D

Spotlight mode

[

Focus adjustment mode (when the auto
focus lens is mounted)

Indicates the current focus adjustment mode of

the camcorder.

* AF (Auto Focus mode)

¢ MF (Manual Focus mode)

* MF* (Manual Focus mode when the MF Assist
function is on)

¢ Full MF (Full Manual Focus mode)

External device control

“Rec2” is displayed when “MAINTENANCE” >
“Camera Config” > “HD SDI Remote I/F” is set
to “Chara” in the setup menu and a recording
control signal is output from the HD/SD SDI
OUT connector.

“Rec2-P” is displayed when “MAINTENANCE”
> “Camera Config” > “HD SDI Remote I/F” is set
to “Para Rec” in the setup menu and synchronized
recording is performed with a compatible device.

Bl Operation status of connected i.LINK

device
Indicator Meaning
OREC i[[I] HDV recording in progress
STBY &[0 Standby for HDV recording




Indicator Meaning
OREC i T DV recording in progress
STBY i IMA Standby for DV recording

Video level indicator [M]

Suitable ND filter indicator

Clip uploading status indicator
An indication is displayed together with an
appropriate ND filter position number when the
light level of the subject is too high or too low.
Indicates the status for clip uploading when an
optional CBK-WA101 Wireless Adapter is
connected.

@ Timecode

Caution message
Indicates the elapsed recording/playback time,
timecode, user bits data or other information
selected by the DISPLAY switch (see page 16).
Also indicates a caution message when caution is

required such as when you try to change settings.

Brightness level
Indicates the average brightness level (%) of the
detection area.

Bl External input source
Indicates the type of external input signal (HDV)
to be recorded.

El External input setting indicator
Indicates “EXT” when an external input is
recorded.

Media remaining space indicator for
the CBK-WA101 Wireless Adapter (not
supplied)

USB media icon indicator (see page 177)
or status indicator of the CBK-WA101
Wireless Adapter (not supplied)

Electric color temperature filter

Appears when the CC 5600K function is set to on.

Filter indicator

Indicates the currently selected ND filter position
number (see page 12).

When Electrical CC is assigned to an assignable
switch, the electrical filter position (A/B/C/D)
appears to the right of the ND filter position (1 to
4).
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White balance memory

Indicates the currently selected white balance

automatic adjustment memory.

ATW: ATW (Auto Tracing White Balance) mode

W:A: Memory A mode

W:B: Memory B mode

W:P: Preset mode

3200: When the assignable switch to which Color
Temp SW 3200K has been assigned is on

4300: When the assignable switch to which Color
Temp SW 4300K has been assigned is on

5600: When the assignable switch to which Color
Temp SW 5600K has been assigned is on

6300: When the assignable switch to which Color
Temp SW 6300K has been assigned is on

Gain value
Indicates the gain value (in dB) of the video
amplifier, as set by the GAIN selector.

M8 Recording status indicator

When “OPERATION” > “Super Impose” >
“Super (Rec Status Indicator)” is set to “On” in
the setup menu, » marks are displayed as the
recording proceeds.

Shutter

Indicates the shutter speed or the shutter mode.
For details, see “Setting the Electronic Shutter”
(page 51).

iE Audio level meters
Indicate the audio levels of channel 1 and channel
2.

Bl Remaining media capacity

Indicates the recording time remaining for each of
the media loaded in the slots. The available time
for recording with the current video format
(recording bit rate) is calculated according to the
remaining space of each media and indicated in
time units of minutes. A lock icon appears if the
media is write-protected.

Histogram
Shows a pixel distribution of video luminance
(HD mode only).

Flashband reduce status indicator
Appears when “Flashband Reduce” (see
page 125) of the OPERATION menu is set to



“On” and the flashband reduce function is
activated.

Iris position indicator (when the lens is
mounted)

Indicates the iris position and the setting for iris

override (reference value for the lens iris) (see

page 53).

The iris override setting is indicated by four

segments indicator as follows.

Reference Indicator

value
+0.25 Lower left segment is lit
u gray.
+0.5 ] Left two segments are lit
u gray.
+0.75 u Left two segments and lower
L right segment are lit gray.
+1 HE  All segments are lit gray.
1]
-0.25 Lower left segment is lit
o white.
-0.5 O Left two segments are lit
O white
-0.75 O Left two segments and lower
oo right segment are lit white.
-1 OO  All segments are lit white.
oo
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%] Preparations

Preparing a Power
Supply

For safety, use only the Sony battery packs and

AC adaptors listed below.

* BP-L80S Lithium-ion Battery Pack

* AC power using the AC-DN2B/DN10 AC
Adaptor

The life expectancy of the AC adapter and the
electrolytic capacitor is about 5 years under
normal operating temperatures and normal usage
(8 hours per day; 25 days per month). If usage
exceeds the above normal usage frequency, the

life expectancy may be reduced correspondingly.

Using a Battery Pack

Press the battery pack against the back of the
camcorder, aligning the line on the side of the
battery pack with the line on the camcorder. Then
slide the battery pack down until its “LOCK”
arrow aligns with the line on the camcorder.

To detach the battery pack, pull the battery pack
up by holding the release button in.

The battery pack operating time depends on the
frequency of use of the battery pack, and the ambient
temperature when used.

Before use, charge the battery pack with a charger
suitable for each battery.

For details on the battery charging procedure, refer
to the battery charger operation manual.

Note on using the battery pack

A warm battery pack may not be able to be fully
recharged.

« If the battery pack is not attached correctly, the
terminal may be damaged.
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* During recording and playback (while the ACCESS
lamp on the right-side panel is lit in blue and the
ACCESS lamp in the card slot section is lit in orange),
be careful never to remove the battery pack.

* Make sure to power the camcorder off before replacing
the battery pack.

Using AC Power

Mount an AC-DN2B/DN10 on the camcorder in
the same way as a battery pack, then connect to
the AC power supply.

The AC-DN2B/DN10 can supply up to 100 W of
power.



Attaching the Viewfinder

When the viewfinder is attached, do not leave the
camcorder with the eyepiece facing the sun.
Direct sunlight can enter through the eyepiece, be
focused in the viewfinder and cause fire.

Attaching the Supplied Viewfinder
[ Note |

When attaching the viewfinder, take note of the

following points.

« Be sure to power off the camcorder before coupling the
viewfinder connector to the camcorder’s VF connector
(26-pin). If you make this connection when the
camcorder power is on, the viewfinder may not
function properly.

Couple the viewfinder connector firmly to the
camcorder’s VF connector (26-pin). If the coupling is
loose, noise may appear on the video or the tally
indicator may not operate properly.

1 @ Loosen the viewfinder left-to-right
positioning ring, @ attach the
viewfinder to the viewfinder fitting
shoe, and ® tighten the viewfinder left-
to-right positioning ring.

Slide stopper

Left-to-right
positioning
ring

2 Couple the viewfinder connector to the
VF connector (26-pin).

VF connector (26-pin)

Detaching the viewfinder

You can detach the viewfinder by following the
attaching procedure in reverse order. But there is
an additional action to take: when detaching the
viewfinder from the fitting shoe, pull up the
stopper (see page 30).

Adjusting the Viewfinder Position

To adjust the viewfinder left-to-right position,
loosen the left-to-right positioning ring, and to
adjust the front-to-back position, loosen the front-
to-back positioning knob.

Viewfinder left-to-right positioning ring

Viewfinder front-to-back positioning knob



Adjusting the Viewfinder Angle

You can adjust the angle of the viewfinder.

To reverse the display (image/text indication)
vertically

The viewfinder can be rotated as much as 180
degrees toward the direction facing the subject.
When you do this, the picture and other
information displayed in the viewfinder appear
upside down.

To restore the normal display, set the MIRROR

switch on the rear panel of the viewfinder to B/T.

Lifting Up the Viewfinder Barrel
and Eyepiece

You can view the LCD screen inside the
viewfinder or its mirrored image by lifting up the
viewfinder barrel or the eyepiece.

This section describes how to lift up the
viewfinder barrel and detach it. The eyepiece can
also be lifted up and detached in the same way.

To raise up the viewfinder barrel

Push the clip on the bottom to release and flip up
the viewfinder barrel.

It locks at the 120-degree position.

Normally use it in the locked position.

Although you can open it farther from the lock
position, you must return it to the closed position
to lock it at the 120-degree position again.
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To detach the viewfinder barrel

s

1 Push the clip on the bottom to release.
2 Flip up the viewfinder barrel.

3 Slide the knob on the top to the opposite
side of the viewfinder barrel.

4 Detach the viewfinder barrel by
horizontally sliding it.

To reverse the display (image/text indication)
horizontally

By setting the MIRROR switch on the rear panel
of the viewfinder to L/R, you can reverse the
picture and other information displayed in the
viewfinder horizontally.

Adjusting the Viewfinder Focus
and Screen

To adjust the viewfinder focus

Turn the diopter adjustment ring until the
viewfinder image is sharpest.

Diopter adjustment ring

You can also attach a commercially available
protection filter, close-up lens, etc. that is 52 mm
in diameter.

To adjust the viewfinder screen

Adjust the brightness, contrast, and peaking of the
viewfinder screen with the controls shown below.
Outlines: Adjust using the PEAKING control.
Contrast: Adjust using the CONTRAST control.
Brightness: Adjust using the BRIGHT control.

(1] 2] 3]

PEAKING CONTRAST BRIGHT
CNC N C

MIRROR DISPLAY  ZEBRA TALLY

LR o ol HIGH
O;; a© 2O @;5

© PEAKING control
© CONTRAST control
© BRIGHT control




i - 3 Attach the BKW-401 with th lied
Using the BKW-401 Viewfinder ach the with the supplie

! bolts.
ROtatlon BrackEt Bolts supplied with the BKW-401

By fitting an optional BKW-401 Viewfinder
Rotation Bracket, you can rotate the viewfinder
out of the way so that your right leg does not hit
the viewfinder while you are carrying the
camcorder.

1 Loosen the front-to-back viewfinder
positioning levers and the front-to-back
viewfinder positioning knobs, and then
pull the viewfinder slide assembly
forward.

4 Adjust the front-to-back position so
that the arm of the BKW-401 does not
touch the handle when it is raised.

Adjust position so that arm
does not touch handle

2 Using a 2.5 mm diameter hexagonal
wrench, detach the viewfinder slide
assembly.

Bolts with
hexagonal
hole

Viewfinder slide assembly
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Attaching a 5-inch Electronic Viewfinder

You can attach an optional DXF-C50W A (5-inch) Electronic Viewfinder. To attach it, an Accessory Shoe
Kit (service part number: A-8274-968-B) is required.

For details, contact a Sony sales or service representative.

It is not possible to use the supplied viewfinder and a 5-inch viewfinder at the same time.
Remove the cover of the grip, and attach the shoe and stopper screw of the Accessory Shoe Kit.

Fixing ring

VF cable

Guide plate

a) Supplied with the Accessory Shoe Kit
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Setting the Area of Use

When the camcorder is used for the first
time

You cannot use the camcorder without setting the
area of use.

To set the area of use

1 Set the POWER switch to the ON
position.
The screen for setting the area of use appears
in the viewfinder.

2 Press the MENU knob.
The settings for selectable areas of use are
displayed.

3 Turn the MENU knob to select the
desired area of use.

Setting Area of use

NTSC Area NTSC area
(for areas other than
Japan) ¥

NTSC({J) Area  NTSC area
(Japan) b)

PAL Area PAL area ©

a) The composite signal output from this
camcorder is an NTSC signal with a black setup
(7.5 IRE). The system frequency is 59.94i.

b) The composite signal output from this
camcorder is an NTSC signal with no black
setup. The system frequency is 59.94i.

¢) The composite signal output from this
camcorder is a PAL signal. The system
frequency is 50i.

4 Set the following items.
* Time Zone
* Date/Time

For details, see “Basic Setup Menu
Operations” (page 110).

9 Turn the MENU knob to select
“Finish”, then press the MENU knob.
The camcorder is now ready for use.
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Setting the Date/Time of
the Internal Clock

You can set or change the date and time of the
internal clock. The date and time set are reflected
in the timecode.

For menu operations, see “Basic Setup Menu
Operations” (page 110).

1 Select “MAINTENANCE?” > “Clock
Set” > “Date/Time” in the setup menu.

2 Press the MENU knob.
The Date/Time setting window appears.

3 Turn the MENU knob to display the
desired value, and press the knob.
The selection shifts to the next item on the
right.

4 To continue the remaining settings,
repeat step 3.

5 Making sure that “SET” is selected,
press the MENU knob.
The internal clock is set with the date and
time set in steps 3 and 4.

To cancel the setting

Before executing step 5, push the MENU
CANCEL/PRST/ESCAPE switch up to the
CANCEL/PRST side.



Mounting and Adjusting
the Supplied Lens

Always power the camcorder off before mounting or
removing a lens.

For information about using a lens other than the
supplied lens, refer to the operation manual for the
lens.

1 Push the lens locking lever up and
remove the lens mount cap from the
lens mount.

2 Align the center pin on the lens with the
center slot in the lens mount, and insert
the lens into the mount.

3 Holding the lens in place, push the lens
locking lever down to lock the lens.

If the lens is not firmly locked, it may come
off while the camcorder is being used. This
could cause a serious accident. Make sure the
lens is firmly locked. It is recommended that
the lens mount securing rubber be put on the
lens locking lever as illustrated in the
following diagram.

Lens mount
securing rubber

If you have attached an aberration correction
lens

The aberration correction function is activated
automatically. Starting the camcorder with an
aberration correction lens may require more time
than normally because of data loading at start-up.
The lens supplied with the camcorder is an
aberration correction lens. Contact a Sony service
representative for information about other
aberration correction lenses.

Adjusting the Flange Focal Length

If the lens does not stay in focus properly as you
zoom from telephoto to wide angle, adjust the
flange focal length (the distance from the plane of
the lens mounting flange to the imaging plane).
Make this adjustment just one time after
mounting or changing the lens.

When carrying out the adjustment, use the
supplied flange focal length adjustment chart as
the subject.




If you use a subject with insufficient contrast, or move
the camcorder or subject during adjustment, this will
cause an adjustment error.

Place the subject (the flange focal length adjustment
chart) so that it appears at the center of the screen at the
telephoto end. Arrange so that no nearby object (no
object closer to the camera than the chart) enters the
screen at the wide-angle end.

Carrying out the adjustment

When using the auto focus lens

With the lens supplied with the camcorder, zoom
and focus operations automatically adjust the
flange focal length.

1 Open the iris, position the supplied
flange focal length adjustment chart
approximately 3 meters (10 ft) away
from the camcorder, and arrange the
lighting to obtain a satisfactory video
output.

2 Set the ZOOM switch to SERVO
(power zoom mode).

3 Hold down the flange focal length
adjustment button for 3 seconds.
The flange focal length adjustment starts.

During adjustment

The message “AUTO FB Adjust
EXECUTING” appears on the viewfinder
screen.

If the adjustment completes correctly
The message on the viewfinder screen
changes to “Auto FB Adjust: OK.”

If the flange focal length adjustment does
not complete correctly

Check the subject and lighting conditions, and
repeat the adjustment.

When using a non-auto focus lens
1 Set the iris to manual.

2 Open the iris, position the supplied
flange focal length adjustment chart
approximately 3 meters (10 ft) away
from the camcorder, and arrange the
lighting to obtain a satisfactory video
output.
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Loosen the fixing screws on the F.f or
F.B ring (flange focal length adjustment
ring).

Use manual or power zoom to set the
lens to telephoto.

Point the camcorder at the chart by
turning the focus ring and focus on it.

Set the zoom ring to wide angle.

Turn the F.f or F.B ring until the chart
is in focus, being careful not to disturb
the focus ring.

Repeat steps 4 to 7 until the chart stays
in focus all the way from wide angle to
telephoto.

Tighten the F.f or F.B ring fixing
screws.



Preparing the Audio
Input System

Connecting a Microphone to the
MIC IN Connector

Attach the supplied microphone to the
microphone holder of the supplied viewfinder.

1 Loosen the screw and open the
microphone holder clamp.

Microphone holder clamp

On how to perform this operation, refer to the
operation manual for the microphone.

3 Plug the microphone cable into the MIC
IN connector, then set the AUDIO IN
switch for the channel on which you
want to record the audio from this
microphone to FRONT.

2 Place the microphone in the
microphone holder.

@ Wind the microphone spacer around
the microphone, while peeling off the
protective sheets on both sides of the
microphone spacer.

@ Place the microphone in the holder so
that “UP” is at the top.

(® Close the microphone holder.

®@ Tighten the screw.

4 Secure the microphone cable with the
cable clamp.

38



Connecting Microphones to the
AUDIO IN Connectors

You can connect up to two monaural
microphones to the AUDIO IN CH-1/CH-2
connectors, using an optional CAC-12
Microphone Holder.

The following is the procedure for attaching an
electret condenser microphone such as the
ECM-674/678.

On how to attach the CAC-12, refer to the operation
manual for the CAC-12.

1 Attach the electret condenser
microphone.

@ Loosen the ball joint lock lever.

(® Wind the microphone spacer (sheet
type, supplied with the microphone)
around the microphone, while peeling
off the protective sheets on both sides
of the microphone spacer.

® Place the microphone in the holder so
that “UP” is at the top.

@® Close the microphone holder.

® Tighten the screw.

(® Position so that the microphone does
not interfere with the viewfinder and

tighten the ball joint lock lever.

Microphone
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Connect the microphone cable to the
AUDIO IN CH-1 or CH-2 connector.

Set the switches as follows.

* Set the AUDIO IN selectors indicated
below, depending on the power supply type
of the microphone.

Internal power supply: MIC
External power supply: +48V

« Setthe AUDIO IN CH1/CH2 switch for the
channel to which the microphone is
connected to REAR.

© AUDIO IN selector switches

@ Monaural microphone

© AUDIO IN CH1/CH2 switches

O To AUDIO IN CH-1 or CH-2 connector

Switch the input level to match the
sensitivity of the microphone used.
Switch the input level by changing the setting of
“MAINTENANCE” > “Audio” > “Rear MIC
CHI1/CH?2 Ref” in the setup menu (factory
default setting is “~60 dB”). For details, see
page 140.



« If the input level on the camcorder is not at an
appropriate setting for the microphone sensitivity, loud
sounds may be distorted, and the signal-to-noise ratio
may be affected.

* Inorder for the AUDIO IN CH-1 and CH-2 connectors
on the camcorder to be able to provide a phantom 48 V
power supply, female XLR connectors (3-pin) are
fitted. If the microphone cable has a female connector,
use an adaptor.

* When you detach a CAC-12 Microphone Holder, be
sure to put the two screws back into their original
places.

Attaching a UHF Portable Tuner
(for a UHF Wireless Microphone
System)

To use a Sony UHF wireless microphone system,

power the camcorder off and then fit one of the

following UHF portable tuners.

* DWR-S02D Digital Wireless Receiver

* WRR-855S UHF Synthesized Tuner Unit

* WRR-860C/861/862 UHF Synthesized
Diversity Tuner

For details of these units, refer to the operation
manuals for them.

The optional WRR Mount Bracket (service part number:
A-1999-908-B) is required to fit the WRR-862.

For details, contact a Sony sales or service
representative.

To fit the DWR-S02D or WRR-855S

1 Remove the four fixing screws holding
the cover of the portable tuner/receiver
housing slot located in the rear of the
camcorder, to remove the cover.

2 Insert the DWR-S02D or WRR-855S
into the housing slot, and fasten the four
fixing screws.

DWR-S02D or WRR-855S

ﬂ

3 Set the AUDIO IN selector for the
channel to which you want to input
audio signal to WIRELESS (see
page 17).



Tripod Mounting

1 Attach the optional VCT-14/U14
Tripod Adaptor to the tripod.

2 Mount the camcorder on the tripod
adaptor.

Slide the camcorder forward along the
groove in the adaptor until it clicks.

3 Make sure that the camcorder is
securely attached by moving it back and
forth.

To remove the camcorder from the tripod
adaptor

Hold down the red button and pull the lever in the
direction of the arrow.

Red button

Lever
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The tripod adaptor pin may remain in the engaged
position even after the camcorder is removed. If this
happens, press the red button and move the lever as
shown above until the pin returns to the stowed position.
If the pin remains in the engaged position, you will not
be able to mount the camcorder on the tripod adaptor.



Connecting a Video
Light

With this camcorder, you can use the Anton
Bauer Ultralight 2 or equivalent video light
(powered by 12 V with maximum power
consumption of 50 W).

« If you connect the video light to the LIGHT
connector on the camcorder and set the LIGHT
switch to AUTO, you can turn the light on and
off automatically as you start and stop recording
on this camcorder.

The output of the LIGHT connector on the
camcorder is controlled to 12 V even when the
camcorder is supplied with over 12 V power
(through the DC IN connector or battery pack).
The brightness or color temperature of the light
will not change according to voltage increase.

* Do not use a video light with power consumption of
over 50 W.

» The brightness or color temperature of the light will
change when the voltage (supplied through the DC IN
connector or from the battery pack) is under 12 V.

To attach the video light

Fit the video light to the accessory fitting shoe on
the camcorder grip, and connect the video light
cable to the LIGHT connector.

The accessory fitting shoe on the camcorder is of the l/4—
inch tapped hole type. If you want to replace this with a
slide-type shoe, use the supplied cold shoe kit.

Using the Shoulder
Strap

To attach the shoulder strap

1 Fit one of the clips to a shoulder strap
fitting.

Pull up the strap to lock the fitting.

2 Fit the other clip to the shoulder strap
fitting on the other side of the grip in the
same way as in step 1.

To remove the shoulder strap

Press here and pull in the direction
shown by the arrow to release.




Adjusting the Shoulder
Pad Position

You can slide the shoulder pad back and forth
within a 40 mm range. This adjustment helps you
get the best balance for shooting with the
camcorder on your shoulder.

Shoulder pad

1 Raise the lever in the center of the
shoulder pad to unlock the shoulder
pad.

2 Slide the shoulder pad backward or
forward until it is in the most
convenient position.

3 Bring down the lever to lock the
shoulder pad in the selected position.
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=] Adjustments and Settings

For menu operations, see “Basic Setup Menu Operations” (page 110).

Setting the Video Format

The following recording formats can be selected for different combinations of video resolution and system
frequency.

In UDF mode
Setting items of “OPERATION” > “Format” Video format (recording Frame size
HD/SD HD System Rec System Frequency a) format/system frequency)
Line Format
HD 1080 HD422 50 59.94i HD422 50 1920/59.94i 1920x1080
50i HD422 50 1920/50i
29.97P HD422 50 1920/29.97P
25P HD422 50 1920/25P
23.98P HD422 50 1920/23.98P
HD420 59.94i HD420 HQ 1920/59.94i 1920%x1080
HQ1920 501 HD420 HQ 1920/50i
29.97P HD420 HQ 1920/29.97P
25P HD420 HQ 1920/25P
23.98P HD420 HQ 1920/23.98P
HD420 59.94i HD420 HQ 1440/59.94i 1440x1080
HQ1440 50i HD420 HQ 1440/50i
29.97P HD420 HQ 1440/29.97P
25P HD420 HQ 1440/25P
23.98P HD420 HQ 1440/23.98P
720 HD422 50 59.94P HD422 50 1280/59.94P 1280%x720
50P HD422 50 1280/50P
29.97P HD422 50 1280/29.97P
25p HD422 50 1280/25P
23.98P HD422 50 1280/23.98P
HD420 59.94P HD420 HQ 1280/59.94P 1280%x720
HQ1280 50P HD420 HQ 1280/50P
23.98P HD420 HQ 1280/23.98P ®
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Setting items of “OPERATION” > “Format” Video format (recording Frame size

HD/SD HD System Rec System Frequency a) format/system frequency)
Line Format
SD - IMX50 59.94i IMX50/59.94i 720%x486
501 IMX50/50i 720%x576
29.97P IMX50/29.97PsF 720x486
25P IMX50/25PsF 720%x576
DVCAM  59.94i DVCAM/59.94i 720%x480
50i DVCAM/50i 720%x576
29.97P DVCAM/29.97PsF 720x480
25P DVCAM/25PsF 720%x576

a) 59.94i/29.97P/59.94P/23.98P: When “OPERATION” > “Format” > “Country” in the setup menu is set to “NTSC
Area” or “NTSC(J) Area”
50i/25P/50P: When “OPERATION” > “Format” > “Country” in the setup menu is set to “PAL Area”

b) Converted to 59.94P by 2-3 pulldown processing and recorded

In exFAT mode

Setting items of “OPERATION” > “Format” Video format (recording Frame size
HD/SD HD System Rec System Frequency a) format/system frequency)
Line Format
HD 1080 XAVC-I 59.94i XAVC-I 1920/59.94i 1920%x1080
50i XAVC-I 1920/501
29.97P XAVC-I 1920/29.97P
25P XAVC-I 1920/25P
23.98P XAVC-I 1920/23.98P
XAVC-L50 59.94i XAVC-L50 1920/59.94i 1920x1080
50i XAVC-L50 1920/50i
29.97P XAVC-L50 1920/29.97P
25P XAVC-L50 1920/25P
23.98P XAVC-L50 1920/23.98P
XVAC-L35 59.94i XAVC-L35 1920/59.94i 1920x1080
50i XAVC-L35 1920/50i
29.97p XAVC-L35 1920/29.97P
25P XAVC-L35 1920/25P
23.98P XAVC-L35 1920/23.98P
XAVC-L25 59.94i XAVC-L25 1920/59.94i 1920x1080
50i XAVC-L25 1920/50i
HD422 50 59.94i HD422 50 1920/59.94i 1920x1080
50i HD422 50 1920/50i
29.97P HD422 50 1920/29.97P
25p HD422 50 1920/25P
23.98P HD422 50 1920/23.98P
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Setting items of “OPERATION” > “Format” Video format (recording Frame size

HD/SD HD System Rec System Frequency ® format/system frequency)
Line Format
HD 1080 HD420 59.94i HD420 HQ 1920/59.94i 1920x1080

HQ1920  50i HD420 HQ 1920/50i
29.97p HD420 HQ 1920/29.97P
25P HD420 HQ 1920/25P
23.98P HD420 HQ 1920/23.98P

HD420 59.94i HD420 HQ 1440/59.94i 1440x1080

HQ1440  50i HD420 HQ 1440/50i
29.97p HD420 HQ 1440/29.97P
25P HD420 HQ 1440/25P
23.98P HD420 HQ 1440/23.98P

720 XAVC-I 59.94p XAVC-I 1280/59.94P 1280x720

50P XAVC-I 1280/50P

XAVC-L50 59.94P XAVC-L50 1280/59.94P 1280x720
50P XAVC-L50 1280/50P

HD422 50 59.94P HD422 50 1280/59.94P 1280x720
50P HD422 50 1280/50P
29.97P HD422 50 1280/29.97P
25P HD422 50 1280/25P
23.98P HD422 50 1280/23.98P

HD420 59.94p HD420 HQ 1280/59.94P 1280x720

HQI1280  s50P HD420 HQ 1280/50P
23.98P HD420 HQ 1280/23.98P )

SD — IMX50 59.94i IMX50/59.94i 720x486
50i IMX50/50i 720x576
29.97P IMX50/29.97PsF 720x486
25P IMX50/25PsF 720x576

DVCAM  59.94i DVCAM/59.94i 720%x480
501 DVCAM/50i 720%x576
20.97P DVCAM/29.97PsF 720%x480
25P DVCAM/25PsF 720x576

a) 59.94i/29.97P/59.94P/23.98P: When “OPERATION” > “Format” > “Country” in the setup menu is set to “NTSC
Area” or “NTSC(J) Area”
50i/25P/50P: When “OPERATION” > “Format” > “Country” in the setup menu is set to “PAL Area”

b) Converted to 59.94P by 2-3 pulldown processing and recorded
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In FAT mode

Setting items of “OPERATION” > “Format” Video format (recording Frame size
HD/SD HD System Rec System Frequency ® format/system frequency)
Line Format
HD 1080 HQ 1920  59.94i HQ 1920/59.94i 1920x1080
50i HQ 1920/50i
29.97p HQ 1920/29.97P
25P HQ 1920/25P
23.98P HQ 1920/23.98P
HQ 1440  59.94i HQ 1440/59.94i 1440x1080
50i HQ 1440/501
29.97p HQ 1440/29.97P
25P HQ 1440/25P
23.98P HQ 1440/23.98P
SP 1440 59.94i SP 1440/59.94i 1440x1080
50i SP 1440/50i
23.98P SP 1440/23.98P
720 HQ 1280  59.94P HQ 1280/59.94P 1280%x720
50P HQ 1280/50P
29.97p HQ 1280/29.97P
25P HQ 1280/25P
23.98P HQ 1280/23.98P
SD — DVCAM  59.94i DVCAM/59.94i 720x480
(fixed) 50i DVCAM/50i 720x576
290.97P DVCAM/29.97PsF 720%x480
25P DVCAM/25PsF 720%x576

a) 59.94i/29.97P/59.94P/23.98P: When “OPERATION” > “Format” > “Country” in the setup menu is set to “NTSC
Area” or “NTSC(J) Area”
50i/25P/50P: When “OPERATION” > “Format” > “Country” in the setup menu is set to “PAL Area”

b) Converted to 59.94i by 2-3 pulldown processing and recorded

5 Power the camcorder off and on again.

Selecting the Recording Mode

Select the recording mode between UDF, exFAT, Cha nging the Video Format
and FAT.

1 Select “OPERATION” > “Format” in

1 Select “OPERATION” > “Format” > the setup menu (see page 115).

“File System” in the setup menu (see

page 115). 2 Turn the MENU knob to select the item
to change, and press the knob.
2 Turn the MENU knob to select “UDF,”
“exFAT,” or “FAT,” and press the 3 Turn the MENU knob to change the
knob. setting, and press the knob.
A confirmation message appears.
3 A confirmation message appears.
4 Select “Execute” to execute, or select
Select “Execute” to execute, or select “Cancel” to cancel, and then press the
“Cancel” to cancel, and then press the MENU knob.
MENU knob.
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O When the setting of HD/SD or Country
was changed, power the camcorder off
and on again.
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Adjusting the Black
Balance and the White
Balance

Black balance and white balance adjustment
values that are automatically set by the camcorder
and the various settings are stored in the
camcorder memory and retained even when the
power is turned off.

Black balance adjustment

The black balance will require adjustment in the

following cases.

* When the camcorder is used for the first time

* When the camcorder has not been used for a
long time

* When the camcorder is used under conditions in
which the surrounding temperature has changed
greatly

¢ When the GAIN selector (L/M/H/Turbo) values
have been changed with “OPERATION” >
“Gain Switch” in the setup menu.

White balance adjustment

Always readjust the white balance when the
lighting conditions change.

Adjusting the Black Balance

In automatic black balance mode, adjustments are
performed in the following order: black set and
black balance. Manual black balance adjustment
can be selected from the setup menu.

Automatic black balance adjustment is disabled in the

following cases.

* During recording

* In a special recording modes (Picture Cache
Rec, Interval Rec, Frame Rec, Slow & Quick)

* When the shutter mode is SLS

1 Set the OUTPUT/DCC switch to CAM.

2 Push the AUTO W/B BAL switch to
BLACK and release the switch.



The message “Executing...” appears during
execution, and changes to “Done” when the
adjustment finishes.

Adjustment values are saved to memory
automatically.

During the black balance adjustment, the iris is
automatically closed.

During the black balance adjustment, the gain
selection circuit is automatically activated so you may
see flickering on the viewfinder screen, but this is not
a fault.

Output from the i.LINK connector stops temporarily if
you execute black balance adjustment during i.LINK
output. Output from the connector resumes when black
balance adjustment finishes.

If automatic black balance adjustment
cannot be made

Error message Meaning

NG: Iris Not Closed The lens iris did not close;

adjustment was impossible.

NG: Timeout Adjustment could not be
completed within the
standard number of

attempts.

NG: Out of Range  The difference between the
reference value and the

current value is so great that
it exceeds the range, making

adjustment impossible.

If any of the above error messages is displayed,
retry the black balance adjustment.

If the error message occurs again, an internal
check is necessary.

For information about this internal check, contact your
vendor or a Sony service representative.

If the lens cable is not firmly connected to the LENS
connector, it may not be possible to adjust the lens iris. If
this happens, the black balance will be incorrect.

Adjusting the White Balance

1 Set the switches and selectors as shown
below.
¢ GAIN switch: L (set to a gain value that is
as small as possible)
¢ OUTPUT/DCC switch: CAM
« WHITE BAL switch: A or B "
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1) Adjustment values are saved to memory B only
when “OPERATION” > “White Setting” >
“White Switch<B>" in the setup menu is set to
“Memory.”

Set the FILTER selector to suit the
lighting conditions as follows.

Place a white test card under the same
lighting conditions as for the subject to
be shot and zoom up to it.

Alternatively, any white object such as a
cloth or a wall can be used.

The absolute minimum white area is as
follows.

Rectangle centered on the screen.
The lengths of the sides are 70% of the
length and width of the screen.

|
v

Make sure there are not bright spots in the
rectangle.

Adjust the lens iris.

Manually adjusted lens: set the iris to an
appropriate setting.

Lens with automatic iris: set the automatic/
manual switch on the lens to automatic.

Push the AUTO W/B BAL switch to
WHITE and then release the switch.
The message “Executing...” appears during
execution, and changes to “Done” when the
adjustment finishes.

The adjustment values are saved
automatically in the memory selected in
step 1 (A or B).

If the camcorder has a zoom lens with an automatic
iris, the iris may hunt ) during the adjustment. To
prevent this, adjust the iris gain knob (indicated as
IG, IS, or S) on the lens.

For details, refer to the lens operation manual.
1) Hunting: Repeated brightening and darkening of
the image, resulting from repeated response to

automatic iris control.



If the automatic white balance adjustment
cannot be made

Error message Meaning

The white video level is too
low. Either open the lens iris
or increase the gain.

NG: Low Light

NG: Timeout Adjustment could not be
completed within the
standard number of
attempts.

NG: High Light The white video level is too

high. Either stop down the
lens iris or change the ND
filter.

If any of the above error messages is displayed,
retry the white balance adjustment. If the error
message occurs again, an internal check is
necessary.

For information about this internal check, contact
your vendor or a Sony service representative.

If you have no time to adjust the white
balance

Set the WHITE BAL switch to PRST.

This makes it possible to automatically set the
white balance to 5600K (factory default value) by
pressing the COLOR TEMP. button.

The color temperature to which the white balance
is set when the COLOR TEMP. button is pressed
can be selected from among 3200K, 4300K,
5600K, and 6300K on OPERATION >
Assignable SW in the setup menu. You can also
assign color temperatures to the ASSIGN. 1/3
switches or ASSIGNABLE 4/5 switches.

To change the color temperature when
the ND filter is switched

You can assign electrical CC (color correction)
filters to ND filters (see page 12). This allows you
to change the color temperature automatically
when the ND filter is switched.

1 Set “MAINTENANCE” > “White
Filter” > “ND Filter C.Temp” in the
setup menu (see page 147) to “On.”

2 To assign an electrical CC filter to
FILTER selector position number 1,
select “ND FLT C.Temp<1>.” To assign
it to positions 2 to 4, select “ND FLT
C.Temp<2-4>.”
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3 Turn the MENU knob to select the
desired color temperature.
As you turn the MENU knob, the color
temperature changes as follows: 3200K «—
4300K «— 5600K «— 6300K.

4 Repeat steps 2 and 3 as required.

To switch between electrical CC filters
with an assignable switch

You can assign the function that switches
between electrical CC filters to an assignable
switch. This allows you to switch between color
temperatures (3200K/4300K/5600K/6300K) that
have been assigned to up to four positions (A to
D) with each press of the assignable switch.
Regardless of assignments to assignable
switches, you can also switch between the color
temperatures assigned to each position from a
RM-B170/B750 Remote Control Unit.

1 Select “AINTENANCE” > “White
Filter” in the setup menu (see page 147).

2 Select the position to which to assign a
CC filter by selecting one of “Electrical
CC<A>” to “Electrical CC <D>,” and
then turn the MENU knob to select the
desired color temperature.

As you turn the MENU knob, the color
temperature changes as follows: 3200K «—
4300K «— 5600K «— 6300K.

To set no color temperature

Select “-----"" with “Electrical CC<C>" or
“Electrical CC<D>" selected.

When the assignable switch is pressed, the
setting for that position is not displayed. For
example, if “----- ” is set for one position, then
switching between the remaining three
positions is carried out.

3 Repeat step 2 as required.

4 Assign the electrical CC filter switching
function (ELECTRICAL CC) to an
assignable switch (see page 158).

White balance memory

Values stored in memory are held until the white
balance is next adjusted even when the camcorder
power is turned off.



The camcorder has two white balance memories,
A and B. You can automatically save adjustment
values for each ND filter in the memory that
corresponds to the WHITE BAL switch setting
(A or B). The camcorder has four built-in ND
filters, allowing you to save a total of eight
adjustment values (4 x 2). However, the contents
of the memories are not linked to ND filter
settings in the following cases.

¢ When the number of memories allocated to
each of A and B is limited to one by setting
“OPERATION” > “White Setting” > “Filter
White Memory” in the setup menu to “Off.”

* When the electrical CC filter switching function
has been assigned to an assignable switch, or
when a remote control unit has been connected.
(In these cases, the contents of white balance
memory are linked to electrical CC filter
positions (A to D).)

Also, when “OPERATION” > “White Setting” >

“White Switch<B>" in the setup menu is set to

“ATW (Auto Tracing White Balance),” and the

WHITE BAL switch is set to B, the ATW

function is activated to automatically adjust the

white balance of the picture being shot for
varying lighting conditions.

While the ATW function is activated, the color
temperature of the subject may differ from the color
temperature that is displayed on the viewfinder screen.
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Setting the Electronic
Shutter

Shutter Modes

Standard mode

Select this mode for shooting fast-moving
subjects with little blurring.

You can set the shutter speed in one of two shutter
modes: Speed mode, in which the speed is set in
seconds, and Angle mode, in which the speed is
set in degrees.

Speed mode
System Shutter speed (unit: seconds)
frequency
: T, 1,1, 1,1
59.941 160> “/100- /120- /125> 12500
59.94p Ys00- 1000 72000
501
50P
29.97p a0, Y50 Yo, Yoo 120,
I
125, 12505 Y500, 10000 72000
25p 1339, 5™, Yoo, 100 V120,
Y125, "a50- 500, 1000 12000
23.98p 730, Yag®, Yso ™, Vg, Hogs

R P
/100> /]120, 125, 1250, /5005
/1000- /2000

a) This speed cannot be selected when the camcorder is
in Slow & Quick Motion mode and “OPERATION”
> “Rec Function” > “Frame Rate” in the setup menu
is set to a value that is greater than the system
frequency.

Angle mode
180°, 90°, 45°, 22.5°, 11.25°

ECS (Extended Clear Scan) mode

Select this mode for obtaining images with no
horizontal bands of noise when shooting subjects
such as monitor screens.

As shown in the following tables, the range of
shutter speeds that can be set varies depending on
whether the Slow & Quick Motion (S&Q)
function is on or off.



System lines: 1080

System Shutter speed (unit: Hz)
frequency S&Q: Off S&Q: On
59.94i 60.00 to 3800 —

501 50.00 to 3500 —

29.97P 29.99to 4100  32.01 to 4100
23.98P 23.99t0 3700  32.02 to 3700
25P 25.00t0 3900  32.03 to 3900

System lines: 720

System Shutter speed (unit: Hz)
frequency S&Q: Off S&Q: On
59.94P 60.07 to 4100  32.01 to 4100
50P 50.03 t0 3900  32.03 to 3900
29.97P 29.99to 4100  32.01 to 4100
23.98P 23.99t0 3700  32.02 to 3700
25P 25.00 to 3900  32.03 to 3900

SLS (slow speed shutter) mode

Select this mode for shooting subjects in low level
lighting conditions.

Number of accumulated frames

2,3,4,5,6,7,8,16,32,64

* SLS mode cannot be used when the video format is SP
1440/23.98P or when the camcorder is in Slow &
Quick Motion mode.

« Itis not possible to output the color bar signal, turn the
SLS mode on or off, or change the number of
accumulated frames when the number of accumulated
frames is set to 16, 32 or 64.

Selecting the Shutter Mode and
Shutter Speed

* When the automatic iris is used, the iris opens wider as
the shutter speed increases, thus reducing the depth of
field.

» The selectable shutter speeds vary depending on the
current system frequency.

To switch between Speed mode and
Angle mode

1 Select “OPERATION” > “Shutter” >
“Shutter Select” in the setup menu (see
page 127).
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2 Turn the MENU knob to select
“Second” or “Degree,” and then press
the knob.

To set the shutter mode and standard-
mode shutter speed

Once the shutter speed is selected, it is retained
even when the camcorder power is turned off.

1 Push the SHUTTER selector from ON
to SELECT.
The current shutter setting indication appears
for about three seconds.

2 Before the shutter setting indication
disappears in step 1, push the
SHUTTER selector down to SELECT
again. Repeat this until the desired
mode or speed appears.

When all modes and speeds are displayed,
the display changes in the following order.

Depending on the frame rate setting (see page 119),
some shutter speeds cannot be selected in Slow & Quick
Motion mode. These speeds are replaced by the slowest
selectable shutter speed.

Example: If you perform Slow & Quick Motion
shooting when setting the frame rate to 60 and the video
format to HQ1280/29.97P:

The shutter speed is indicated as follows.

When Slow & Quick Motion mode is off
1/40—»1/50—1/60—»1/100—...

When Slow & Quick Motion mode is on
1/60—1/60—»1/60—»1/100—-...

To set the shutter speed in ECS mode

1 Set the shutter mode to ECS (see the
previous item).

2 Turnthe MENU knob to select the
desired frequency or number of frames.

To set the shutter speed in SLS mode

1 Set “OPERATION” > “Shutter” >
“Slow Shutter” in the setup menu to
“On” (see page 127).



2 Select the desired number of
accumulated frames with
“OPERATION” > “Shutter” > “SLS
Frames” in the setup menu.
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Setting Auto Iris

The reference value for automatic iris adjustment

can be changed to aid the shooting of clear

pictures of back-lit subjects, or to prevent blown-

out highlights. The reference value for the lens

iris can be set within the following range with

respect to the standard value.

¢ 0.25 to 1 (increments of 0.25): About 0.25 to 1
stop further open

¢ —0.25 to -1 (increments of 0.25): About 0.25 to
1 stop further close

Also you can set the area where light detection

occurs.

To change the reference value

1 Set “OPERATION” > “Auto Iris” >
“Iris Override” in the setup menu to
“On” (see page 125).

2 Set the MENU ON/OFF switch to OFF.

3 Turn the MENU knob to change the
reference value.

Be sure to confirm that the current shutter mode is
not ECS.

An indicator of the current reference value is
shown at the iris position indication (see
page 28) on the viewfinder screen.

To make the iris more open

Turn the MENU knob counterclockwise as
seen from the front of the camcorder.
Select one of 0.25, 0.5, 0.75, or 1.

To stop down the iris

Turn the MENU knob clockwise as seen
from the front of the camcorder.

Select one of —0.25, —0.5, -0.75, or —1.

The changed reference value is retained until
the power of the camcorder is turned off.
Even if the reference value is changed, it
reverts to the standard value every time the
power is turned on.



To set the automatic iris window

1 Set “OPERATION” > “Auto Iris” >
“Iris Window Indication” in the setup
menu to “On.”

The current automatic iris window appears
on the viewfinder screen.

If it is not necessary to display the auto iris
window on the screen, set to “Off.”

2 Turn the MENU knob to select “Iris
Window,” and then press the knob.

3 Turn the MENU knob until the desired
auto iris window appears, and then
press the knob.

1 2 3 4 5 6

(| = [ e |
Shaded parts indicate areas of light
detection

If you select “Var,” the following items
become effective and you can set the window
of the desired size. Set the following items
with “MAINTENANCE” > “Auto Iris2.”

Item Setting

Iris Var Width ~ The width of the window

Iris Var Height ~ The height of the window

Iris Var H The position of the window
Position in the horizontal direction
Iris Var V The position of the window
Position in the vertical direction.

When you exit the menu, the auto iris window
selected in step 3 appears.

Unless you need to keep this window displayed,
set “OPERATION” > “Auto Iris” > “Iris Window
Indication” in the setup menu to “Off.”

To counter problems with very bright
highlights

If the subject is too bright, the iris may close too
much, leaving the overall image dark, or the
highlights may be blown out. In such cases,
setting the highlight clip function on reduces the
luminance range, avoiding problems from the
automatic iris correction.

Set “OPERATION” > “Auto Iris” > “Clip High
Light” in the setup menu to “On.”

Zooming

Switching between Zoom Modes

Set the ZOOM switch to SERVO (servo zoom) or
MANU (manual zoom).

Using Manual Zoom

Turn the zoom ring.

Using Servo Zoom

Operate the power zoom lever. The current lens
zoom position appears in the viewfinder, over the
range 0 (wide-angle) to 99 (telephoto) (see
page 25).

Push to the W (wide) side when you want wide-
angle, and push to the T (telephoto) side when
you want telephoto. Press the lever harder for a
faster zoom action, or softer for slower zoom
action.



Adjusting the Focus

The lens is designed with an extra margin at the infinity
position (ee), to compensate for focus drifting due to
variations in temperature. When shooting a subject at
infinity in MF or Full MF mode, check the picture in the
viewfinder as you focus.

Adjusting in Full MF Mode

When you slide the focus ring back (toward the
camcorder), the focus mode becomes Full MF

mode, in which all focus adjustments are manual.

When you slide the focus ring back, the focus instantly
moves to the mark position.

Focus by turning the focus ring while viewing the
viewfinder.

The distance indications on the ring are valid in
Full MF mode. The distances where the picture is
in focus correspond to absolute positions of the
focus ring.

Peaking

You can turn the PEAKING knob on the
viewfinder to use the peaking function. Edges are
emphasized in the monitor picture, which
facilitates manual focusing.

The recorded video signals are not affected.

Adjusting in MF Mode

When you slide the focus ring forward (toward
the lens hood), and set the FOCUS switch to M
(manual), the focus mode becomes MF mode, in
which focus adjustments are manual but auto
focus is available only when necessary.

Using the focus ring

Focus by turning the focus ring while viewing the
viewfinder.

The distance indications on the ring are invalid in
MF mode.

One-push auto focus

Press the PUSH AF button. Auto focus is enabled
temporarily.

One-push auto focus ends when the subject is
brought into focus.

MF assist function

When the MF assist function is on (see page 160),
auto focus starts when you stop adjusting with the
focus ring, enabling fine adjustments with the
subject at the center of the screen.

Auto focusing by the MF assist function ends
when the fine adjustments end.

Adjusting in AF Mode

When you slide the focus ring forward, and set the
FOCUS switch to A (auto), the focus mode
becomes AF mode, in which auto focus is always
active.

The distance indications on the ring are invalid in
AF mode.

Using Macro Mode

When the focus mode is MF or AF, you can set
the MACRO switch to the ON side to enable
macro mode. Macro mode allows you to focus
over the range that includes the macro area.
Macro mode is disabled in Full MF mode.



Adjusting the Audio
Level

When you set the AUDIO SELECT switch to
AUTO, the input levels of analog audio signals
recorded on each channel are adjusted
automatically. You can also make manual
adjustments.

Even if you set the AUDIO SELECT switch to AUTO,
the input levels of digital audio signals are not adjusted
automatically.

Target audio level for manual audio level
adjustment

Make adjustment using —20 dB as the target level.

If the audio level meter shows a maximum level
of 0 dB, then it indicates that the input audio level
is excessive.

Manually Adjusting the Audio
Levels of the Audio Inputs from
the AUDIO IN CH-1/CH-2
Connectors

1 To adjust the signal input to the AUDIO
IN CH-1 or CH-2 connector, set the
AUDIO IN CH-1 or CH-2 switch to
REAR.

To adjust both input signals, set both
switches to REAR.

2 Set the AUDIO SELECT switch(es)
corresponding to the channel(s) selected
in step 1 to MANUAL.

3 With the LEVEL control(s) for the
channel(s) selected in step 1, adjust so
that the audio level meter shows up to
—-20 dB for a normal input volume.

Correspondence between recording level
adjustments and audio level controls

You can select which audio level control controls
the audio recording level of the input to each of
the AUDIO IN CH-1/CH-2 connectors on
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“MAINTENANCE” > “Audio” in the setup

menu.

Rearl/WRR Level: Channel 1 recording level
(see page 141)

Rear2/WRR Level: Channel 2 recording level
(see page 142)

‘When you have operation of the LEVEL (CH1/CH2)
knobs and MIC LEVEL control linked together, if the
MIC LEVEL control is set to 0, the audio signals on
channels 1 and 2 cannot be recorded. Check the position
of the MIC LEVEL control before adjusting the LEVEL
(CH1/CH2) knobs.

Manually Adjusting the Audio
Level of the MIC IN Connector

1 Set either or both of the AUDIO IN
switch(es) to FRONT.

2 Set the AUDIO SELECT switch(es) for
the desired channel(s) selected in step 1
to MANUAL.

3 Turn the MIC LEVEL control, and
adjust so that the audio level meter
shows up to —20 dB for a normal input
volume.

Correspondence between recording level
adjustments and audio level controls

You can select which audio level control controls

the audio recording level of the front microphone

input on “MAINTENANCE” > “Audio” in the

setup menu.

MIC CH1 Level: Channel 1 recording level (see
page 141)

MIC CH2 Level: Channel 2 recording level (see
page 141)

‘When you have operation of the MIC LEVEL control
and LEVEL (CH1/CH2) knobs linked together, if the
LEVEL (CH1/CH2) controls are set to 0, the audio
signals on channels 1 and 2 cannot be recorded. Check
the position of the LEVEL (CH1/CH2) knobs before
adjusting the MIC LEVEL control.



Recording Audio on Channels 3
and 4

Selecting the recorded audio

You can select the audio recorded on audio
channels 3 and 4 with the AUDIO IN CH3/CH4
switches.

CH3 switch Channel 3 recording target
FRONT Front microphone audio
REAR Audio signal input to AUDIO
IN CH-1 connector
WIRELESS Wireless microphone audio
CH4 switch Channel 4 recording target
FRONT Front microphone audio
REAR Audio signal input to AUDIO
IN CH-2 connector
WIRELESS Wireless microphone audio

You can have the selection made automatically,
as follows.

To automatically select the same audio as on
channels 1 and 2

Set “MAINTENANCE” > “Audio” > “Audio
CH3/4 Mode” of the setup menu to “Ch 1/2.”

Adjusting the audio recording levels

To adjust automatically
Set the AUDIO SELECT CH 3-4 switch to
AUTO.

To adjust manually

1 Set the AUDIO SELECT CH 3-4 switch
to MANUAL.

2 Select the knobs that adjust the audio
levels with the Audio CH3 Level and
Audio CH4 Level items under
“MAINTENANCE” > “Audio” in the
setup menu.

Audio CH3 Level: Channel 3 recording
level (see page 142)

Audio CH4 Level: Channel 4 recording
level (see page 142)

You can now adjust the levels of audio

channels 3 and 4 with the knobs selected

here.
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Setting Time Data

When picture cache mode is enabled, it is not possible to
set time data, even if you set the F-RUN/SET/R-RUN
switch to SET. If you want to set time data, first exit
picture cache mode.

Setting the Timecode

The timecode setting range is from 00 : 00 : 00 :
00 to 23 : 59 : 59 : 29 (hours : minutes : seconds :
frames).

1 Set the DISPLAY switch to TC.

2 Set the PRESET/REGEN/CLOCK
switch to PRESET.

3 Set the F-RUN/SET/R-RUN switch to
SET.
The first (leftmost) digit of timecode flashes.

4 Use the up and down arrow buttons to
change values, and use the left and right
arrow buttons to move the flashing
digit. Repeat until all digits are set.

To reset the timecode value to 00:00:00:00
Press the RESET/RETURN button.

5 Set the F-RUN/SET/R-RUN switch to
F-RUN or R-RUN.
F-RUN: Free run. The timecode generator
keeps running.
R-RUN: Recording run. The timecode
generator runs only while recording.

To set the drop frame mode/non-drop frame
mode

You can select the drop frame (DF) mode or non-
drop frame (NDF) mode on MAINTENANCE
>Timecode in the setup menu.

To make the timecode consecutive

When the F-RUN/SET/R-RUN switch is set to R-
RUN, recording a number of scenes on the media
normally produces consecutive timecode.
However, once you remove the media and record



on another media, the timecode will no longer be
consecutive when you use the original media
again for recording.

In this case, to make the timecode consecutive, set
the PRESET/REGEN/CLOCK switch to
REGEN.

Saving the real time in the timecode

Setting the PRESET/REGEN/CLOCK switch to
CLOCK saves the real time in the timecode.
When it is necessary to set the actual time, use
MAINTENANCE > Clock Set > Date/Time in
the setup menu.

For details, see “Setting the Date/Time of the
Internal Clock” (page 35).

Setting the User Bits

By setting the user bits (up to 8 hexadecimal
digits), you can record user information such as
the date, time, or scene number on the timecode
track.

1 Set the DISPLAY switch to U-BIT.

2 Set the F-RUN/SET/R-RUN switch to
SET.
The first (leftmost) digit flashes.

3 Use the up and down arrow buttons to
change values, and use the left and right
arrow buttons to move the flashing
digit. Repeat until all digits are set.

To reset the user bit data to 00 00 00 00
Press the RESET/RETURN button.

4 Set the F-RUN/SET/R-RUN switch to
F-RUN or R-RUN, corresponding to the
desired operating mode for the
timecode generator.

To store the user hit setting in memory

The user bit setting (apart from the real time) is
automatically retained in memory even when the
power is turned off.

Synchronizing the Timecode

Connections for timecode
synchronization

Connect both the reference video signal and the
external timecode as illustrated below.

Example 1: Synchronizing with an external
timecode

IR(,&‘J

G
aT lﬂe External timecode

Reference video signal

© GENLOCK IN connector
@® TC IN connector




Example 2: Interconnecting a number of
camcorders (including one reference
camcorder)

To next camcorder

© VIDEO OUT connector
@® TC OUT connector

© TC IN connector

O GENLOCK IN connector

To lock the timecode to an external
source

1 Set the POWER switch to the ON
position.

2  Set the PRESET/REGEN/CLOCK
switch to PRESET.

3 Set the F-RUN/SET/R-RUN switch to
F-RUN.

4 Set the DISPLAY switch to TC.

5 Supply a timecode signal and a
reference video signal complying with
the SMPTE standard and in proper
phase relationship, to the TC IN

connector and to the GENLOCK IN
connector, respectively.

This operation synchronizes the internal
timecode generator with the external
timecode. After about 10 seconds, you can
disconnect the external timecode without
losing the synchronization.

* When you finish the above procedure, the internal
timecode is immediately synchronized with the
external timecode and the counter display will show
the value of the external timecode. However, wait for
afew seconds until the sync generator stabilizes before
recording.

If the frequency of the reference video signal is not the
same as the system frequency of the camcorder, the
camcorder cannot be correctly genlocked. In such a
case, the internal timecode is not correctly
synchronized with the external timecode.

User hit settings during timecode
synchronization

When the timecode is synchronized, only the time
data is synchronized with the external timecode
value.

To release the timecode synchronization
First disconnect the external timecode, then set
the F-RUN/SET/R-RUN switch to R-RUN.

To change the power supply from the battery
pack to an external power supply during
timecode synchronization

To maintain a continuous power supply, connect
the external power supply to the DC IN connector
before removing the battery pack.

Camcorder synchronization during timecode
synchronization

During timecode synchronization, the camcorder
is genlocked to the reference video signal input
from the GENLOCK IN connector.



Checking Camcorder
Settings and Status
Information (Status
Screens)

Status screen Information displayed

CAMERA Settings and status
information related to

shooting

AUDIO Settings and status
information related to

audio input and output

VIDEO Settings and status
information related to

recording and playback

Names of functions
assigned to assignable
switches

ASSIGN SWITCH

BATTERY/MEDIA  Status of the battery
mounted on the camcorder

and the media status

To display status screens

With no menu is displayed, push the STATUS
ON/SEL/OFF switch up to the ON/SEL side.
Each push selects the next status screen, in the
order given in the table above.

CAMERA status screen

White Bal: White balance status

Gain: GAIN switch status

Zoom Speed: Zoom speed set with the lens
ZOOM button

Zebra: Zebra status

Skin Detail: Skin detail status

AUDIO status screen

CH-1/CH-2/CH-3/CH-4: Audio level meters
and input sources
Wind Filter: Wind filter settings

VIDEO status screen

Video Format: Video format

Rec Mode: REC Format

Output&i.LINK: Output&i.LINK setting and
i.LINK usage status
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SDI Output: HD/SD SDI OUT connector output
setting

HDMI Output: HDMI connector output setting

Down Converter: SD output down converter
setting (HD mode only)

ASSIGN SWITCH status screen

This screen displays the names of the functions
assigned to assignable switches

BATTERY/MEDIA status screen

Battery: The remaining battery capacity
Charge Count: The number of times the battery
has been charged
Media A/Media B:
* Remaining capacity of media
* Remaining recording time
* Approximate writable lifetime (Life)
“Life 100%” is shown for unused media.



Shooting

Handling SxS Memory
Cards

This camcorder records video and audio on SxS
memory cards (not supplied) loaded into one or
both of its memory card slots.

You can use the camcorder with the following

devices to make recording.

« MEAD-SD02 Media Adaptor (when the
recording mode is FAT), or QDA-EX1 XQD
ExpressCard Adapter (when the recording
mode is UDF/exFAT/FAT)

About SxS Memory Cards

SxS memory cards that can be used with
this camcorder

Use the following Sony SxS memory cards (SxS
PRO or SxS-1) with this camcorder.

SxS PRO+ series
SxS PRO series
SxS-1 series

The memory cards listed above comply with the
ExpressCard memory card standard.

Loading and Ejecting SxS Memory
Cards

To load SxS memory cards

1 Slide the cover to the left to open.

2 Insertan SxS memory card into a card
slot.

3 Close the cover.
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ACCESS lamp status indications
Card slots A and B each have an ACCESS lamp
to indicate the slot status.

Lamp Slot status

Lights Accessing the SxS memory card

orange (lights during data reading and
writing)

Lights Standby (the loaded SxS memory

green card is ready for recording or
playback)

Not lit * No SxS memory card is loaded.

* An unusable card is loaded.
¢ An SxS memory card is loaded, but
the other slot is selected.

To eject SxS memory cards

1 Open the cover, and then press the
EJECT button to release the lock and
pull the button out.

2 Press the EJECT button again to eject
the card.

Data integrity cannot be guaranteed if you power the
camcorder off or remove a memory card while the card
is being accessed. Doing so may corrupt all data recorded
on the card. Always make sure that the ACCESS lamp is
lit green or not lit before you power the camcorder off or
remove a memory card.

Selecting the SxS Memory Card to
Use

When SxS memory cards are loaded in both slot
A and slot B, you can press the SLOT SELECT
button to select the SxS memory card to use.
The camcorder switches automatically to the
other card if the selected card becomes full during
recording.

The SLOT SELECT button is disabled during playback.
Even when pressed, it does not change the selected slot.
Button operations are enabled when a thumbnail screen
(see page 96) is displayed.



Formatting (Initializing) SxS
Memory Cards

When you load an unformatted SxS memory card,
or load an SxS memory card that has been
formatted to other specifications, a message
“Cannot Use Media(A)/Unsupported File
System” appears in the viewfinder. In this case,
format the memory card in the following way.

SxS memory cards not formatted on an XDCAM EX
device cannot be used.

To format (initialize) a memory card

1 Select “OPERATION” > “Format
Media” in the setup menu (see
page 117).

2 Select “Media(A)” (slot A) or
“Media(B)” (slot B).

3 Turn the MENU knob to select
“Execute,” and then press the knob.
The confirmation message for formatting is
displayed on the viewfinder screen.

4 Turn the MENU knob to select
“Execute” and press the knob.

Execution of the format starts.
During execution, a progress indication appears
(%), and the ACCESS lamp lights in orange.

Recording and playback during format execution
Even during execution of a format, recording and
playback are possible using an SxS memory card
loaded into the other card slot.

If the format operation fails

A format operation may fail because the SxS
memory card is write protected, or because it is
not the type of card specified for use with this
camcorder.

In this case, an error message appears. Follow the
instructions in the error message and exchange
the card for an SxS memory card that can be used
with this camcorder.
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« All data is erased when you format a memory card,
including setup files and all of the recorded video data.

* Use the format function of this camcorder to format
SxS memory cards for use on this camcorder. The
formats of cards formatted on other devices are not
recognized as valid formats, making it necessary to
format them again on this camcorder.

Checking the Remaining
Recording Time

You can check the remaining capacity of the SxS
memory cards loaded in the two slots by checking
the recording media remaining capacity display
in the viewfinder.

The camcorder calculates the remaining
recording time for the media in each slot on the
basis of the current video format (recording bit
rate), and displays it in units of minutes.

You can also check the remaining time in the
BATTERY/MEDIA status screen (page 60).

A (EL mark appears when a memory card is write
protected.

When to exchange SxS memory cards

» The warning message “Media Near Full”
appears, the WARNING indicator and the REC
indication on the viewfinder screen flash, and
the buzzer sounds when the total remaining
recording time of the two memory cards falls to
five minutes during recording.

Exchange one of the cards for media with
available recording capacity.

« If you continue recording, the message “Media
Full” appears and recording stops when the total
remaining recording time falls to O.

About up to 600 clips can be recorded on one SxS
memory card.

The display of remaining recording time changes to “0”
and the message “Media Full” appears when the clip
limit is reached.



Restoring SxS Memory Cards

When you load an SxS memory card that needs to
be restored, a message appears in the viewfinder
to ask whether you want to restore it.

To restore a card

Turn the MENU knob to select “Execute,” and
then press the knob.

The restoration starts.

During the restoration, a execution message
appears, the progress is displayed (%), and the
ACCESS lamp lights in orange.

When the restoration finishes, a completion
message is displayed for three seconds.

If restoration fails

* Write protected SxS memory cards and cards on
which memory errors have occurred cannot be
restored. A warning message appears for such
cards. Follow the instructions in the message
and unprotect the card or replace it with another
card.

SxS memory cards on which memory errors
have occurred may become usable if they are
reformatted.

In some cases, some clips can be restored while
others cannot. The restored clips can be played
normally.

If the message “Could not Restore Some Clips”
keeps appearing after repeated attempts at
restoration, it may be possible to restore the SxS
memory card with the following procedure.

@ Use the camcorder’s copy function (see
page 103) or the supplied application
software (see page 174) to copy the
required clips to another SxS memory
card.

(® Format the unusable SxS memory card on
the camcorder.

(® Copy the required clips back to the newly
formatted SxS memory card.

Recording and playback during restoration
Even while restoration is in progress, you can
record and play an SxS memory card in the other
card slot.

63

For restoration of media recorded with this camcorder,
be sure to use this camcorder.

Media recorded with a device other than this camcorder
or with another camcorder of different version (even of
the same model) may not be restored using this
camcorder.



Using a Media Adaptor

* A media adaptor cannot obtain the high reliability and
durability equivalent to an SxS memory card for
professional use.

* Not all memory cards have been tested and are not
guaranteed to work with this camcorder. For
compatible memory cards, contact your Sony dealer.

XQD Memory Cards

By using an optional QDA-EX1 XQD
ExpressCard Adapter, you can insert an XQD
memory card into the SxS memory card slot and
use it instead of an SxS memory card.

For details on using a QDA-EX1 XQD ExpressCard
Adapter, refer to the instruction manual supplied
with it.

* High-speed playback may not be properly achieved
with an XQD memory card.

» Slow Motion recording by the Slow & Quick Motion
recording function cannot be made with an XQD
memory card.

Formatting

When you use an XQD memory card with this
camcorder, formatting is required.

An XQD memory card to be used with this
camcorder must be formatted using the format
function of this camcorder. It is also necessary to
format an XQD memory card for use if a caution
message is displayed when you mount the XQD
memory card.

For an XQD memory card that was formatted
with another system unsupported by this
camcorder, the message “Unsupported File
System” is displayed on the LCD monitor/
viewfinder screen.

Format the XQD memory card as instructed
below.

To format (initialize) a memory card
Specify the slot on “OPERATION” > “Format
Media” in the setup menu, then select “Execute.”

On a confirmation message, select “Execute”
again.

An in-progress message and status bar (%) are
displayed, and the access lamp lights in orange.
When formatting is completed, a completion
message is displayed for three seconds.

When formatting, all data in an XQD memory card-
including protected images-are erased and cannot be
restored.

Connection between the camcorder and a
computer

To use an XQD memory card in which data have
been recorded with an XDCAM EX-series
product, insert it into the slot of the camcorder
and connect between the computer and this
camcorder using a USB cable.

To use media formatted with this camcorder in
the slots of other devices

Make a backup of the media, then format it using
the other device.

SDHC Cards (FAT Mode only)

When FAT mode is selected, use of the optional
MEAD-SD02 Media Adaptor permits you to
insert an SDHC card to the SxS memory card slot
of the camcorder and use it for recording and
playback in the same way as with an SxS memory
card.

Supported SDHC cards
SDHC cards (SD speed Class 10)

For details on use of the MEAD-SD02 Media
Adaptor, refer to the Operating Instructions of the
adaptor.

In UDF/exFAT mode, no Media Adaptor can be used.
High-speed playback may not be properly achieved
with an SDHC card.

When using the Slow & Quick Motion function with
an SDHC card, you cannot perform slow motion
shooting.



Formatting

When you use an SDHC card with this
camcorder, formatting is required.

An SDHC card to be used with this camcorder
must be formatted using the format function of
this camcorder.

It is also necessary to format an SDHC card for
use if a caution message is displayed when you
mount the SDHC card.

For an SDHC card that was formatted with
another system unsupported by this camcorder,
the message “Unsupported File System” is
displayed on the LCD monitor/EVF screen.
Format the SDHC card as instructed below.

To format (initialize) a memory card

Select “Media(A)” (slot A) or “Media(B)” (slot
B) on “OPERATION” > “Format Media” in the
setup menu, and select “Execute.”

During execution, a progress indication appears
(%), and the ACCESS lamp lights in orange.
When formatting is completed, a completion
message is displayed for three seconds.

In formatting, all data in an SDHC card, including
protected images, are erased and cannot be restored.

Connection between the camcorder and a
computer

To use an SDHC card in which data have been
recorded with an XDCAM EX-series product,
establish USB connection between the computer
and this camcorder and insert it into the slot of the
camcorder, or use a specified USB card reader
SBAC-US20.

To use media formatted with this camcorder in
the slots of other devices

Make a backup of the media, then format it using
the other device.
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Handling USB Flash
Drives

In UDF/exFAT mode, you can connect a USB
flash drive connected to the external device to
record, save and load the following data.

* Planning metadata (see page 93)

* Setting data file (see page 164)

¢ Use USB flash drives with capacity of 4 GB or greater.

» USB flash drives other than the recommended flash
drives listed above may not be recognized when
connected to the USB connector.

Formatting (Initializing) USB
Flash Drives

USB flash drives must be formatted with the
FAT32 file system.

Before using a drive, format it on this camcorder or a PC.
If a drive formatted on a PC cannot be used, format it on
the camcorder.

1 Connect a USB flash drive to the
external device connector.
When the drive is unformatted or has been
formatted in an unsupported format, a
message appears stating that the drive cannot
be used.

2 Select “MAINTENANCE” > “USB Set”
> “Format USB” > “FAT32” in the
setup menu.

A confirmation message prompting you to
execute formatting appears on the LCD
monitor.

3 Turn the MENU knob to select
“Execute” and press the knob.
During execution, a progress indication
appears (%). When formatting is completed,
the message “Format USB Memory Done” is
displayed. The
\MSSONY\PRO\XDCAM\MEMDISC
folder and the \General\Sony\Planning folder
are automatically created in the drive.



If the format operation fails

A format operation may fail because the USB
flash drive is write protected, or because it is not
the type of drive specified for use with this
camcorder.

In this case, an error message appears. Follow the
instructions in the error message and exchange
the drive for one that can be used with this
camcorder.

Restoring USB Flash Drives

When you load a USB flash drive that cannot be
mounted normally because the file system is
destroyed, a message appears on the viewfinder
screen to ask whether you want to restore it.
Pressing the MENU knob after turning the
MENU knob to select “Execute” starts execution
of the format and a progress indication appears
(%).

When restoring is completed, the message
“Restore USB Memory Done” is displayed.
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Operating via the
REMOTE Connector

When the RM-B170/B750 Remote Control Unit,
the RCP-1001/1501 Remote Control Panel, or
other control unit is connected, some camcorder
functions can be controlled from these units.
You can use the RM-B750’s display or a video
monitor connected to the MONITOR connector
of the remote control unit to control the
camcorder by menu operations and monitor the
camcorder picture.

To connect

Using the remote cable (10 m (33 ft)) supplied
with the remote control unit, connect between the
REMOTE connector (8-pin) of the camcorder and
the camera connector of the remote control unit.
When you turn on the camcorder after the
connection, the camcorder enters Remote Control
mode.

Adjusting the Camcorder from the
Remote Control Unit

You can control menu and recording operations.

For the functions that can be controlled from the
remote control unit, see “Functions That Can Be
Controlled from the RM-B170/B750” on page 70 or
“Functions That Can Be Controlled from the RCP-
1001/1501” on page 77.

* Remote Control operations cannot be made if USB
connection to the camcorder is enabled.

* Do not connect or disconnect the remote control unit
when the camcorder is on.

The following switches of the camcorder become

inoperative when the remote control unit is

connected.

* GAIN selector

* WHITE BAL switch

* AUTO W/B BAL switch

* SHUTTER switch

* OUTPUT/DCC switch

* Buttons and switches to which the Turbo Gain
function has been assigned, including the



ASSIGN. 1/3 switches, the ASSIGNABLE 4
switch, the COLOR TEMP. button, and the
ASSIGNABLE 5 switch.

REC START button: the VTR button on the
lens, and buttons and switches to which the
function has been assigned using
“OPERATION” > “Assignable SW” in the
setup menu, including the ASSIGN. 1/3
switches, the ASSIGNABLE 4 switch, the
COLOR TEMP. button, and the ASSIGNABLE
5 switch (when “MAINTENANCE” > “Camera
Config” > “RM Rec Start” in the setup menu is
set to “RM”).

To release remote control mode

Turn off the camcorder and disconnect the remote
control unit.

The settings on the controls on the camcorder
become valid.

To connect the monitor to the RM-B170/
B750

The MONITOR connector (BNC type) of the
RM-B170/B750 outputs a composite signal.

To connect a monitor to the MONITOR
connector on the RM-B170/B750, use the black
cable supplied with the RM-B170/B750.

Camera image quality adjustment items
when the RM-B170/B750 is connected

‘When the RM-B170/B750 is connected, the
parameters for camera image quality adjustment
items (paint data) are reset to the parameters that
were specified the last time that RM-B170/B750
was connected.

Function of the recording start/stop
buttons when the RM-B170/B750 is
connected

This setting is made using “MAINTENANCE” >
“Camera Config” > “RM Rec Start” in the setup
menu.

Relationship between the setting of the RM Rec
Start item and the function of recording start/stop
buttons

Settings of RM Rec Start
Button

RM CAM PARA

Camcorder’s REC
START button

Disabled Enabled Enabled

Lens’ VTR button Disabled Enabled Enabled

Buttons and switches Disabled Enabled Enabled
to which the
recording start/stop
function has been
assigned (ASSIGN.
1/3 switches,
ASSIGNABLE 4
switch, COLOR
TEMP. button, and
ASSIGNABLE 5
switch)

Remote control Enabled Disabled Enabled

unit’s VTR button

Structure of the paint adjustment data

The non-volatile memory of the camcorder used
for storing paint adjustment data consists of two
regions as shown below: one is the “main data
block” that is used when a remote control unit is
not connected, and the other is the “remote
control data block” that is used when a remote
control unit is connected. Paint adjustment data is
automatically selected and output to the camera
section depending on whether or not a remote
control unit such as the RM-B170 is connected.



Setup menu of

the camcorder | | RM-B170 |

> |

1
Main data block Remote control data

block
MASTER BLACK
MASTER GAMMA
KNEE POINT

MASTER BLACK
MASTER GAMMA

KNEE POINT
DETAIL LEVEL DETAIL LEVEL
R/B GAIN
R/B BLACK R/B GAIN

R/B BLACK

Non-volatile memory

) P_Ii_/!
Hardware of the
camera section

o—o RM-B170 connected
o---0 RM-B170 not connected

When a remote control unit is connected to the
camcorder, the “remote control data block™ is
selected as the current paint data block, and the
paint adjustment parameters that were in effect
the last time the remote control unit was used are
recalled.

The settings of the absolute value rotational

controls ! and absolute value switches 2 are

overwritten by those on the remote control unit
after the remote control unit is connected.

When the remote control unit is disconnected

from the camcorder, the “main data block™

becomes effective. Thus the camcorder will
return to the settings that were in effect before the
remote control unit was connected.

1) Absolute value rotational controls: The data
corresponding to the angular position of controls is
output. Rotational controls for which the data
corresponding to the amount of their rotation is
output are called relative value controls.

2) Absolute value switches: Like toggle switches or
slide switches (except most momentary switches), the
switches (or knobs) whose positions must coincide
with their functions are called absolute value
switches.

When “MAINTENANCE” > “Camera Config” >

“RM Common Memory” is set to “On” in the

setup menu, you can use settings of the paint

adjustment data stored in the main data block
even if you connect the remote control unit. In
this case, the settings stored in the main data
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block will be renewed when you change the
settings on the remote control unit. Thus, the
settings of the paint data made with the remote
control unit can be retained even if the remote
control unit is removed. However, if the switch
position on the remote control unit differs from
the one on the camcorder, the switch position on
the camcorder takes precedence over that on the
remote control unit.

Also, it is possible to keep the settings that are in
effect before you connect the remote control unit.
In this case, you should set the control knob to the
relative value mode on the remote control unit.

For details, refer to the Operation Manual supplied
with the remote control unit.

Operating the Menu from the
RM-B170

1 Set the DISPLAY switch to MENU.
The camcorder menus can be displayed on a
video monitor connected to the MONITOR
connector of the RM-B170.

Select and set the menu items, using the
MENU SELECT knob and the
CANCEL/ENTER switch.

When the settings are completed, set the
DISPLAY switch to ON or OFF to exit
the menu.

For details on operations of the RM-B170, refer to
the Operation Manual of the RM-B170.

Operating the Menu from the
RM-B750

1 Press and light the MONITOR button
then press the VF MENU button.
The camcorder menus can be displayed on
the RM-B750’s display or a video monitor
connected to the MONITOR connector of the
RM-B750.

Select and set the menu items, using the
MENU SELECT knob, ENTER button,
and CANCEL button.



3 When the settings are completed, press
the VF MENU button to exit the menu.

For details on operations of the RM-B750, refer to
the Operation Manual of the RM-B750.
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Functions That Can Be Controlled from the RM-B170/
B750

You can adjust the functions in the following table by using menu operations, adjustment knobs, switches,
and the touch panel (RM-B750 only).

For details on operations, refer to the operation manual of the RM-B170/B750.
How to read the table
In the RM-B 170 and RM-B750 columns of the table below, “Yes” and “No” mean the following.

Yes: The operation can be performed from the unit.
No: The operation cannot be performed from the unit.

Item Sub-item Setting Description RM-B170 RM-B750
Gain Step Gain — Sets the master gain. No No
L/M/H Low/Mid/High  Switches between three gain levels, No No

when the master gain has been set
from a menu.

Step —3/0/3/6/9/12/18/ Sets the master gain. Yes Yes
24dB
Bars Bars On/Off Turns color bar output on or off. Yes Yes
Shutter Step Shutter On/Off Turns the step shutter function on or Yes Yes
Setting off.
Step Shutter — Sets the step shutter speed. Yes Yes
Speed
ECS Setting On/Off Turns ECS on or off. Yes Yes
ECS Frequency — Selects the ECS frequency. Yes Yes
SLS Setting On/Off Turns SLS on or off. Yes Yes/No ¥
SLS Speed — Sets the SLS speed (number of Yes Yes ¥
frames).
DCC DCC On/Off Turns DCC on or off. Yes Yes
White AWB Start/Stop Starts execution of auto white Yes Yes
Balance balance adjustment.
Stops execution if in progress.
White Memory A/B/C/Preset Switches the auto white balance Yes Yes
memory.
ATW On/Off Turns ATW on or off. Yes Yes
5600K On/Off Turns color temperature conversion Yes Yes
on or off.
Black ABB Start/Stop Starts execution of auto black Yes Yes

balance adjustment.
Stops execution if in progress.
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Item Sub-item Setting Description RM-B170 RM-B750
Iris Iris Mode Auto/Manual Selects the iris mode. Yes Yes
Iris Speed —99 to 0 to +99  Specifies the control speed (speed of  Yes Yes ?
reaction to changes in the video).
(Larger values specify quicker
reaction times.)
Iris Level —-99 to 20 to +99  Adjusts the level of the auto iris Yes ¥ Yes V)
target value.
Iris APL Ratio  —99 to #0 to +99 Adjusts the mix ratio of auto iris Yes ® Yes ?
detection peak value and average
value.
Iris Window Ind On/Off Turns on or off the function that Yes ® Yes
displays a frame marker for the auto
iris detection window.
Close On/Off Turns forcible iris closing on or off. No Yes
Rec Slow & Quick  On/Off Turns the Slow & Quick Motion Yes Yes D)
Function function on or off.
Frame Rate The available When “Slow & Quick” is set to Yes Yes VP
settings vary “On,” sets the frame rate for Slow &
depending on the Quick Motion shooting.
Format >HD
System Line
setting.
Camcorder Menu On/Off Operates the camcorder menu. Yes Yes
Menu Cancel/Preset ~ Cancel/Preset Yes Yes
Select/Set Select (Up/ Yes Yes
Down)/Set
Panel Panel Active On/Off Enables (On) or disables (Off) panel Yes Yes
Active operations.
Standard Standard On/Off Selects standard mode. Yes Yes
ND Filter ~ ND Filter Display only Turns the display of ND filter No No
settings on or off. (The settings
cannot be changed, only displayed.)
CCFilter  CC Filter A/B/C/D Selects a CC filter. Yes Yes
Extender  Extender On/Off Turns the lens extender indication No No
IND on or off. (The settings cannot be
changed, only displayed.)
Call Call On/Off Enables (On) or disables (Off) calls Yes Yes
from externally connected
equipment.
Media Rec Start/Stop Starts or stops recording. Yes Yes
Play Play/Pause Starts playback. Yes Yes
FREV — Starts high-speed reverse playback. Yes Yes
FFWD — Starts high-speed playback. Yes Yes
Stop — Stops playback. Yes Yes
Rec Review — Starts a recording review. Yes Yes
PREV — Jumps to the first frame of the Yes Yes
current clip.
NEXT — Jumps to the first frame of the next Yes Yes
clip.
Freeze Mix — Execute the freeze mix function. Yes Yes
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Item Sub-item Setting Description RM-B170 RM-B750
Switch Gamma On/Off Turns gamma correction on or off. Yes ® Yes ?
Status Black Gamma  On/Off Turns black gamma correction on or Yes Yes ?)
off.
Matrix On/Off Turns linear matrix correction and Yes P Yes ?
user matrix correction on or off.
Knee On/Off Turns knee correction on or off. Yes Yes ®
White Clip On/Off Turns white clipping adjustment on Yes P Yes ?
or off.
Detail On/Off Turns detail adjustment on or off. Yes Yes
Flare On/Off Turns flare correction on or off. Yes Yes
Test Saw On/Off Turns the test saw signal on or off. Yes Yes
White R Gain<A> —99 to #0 to +99 Specifies the white balance R gain Yes Yes
value saved in memory A.
B Gain<A> —99 to 20 to +99  Specifies the white balance B gain Yes Yes
value saved in memory A.
R Gain<B> —99 to 20 to +99  Specifies the white balance R gain Yes Yes
value saved in memory B.
B Gain<B> —99 to #0 to +99 Specifies the white balance B gain Yes Yes
value saved in memory B.
Black Master Black —99 to 20 to +99 Specifies the master black level. Yes Yes
R Black -99 to #0 to +99 Specifies the R black level. Yes Yes
B Black —99 to #0 to +99 Specifies the B black level. Yes Yes
Flare Flare On/Off Turns flare correction on/off. Yes Yes ®
R Flare —99 to 20 to +99 Sets the R flare correction level. Yes Yes
G Flare —99 to 20 to +99  Sets the G flare correction level. Yes ¥ Yes »
B Flare —99 to 0 to +99 Sets the B flare correction level. Yes Yes
Gamma Gamma On/Off Turns gamma correction on or off. Yes Yes
Step Gamma 0.35t00.45t0  Specifies a gamma correction value Yes P Yes ?
0.90 (0.05 steps) in steps of 0.05.
Master Gamma —99 to £0 to +99 Specifies the master gamma level. Yes Yes
R Gamma —99 to 20 to +99 Specifies the R gamma level. Yes ® Yes
G Gamma -99 to #0 to +99 Specifies the G gamma level. Yes ® Yes ?
B Gamma -99 to #0 to +99 Specifies the B gamma level. Yes ® Yes
Gamma Select When Gamma Select the gamma table to use in Yes ® Yes
Category is STD: gamma correction.
1 DVW
2 x4.5
3x3.5
4 240M
5R709
6 x5.0
When Gamma Yes? Yes VD)
Category is HG:
13250
2 4600
33259
44609
Gamma STD/HG Selects use of standard gamma Yes ® Yes VP
Category (STD) or HyperGamma (HG).

72



Item Sub-item Setting Description RM-B170 RM-B750
Black Black Gamma  On/Off Turns black gamma correction on or Yes Yes
Gamma off.
Gamma Level  —99 to 20 to +99 Specifies the master black gamma Yes ® Yes
level.
Range Low/L.Mid/ Selects the black gamma correction Yes ¥ Yes V)
H.Mid/High effective range.
Knee Knee On/Off Turns knee correction on or off. Yes Yes »
Knee Point 50% t0 90.0% to Specifies the knee point. Yes Yes P
109% (1% steps)
Knee Slope —99 to £0 to +99 Specifies the knee slope. Yes ) Yes ?)
Knee Saturation On/Off Turns the knee saturation function Yes ¥ Yes »)
on or off.
Knee Saturation —99 to £0 to +99 Specifies the knee saturation level. Yes ® Yes®
Level
White Clip White Clip On/Off Turns white clipping adjustment on Yes ® Yes
or off (Off = fixed as 109%).
White Clip Country is set to  Specifies the white clip level. Yes ® Yes ?
Level other than PAL
Area
90.0% to
108.0% to
109.0%
Country is set to
PAL Area
90.0% to
105.0% to
109.0%
Detail(HD Detail On/Off Turns detail adjustment on or off. Yes Yes P
mode)/ Level -99 to +0 to +99 Specifies the detail level. Yes Yes
Detail(SD "H/v Ratio —99 to 20 to +99 Specifies the mix ratio between the Yes P Yes ?
mode) H detail level and the V detail level.
Crispening —99 to £0 to +99 Specifies the crispening level. Yes ® Yes
Level Depend ~ On/Off Turns the level dependence Yes ® Yes
adjustment function on/off.
Level Depend 99 to £0 to +99  Specifies the level dependence level.  Yes ) Yes ?
Level
Frequency —99 to 0 to +99  Specifies the central frequency forH ~ Yes Yes ?
detail signal. Larger values give
finer details.
Knee Aperture  On/Off Turns the linear knee aperture Yes ¥ Yes »)
function on or off.
Knee Aperture  —99 to 20 to +99 Specifies the knee aperture level. Yes P Yes ?
Level
Limit 99 to £0 to +99  Specifies the detail limiter values for ~ Yes® Yes
both the white-side and black-side
direction.
White Limit —99 to 0 to +99  Specifies the white-side detail Yes ¥ Yes
limiter value.
Black Limit -99 to #0 to +99 Specifies the black-side detail Yes ® Yes ?

limiter value.
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Item Sub-item Setting Description RM-B170 RM-B750

Skin Detail Skin Detail On/Off Turns skin detail correction on or Yes ® Yes
off.
Area Detection  Color detection  Detects the color to be targeted by Yes ® Yes
screen skin detail correction.
Area Indication On/Off Turns on or off the function that Yes ® Yes ?

displays a zebra pattern in the area
targeted by skin detail correction.

Level -99 to #0 to +99 Specifies the skin detail level. Yes ® Yes

Saturation —99 to 20 to +99 Specifies the saturation of the color Yes ») Yes
targeted by skin detail correction.

Hue 0 to 359 Specifies the hue of the color Yes ® Yes ?
targeted by skin detail correction.

Width 0 to 40 to 90 Specifies a range for the hue of the Yes ® Yes ?
color targeted by skin detail
correction.

Matrix Matrix On/Off Turns the matrix correction function  Yes Yes »)

on or off.

Preset Matrix On/Off Turns the preset matrix function on Yes ® Yes
or off.

Preset Select 1/2/3/4/5/6 Selects a preset matrix. Yes ® Yes ?

1: SMPTE-240M equivalent
2: ITU-709 equivalent

3: SMPTE WIDE equivalent
4: NTSC equivalent

5: EBU equivalent

6: ITU-601 equivalent

User Matrix On/Off Turns the user matrix function onor  Yes ® Yes ?
off.
User Matrix —99 to 20 to +99 Specifies a freely defined R-G user Yes P Yes ?
R-G matrix.
User Matrix -99 to #0 to +99 Specifies a freely defined R-B user Yes ® Yes ?
R-B matrix.
User Matrix -99 to #0 to +99 Specifies a freely defined G-R user Yes ® Yes ?
G-R matrix.
User Matrix —99 to 20 to +99 Specifies a freely defined G-B user Yes ® Yes
G-B matrix.
User Matrix -99 to #0 to +99 Specifies a freely defined B-R user Yes ® Yes ?
B-R matrix.
User Matrix -99 to #0 to +99 Specifies a freely defined B-G user Yes ® Yes ?
B-G matrix.
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Item Sub-item Setting Description RM-B170 RM-B750
Multi Multi Matrix On/Off Turns the multi matrix correction Yes ¥ Yes »)
Matrix function on or off.
Area Indication On/Off Turns on or off the function that Yes ® Yes
displays a zebra pattern in the color
area targeted by multi matrix
correction.
Axis B/B+/MG-/MG/ Specifies a color targeted by multi Yes ® Yes ?
MG+/R/R+/YL~/ matrix correction (16-axis mode).
YL/YL+/G-/G/
G+/CY/CY+/B-
Hue —99 to 20 to +99 Specifies the hue of the color Yes ® Yes
targeted by multi matrix correction
for each 16-axis mode.
Saturation —99 to 20 to +99 Specifies the saturation of the color Yes ¥ Yes
targeted by multi matrix correction
for each 16-axis mode.
\Y V Modulation  On/Off Turns V modulation shading on or Yes P Yes ?
Modulation off.
Master V -99 to 20 to +99 Specifies the master V modulation Yes ¥ Yes
Modulation level.
R V Modulation —99 to #0 to +99 Specifies the V modulation level of Yes ® Yes ?
R signal.
G V Modulation —99 to 0 to +99 Specifies the V modulation level of Yes P Yes ?
G signal.
B V Modulation —99 to £0 to +99 Specifies the V modulation level of Yes ® Yes
B signal.
Low Key  Low Key On/Off Turns low key saturation correction Yes ¥ Yes »
Sat. Saturation on or off.
Level -99 to 20 to +99 Specifies the saturation of colors in Yes ® Yes ?
low luminance areas.
Noise Noise Suppress On/Off Turns noise suppression on or off. Yes ¥ Yes VD)
Suppress
White R/G/B White H -99 to 0 to +99 Specifies a SAW white shading Yes ® Yes ?
Shading Saw correction value for the horizontal
direction.
R/G/B White H -99 to 0 to +99 Specifies a parabola white shading Yes ® Yes ?
Para correction value for the horizontal
direction.
R/G/B White V. -99 to 0 to +99 Specifies a SAW white shading Yes ® Yes ?
Saw correction value for the vertical
direction.
R/G/B White V. -99 to 0 to +99 Specifies a parabola white shading Yes ® Yes ?

Para

correction value for the vertical
direction.
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Item Sub-item Setting Description RM-B170 RM-B750
Scene O1 Standard File number and file ID Yes ® Yes ?
02 Standard File number and file ID Yes ® Yes
03 Standard File number and file ID Yes ) Yes®
04 Standard File number and file ID Yes ) Yes®
Os Standard File number and file ID Yes ® Yes ?
Scene Recall Execute/Cancel  Loads a scene file (execute using Yes ® Yes ?
Execute).
Scene Store Execute/Cancel  Saves a scene file (execute using Yes P Yes ?)
Execute).
Reference  Reference Store Execute/Cancel — Stores the current settings of Yes ® Yes
reference file items in the reference
file that is maintained in internal
memory (execute using Execute).
Shot Mark  Shot Mark1 — Set a Shot Markl1. Yes No
Shot Mark2 — Set a Shot Mark?2. Yes No

a) Depending on RM-B750 version
b) The camcorder’s built-in menu can be operated from the RM-B170/B750.

Adjustments of the lens functions

The following functions can also be controlled from the RM-B170/B750.

Description Operation on the lens BM-B170 RM-B750
Iris adjustment Iris ring Yes Yes
Iris close — No Yes
Switching between auto iris and manual iris IRIS switch Yes Yes
Zooming Zoom ring Yes No
Focus adjustment Focus ring Yes No
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Functions That Can Be Controlled from the RCP-1001/
1501

You can adjust the functions in the following table by using menu operations, adjustment knobs, switches,
and the touch panel on the RCP-1001/1501.

For details on operations, refer to the operation manual of the RCP-1001/1501.

How to read the table

In the RCP-1001, and RCP-1501 columns of the table below, “Yes” and “No” mean the following.
Yes: The operation can be performed from the unit.

No: The operation cannot be performed from the unit.

Item Sub-item Setting Description RCP-1001/1501
Gain Step Gain — Sets the master gain. Yes
L/M/H Low/Mid/High  Switches between three gain levels, when No
the master gain has been set from a menu.
Step —3/0/3/6/9/12/18/ Sets the master gain. Yes
24/30/36/42dB
Bars Bars On/Off Turns color bar output on or off. Yes
White AWB Start/Stop Starts execution of auto white balance Yes
Balance adjustment.
Stops execution if in progress.
ATW On/Off Turns ATW on or off. Yes
5600K On/Off Turns color temperature conversion on or Yes
off.
Black ABB Start/Stop Starts execution of auto black balance Yes
adjustment.
Stops execution if in progress.
Iris Iris Mode Auto/Manual Selects the iris mode. Yes
Iris Level -99 to #0 to +99 Adjusts the level of the auto iris target Yes
value.
Close On/Off Turns forcible iris closing on or off. Yes
Camcorder Menu On/Off Operates the camcorder menu. Yes
Menu Cancel/Preset ~ Cancel/Preset Yes
Select/Set Select (Up/ Yes
Down)/Set
Panel Panel Active On/Off Enables (On) or disables (Off) panel Yes
Active operations.
Standard ~ Standard On/Off Selects standard mode. Yes
ND Filter ~ ND Filter Display only Turns the display of ND filter settings on Yes
or off (settings cannot be changed, only
displayed.)
CC Filter ~ CC Filter A/B/C/D Selects a CC filter. Yes
Call Call On/Off Enables (On) or disables (Off) calls from Yes

externally connected equipment.
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Item Sub-item Setting Description RCP-1001/1501
Switch Gamma On/Off Turns gamma correction on or off. Yes
Status Black Gamma  On/Off Turns black gamma correction on or off. Yes
Matrix On/Off Turns linear matrix correction and user Yes
matrix correction on or off.
Knee On/Off Turns knee correction on or off. Yes
‘White Clip On/Off Turns white clipping adjustment on or Yes
off.
Detail On/Off Turns detail adjustment on or off. Yes
Flare On/Off Turns flare correction on or off. Yes
Test Saw On/Off Turns the test saw signal on or off. Yes
White R Gain<A> —99 to 20 to +99 Specifies the white balance R gain value Yes
saved in memory A.
B Gain<A> —99 to 20 to +99 Specifies the white balance B gain value Yes
saved in memory A.
R Gain<B> -99 to #0 to +99 Specifies the white balance R gain value Yes
saved in memory B.
B Gain<B> —99 to 20 to +99 Specifies the white balance B gain value Yes
saved in memory B.
Black Master Black —99 to 20 to +99 Specifies the master black level. Yes
R Black —99 to 20 to +99 Specifies the R black level. Yes
B Black -99 to #0 to +99 Specifies the B black level. Yes
Detail(HD Level -99 to #0 to +99 Specifies the detail level. Yes

mode)/
Detail(SD
mode)
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Using Wireless LAN
Connection

Connecting an optional IFU-WLM3 USB

Wireless LAN Module to this camcorder allows a

wireless LAN connection between a computer

and the camcorder.

Making a wireless LAN connection between a

computer and the camcorder enables you to do the

following.

* You can transfer planning metadata and other
files between a computer and this camcorder.

* You can also use the Live Logging function to
add shot marks to the video currently being
shot.

Check the firmware version of your camcorder to make
sure that the camcorder supports the wireless LAN
connection.

For details, contact a Sony sales or service
representative.

Connecting the IFU-WLM3

Open the cover of the external device connector,
then connect the IFU-WLM3.

¢ The IFU-WLM3 USB Wireless LAN Module (sold
separately) may not be available in some countries/
regions.

¢ Attach/remove the IFU-WLM3 after the camcorder is
turned off.

¢ Ani.LINK connection and USB wireless LAN module
cannot be used at the same time.
When using a wireless connection with an IFU-
WLM3 inserted directly into the external device
connector, do not connect a device to the i. LINK
connector.

« If you use a wireless device near the camcorder, the
camcorder may not work correctly. Turn any wireless
devices off that are near the camcorder.

Making a Wireless LAN
Connection

Two types of wireless LAN connections are
available. In “ad-hoc mode”, you can make a
peer-to-peer connection between a computer and
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camcorder. In “infrastructure mode”, you can
make connections between a computer and
multiple camcorders via a wireless LAN access
point (building a LAN).

To make a network setting

Change settings under “MAINTENANCE” >
“Network Setting” in the setup menu as required.

Item
DHCP

Setting

Setting that specifies whether to

acquire the IP address

automatically from a DHCP

Server.

Enabled: Acquire
automatically.

Disabled: Do not acquire
automatically (factory
default setting).

IP address ¥ (factory default

setting: 192.168.1.10)

Subnet mask (factory default

setting: 255.255.255.0)

Default gateway (factory

default setting: 0.0.0.0)

User name for log-in (factory

default setting: admin)

IP Address

Subnet Mask

Default Gateway

User Name

Password Password for log-in (factory
default setting: model name

“pxw-x320")

a) The IP address determined by DHCP server is
displayed here.

When you have changed a setting
Set the “Set” item to “Execute.” When a

confirmation message appears, turn the MENU
knob to select “Execute” and press the knob.

To make a connection in ad hoc mode

1 Configure network connection settings
on the computer to be connected to the
camcorder.

Start a connection on the computer.

Set “MAINTENANCE” > “Wi-Fi
Setting” > “Wi-Fi” to “Enable” in the
setup menu.

4 Set “MAINTENANCE” > “Wi-Fi
Setting” > “Scan Networks” to
“Execute” and press the MENU knob.



The camcorder starts scanning for a network
connection.

When networks are detected, the
NETWORK SCAN list appears.

Turn the MENU knob to select a
network and press the knob.

The “MAINTENANCE” menu appears
again.

Confirm that the settings for the Wi-Fi
Setting item conform to the network
setting on the computer.

SSID (network name): Selected network
name

Network Type (connection mode):
“Adhoc”

CH (channel): “1”

Authentication (network authentication):
Depending the settings on the computer,
“Open,” “Shared,” or “WPA”

Encryption (data encryption): Depending
the settings on the computer, “Disable,”
“WEP,” “TKIP,” or “AES”

WEP Key Index (key index): “1” when
“Encryption” is set to “WEP”

Input Select (key input format): Depending
the network key (or security key),
“ASCII5,” “ASCII13,” “HEX10,” or
“HEX26” when “Encryption” is set to
“WEP,” “ASCII8-63” or “HEX64”
when “Encryption” is set to “TKIP” or
“AES”

Set the Key item to the network key (or
security key) set on the computer and
press the MENU knob.

Set the Set item to “Execute’ and press
the MENU knob.
The message “Wi-Fi Setting Executing...”

appears and the camcorder starts connection.

If the connection to the computer is
complete, then the message changes to
“Wi-Fi Setting OK”.

Black squares (M) appear in the Wi-Fi Status
column to show the connection status. (The
number of M squares shows the level of
connection status.) In the Wireless Mode
column, the IEEE802.11 standard of the
established connection appears (802.11b,
802.11g or 802.11n).
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Tip
Itis also possible to make a wireless LAN connection by
accessing a network connection started on the camcorder
from the computer.

To terminate the connection
Terminate the connection on the computer.

To revert to the default settings (reset)

If you have trouble making a connection, or you
want to start over, you can reset your wireless
LAN connection settings to their defaults.

Set “MAINTENANCE” > “Network Setting” >
“Net Config Reset” in the setup menu to
“Execute” and press the MENU knob.

If the reset is executed, the message “Done”
appears.

The camcorder attempts to connect to the network
using a MAC address as the SSID.

To make a connection in infrastructure
mode

Setting up the wireless LAN access point
The following settings are required.

* Network ID (SSID)

* Encryption method

* Network key (Key)

For details about setting up the wireless LAN access
point, refer to the Operation Manual of the wireless
LAN access point.

To find and connect to a wireless LAN from the

camcorder

Perform the same procedure in “To make a

connection in ad hoc mode” (page 79).

Note the following variations.

* Do not perform steps 1 and 2.

* The settings made in step 7 change as follows.
SSID (network name): Selected network name
Network Type (connection mode): “Infra”
Ch (channel): “Auto”

Authentication (network authentication):
Depending the settings on the computer,
“Open,” “Shared,” “WPA,” or “WPA2”

Encryption (data encryption): Depending the
settings on the computer, “Disable,”
“WEP,” “TKIP,” or “AES”

WEP Key Index (key index): “1” when
“Encryption” is set to “WEP”

Input Select (key input format): Depending
the network key (or security key),
“ASCIIS,” “ASCII13,” “HEX10,” or



“HEX26” when “Encryption” is set to
“WEP,” “ASCII8-63” or “HEX64” when
“Encryption” is set to “TKIP” or “AES”

Using the Web Menu

You can operate the Web menu built in the
camcorder from a computer when it is connected
to the camcorder via a wireless LAN connection.
You can check the information and setting status
of the camcorder, and upload a planning metadata
file, using the Web menu.

You cannot access the Web menu during recording/
playback. (You cannot send/receive files via a wireless
LAN connection.)

Example Web menu

Product Information
* Model name
¢ Serial No.

Network

* MAC Address
* IP Address

¢ Subnet Mask

Wi-Fi Status

* Wireless Mode

« SSID

* Type

¢ Channel

¢ Authentication (network authentication)
¢ Data Encryption (data encryption)

Planning Metadata

Clicking “Upload” displays the Planning
Metadata screen which allows upload of a
planning metadata file (see page 81).

The configuration of items displayed in the Web menu
varies depending on the browser you are using.

To display the Web menu

1 Launch a web browse on the computer,
and navigate to “http://<camcorder’s
IP address> (setting of
“MAINTENANCE” > “Network
Setting” > “IP Address” in the setup
menu).

Example (when the IP address is
“192.168.1.10”): Type “http://
192.168.1.10/” in the address bar.

If the connection is complete, a dialog
appears asking you to enter the user name
and password.

2  Enter the user name and password, and
click “OK.”
User name: admin
Password: pxw-x320 (model name in lower
case)

To upload a planning metadata file

1 Insert a media such as an SxS memory
card.

2 Click “Upload” in the Web menu.
The Planning Metadata screen appears.

3 Click “Select” to show Choose File
dialog.

4 Select the planning metadata file you
want to upload, and then click “Open.”
The path of the selected file appears.

9 Click “Execute.”
The planning metadata file is loaded into the
camcorder’s memory and stored in the
media.
“OK” appears in the Status field when the
transfer is complete.

To upload a planning metadata file
automatically

In the planning metadata file you want to load
automatically, add a “load” property to the
PlanningMetadata tag and set the value of the
property to “True.” When you display the Web
menu and insert a media, the planning metadata
file is immediately loaded into the camcorder’s
memory.

Example: <PlanningMetadata

-+-sp{1oad="true" ;pversion="1.00">

For details on the planning metadata, refer to the
Operating Instructions supplied with the camcorder.



Using Live Logging Functions

The Live Logging function allows you to record
shot marks using a computer while you are
shooting.

That is, you can use a computer to record shot
marks on the video being shot while you are

monitoring the video output from this camcorder.

Using the Wi-Fi Remote Control

When a wireless LAN connection is established,
you can access the built-in Wi-Fi remote control
from a wireless device such as smartphone, tablet,
or PC.

The wireless device can operate the camcorder
using the Wi-Fi remote control. You can start/
stop recording, adjust iris/focus/zoom, etc., with a
Wi-Fi connected device. This function is useful
for setting the camcorder in a remote place, such
as the top of a crane, etc.

Wi-Fi Remote screen (smartphone)

Camera Information
PMW-

0002076
Enable

STOP
REviEW,

Play
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Wi-Fi Remote screen (tablet)

« Some serial lenses cannot be controlled from the Wi-Fi
remote control. With any of such lenses mounted on
the camcorder, even when you try to perform focus/
zoom control from the Wi-Fi remote control, the focus/
zoom setting value displayed on the Wi-Fi remote
control continues to be [0].

Even when a lens controllable from the Wi-Fi remote
control is mounted on the camcorder, zoom control
from the remote control is not possible if the servo
function for the zoom operation is disabled on the lens.
* When a remote control unit is connected to the
camcorder’s REMOTE connector and the white
balance memory setting on the camcorder is other than
“A (memory A),” turning the Wi-Fi remote control on
or off may cause the color to change.

When a remote control unit is connected to the
camcorder’s REMOTE connector, that unit has control
priority and therefore the Wi-Fi remote control cannot
work.

To display the Wi-Fi remote control

To display the Wi-Fi remote control on a device
screen, settings are required on both the device
and camcorder.

Camcorder settings

1 Set “MAINTENANCE” > “Wi-Fi
Setting” > “Wi-Fi” to “Enable” in the
setup menu.

2 Set “MAINTENANCE” > “Wi-Fi
Setting” > “Wi-Fi Remote” to “On” in
the setup menu.

Device settings
Set the smartphone, tablet, PC, etc., to be used as
the Wi-Fi remote control.

1 Make a wireless LAN connection
between the device and camcorder (see
page 79).
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Launch the browser and input http://
<camcorder’s IP address> (setting of
MAINTENANCE > Network Setting >
IP Address in the setup menu)/rm.html
in the address bar.

Example: When the IP address is
192.168.1.10, input http://192.168.1.10/
rm.html in the address bar.

The Wi-Fi Remote screen will appear on the
device screen when the connection is
established.

Thereafter operate the camcorder as shown

on the screen of the Wi-Fi connected device.

The REC button becomes unavailable when
the Lock switch is dragged to the right.

To display the page for a smartphone, change the page

to “rms.html.” To display the page for a tablet device,
change the page to “rmt.html.” Normally, when
“rm.html” is entered, the page displayed switches
automatically for the device. However, in some cases,

a

different page may be displayed, depending on the

device.

The camcorder status may not match the Wi-Fi

Remote screen in the following cases. If this happens,
reload the browser display.

when the camcorder is restarted while the connection
is established.

when the camcorder is controlled directly while the
connection is established.

when the device is reconnected.

when you operate forward/backward on the device’s
browser.

If the Wi-Fi signal is poor, the Wi-Fi remote control

may not work properly.

the ad hoc mode. For details, refer to the operating
instructions supplied with the smartphone/tablet.

Your smartphone/tablet may not be compatible with

Compatible devices

The following devices, using the specified

versions or higher, can be used as Wi-Fi remote

controls.

Device OoS Browser

PC Windows 7/ Chrome or Safari
Windows 8

Mac 0S10.8/10.9/  Safari
10.10

Smartphone Android 4.1/ Chrome
4.2/4.3/4.4

i087.1/8.0/8.1  Safari
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Device (O} Browser
Tablet Android 4.1/ Chrome
4.2/4.3/4.4
i0S7.1/8.0/8.1  Safari




Basic Operations

Attach a fully charged battery pack (see
page 29).

Load one or two SxS memory cards (see
page 61).

If you load two cards, the camcorder
switches automatically to the second card
when the first card becomes full.

Set the camcorder’s POWER switch
(see page 10) to ON.

Make the following settings.

Marker display: On (see page 122)

Iris: Auto (see page 53)

Zoom: Auto (see page 54)

Camera output: Select the picture currently
being shot (camera picture), and turn the
DCC function on (see page 14).

Timecode advance mode: F-RUN (Free
Run) or R-RUN (Rec Run) (see page 57)

Audio input channel selection: Auto (see
page 17)

Push the AUTO W/B BAL switch to the
BLACK side to adjust the black balance
(see page 48).

Select a filter according to the lighting
conditions, and adjust the white balance
(see page 49).

Point the camcorder at the subject, and
adjust the focus (see page 55) and zoom.

If you are using the electronic shutter,
select an appropriate shutter mode and
speed (see page 51).

Do one of the following to start

recording.

- Press the REC START button (see
page 12).

- Press the VTR button on the lens (see
page 23).
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- Turn on the assignable switch to which the
Rec function has been assigned (see
page 159).

During recording, the TALLY indicators, the
tally indicator on the front panel of the
viewfinder, and the REC indication on the
viewfinder screen light. Adjust the zoom and
focus as required.

Never remove the battery pack while the
camcorder is recording (while the ACCESS lamp
on the right-side panel is lit in blue and the
ACCESS lamp in the card slot section is lit in
orange). Doing so risks the loss of several
seconds of data before the recording was
interrupted, because internal processing will not
end normally.

The playback control buttons (EJECT, F REV, F
FWD, NEXT, PREV, PLAY/PAUSE, STOP) do
not function during recording.

10 1o stop recording, perform one of the

operations listed in step 9.

The TALLY indicators, the tally indicator on
the front panel of the viewfinder, and the
REC indication on the viewfinder screen go
out, and camcorder enters recording standby
(STBY) mode.

A clip is created from the video and audio
data and the metadata recorded in steps 9 and

10.

To check the recording (recording review)
With the camcorder in recording standby
(STBY) mode, turn on the assignable switch
to which the Rec Review function or the
Freeze Mix function has been assigned (see
page 158).

The camcorder plays the entire last clip, or
the last few seconds of that clip (3 seconds or
10 seconds), and then returns to standby
mode.

When the Rec Review function is assigned to
the RET button on the lens, you can also
conduct a review by using the RET button.

11 Repeat steps 9 and 10 to continue

recording.
With each repetition, another clip is created
on the memory card.



Clip 1 Clip2 Clip 3
REC REC /REC REC /REC REC
START STOP/ START STOP/ START STOP

You cannot resume recording for about one second
after stopping recording.

The maximum number of clips that can be recorded on
one memory card is 600. Even if the memory card has
enough free capacity to record more clips, when 600
clips have been recorded, no further recording is
possible.

Clip file sizes
Clip file sizes vary according to file formats.

File format  File size Clip size
MP4 Less than 4 GB  Less than

30 minutes
AVI Less than 2 GB  Less than

9 minutes and

30 seconds
MXF Less than 43 GB Less than

6 hours

If you continue recording for an extended period,
recorded materials may be segmented into
multiple files, depending on the file size (the
maximum number of partitions is 99).

The camcorder regards MP4 and AVl files as one
clip even if it has been segmented into multiple
files.

Clip names

Eight-character clips names (consisting of a four-
character prefix and a four-digit number) are
generated automatically for clips recorded by this
camcorder.

Example: ABCD0001

You can also use “OPERATION” > “Clip” >
“Title Prefix” (see page 129) in the setup menu to
set the clip name prefix to a user-specified string
of characters (four to 46 characters in length). (A
user-specified prefix cannot be changed after
recording.)

The four-digit number at the end of clip names is
generated automatically, counting up in order as
clips are recorded.
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Playing Recorded Clips

When the camcorder is in standby (STBY) mode,
you can play all or part of the most recently
recorded clip (see page 84).

1 Insert the SxS memory card to play (see
page 61).

2 Press the PREV button (see page 15) or
the F REV button (see page 15) to cue
up the clip to play.

3 Press the PLAY/PAUSE button.
The PLAY/PAUSE indicator lights, and the
playback picture appears in the viewfinder.

To pause the playback

Press the PLAY/PAUSE button.

The PLAY/PAUSE indicator flashes during
pause.

Press the button again to return to playback mode.

To play at high speed

Press the F FWD button (see page 15) or the F
REV button (see page 15).

To return to normal playback, press the PLAY/
PAUSE button.

To switch between memory cards

When two memory cards are loaded, press the
SLOT SELECT button (see page 18) to select the
active slot.

Itis not possible to switch between memory cards
during playback.

To stop playback

Press the STOP button: Playback stops, and the
camcorder enters E-E mode.

Press the THUMBNAIL button: Playback
stops, and a thumbnail screen (see page 96)
appears in the viewfinder.

Playback also stops and the timecode screen

appears in the viewfinder when you start

recording during playback, and when you eject an

SxS memory card.

Deleting Recorded Clips

You can use the assignable switches to delete the
last recorded clips (Last Clip DEL function).

You can also use the THUMBNAIL menu to delete all
recorded clips (All Clips DEL function) or to delete



selected clips. For details, see “Deleting Clips”

(page 104) Advanced Operations

1 Turn on the assignable switch to which
the Last Clip DEL function has been
assigned (see page 159).

A confirmation message appears.

2 Turn the MENU knob to select Recording Shot Marks

“Execute” and press the knob.
On this camcorder, two types of shot marks are
available in HD mode. You can record them at
user-specified positions to make it easier for
editors to cue up those positions.
You can record up to 127 shot marks per clip.

Shot marks cannot be recorded in SD mode.

You can also use the THUMBNAIL menu to add and
delete shot marks in clips. For details, see “Adding
and Deleting Shot Marks (UDF/exFAT/FAT-HD
Mode Only)” (page 106).

To record shot marks

Do one of the following.
 Turn on an assignable switch to which Shot
Mark 1 or Shot Mark 2 has been assigned (see
page 158).
* If Lens RET has been assigned to the RET
button on the lens, operate as follows.
To record shot mark 1: Press the RET button
once.
To record shot mark 2: Press the RET button
twice in quick succession.

When a shot mark is recorded, a “Shot Mark 1" or
“Shot Mark 2” indication appears in the
viewfinder for about three seconds near the
timecode indication.

Setting OK Marks

As a guide for selecting clips during editing, you
can set OK marks in clips recorded in HD mode.

* OK marks cannot be set in SD mode.

* OK marks cannot be set or deleted during recording or
playback.

To add/delete OK marks

You can also use the THUMBNAIL menu to add

and delete OK marks in previously recorded clips.
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For details, see “Adding/Deleting the OK Mark
(FAT-HD Mode Only)” (page 103).

Starting to Record from Pre-
stored Video (Picture Cache
Function)

The camcorder is equipped with enough internal
memory to pre-store up to 15 seconds of video
and audio data in a picture cache. This allows you
to begin recording a specified number of seconds
in advance of the time when you press a recording
start button.

Selecting picture cache mode and setting
the picture cache time

Before recording in picture cache mode, you need
to perform the “Picture Cache Rec” and “P.
Cache Rec Time” settings in the “OPERATION”
menu (see page 119).

You can also select picture cache mode by using
an assignable switch to which the Picture Cache
function has been assigned (see page 158).

The picture cache time determines how far in
advance you can start recording, counting back in
seconds from the operation that starts recording.
Note that it may not be possible to start this far in
advance in the special cases explained in the
following notes.

Storage of picture data to memory begins when you
select picture cache mode. Therefore, if you start
recording immediately after selecting picture cache
mode, the picture data from before the selection is not
recorded.

No data is recorded to picture cache memory during
playback, recording review, or during thumbnail
display. It is not possible to record picture data from
the time you were conducting playback or a recording
review.

Picture cache recording is not possible in Frame Rec,
Interval Rec, and Slow & Quick Motion mode. The
camcorder exits Frame Rec, Interval Rec, or Slow &
Quick Motion mode whenever you select picture cache
mode. The camcorder exits picture cache mode
automatically whenever you select Frame Rec,
Interval Rec, or Slow & Quick Motion mode.

The data stored in memory is cleared when you change
the system settings, for example by selecting a
different video format. Picture data from before the
change is not recorded even if you start recording
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immediately after the change. The camcorder exits
picture cache mode automatically.

« It is not possible to set the picture cache time during
recording.

* When “OPERATION” > “Format” > “Rec Format” is
set to “XAVC-1,” the Picture Cache time can be set up
to 4 seconds.

Camcorder operation when recording in picture
cache mode

Recording procedures in picture cache mode are
basically the same as normal recording
procedures. However, note the following
differences with respect to how the camcorder
handles video, time, and output data.

« If you start recording while the media is being
accessed, the start point of the video that is
actually recorded may be later than the
currently specified picture cache time. Because
the delay increases as the number of recorded
clips increases, you should avoid rapid start-
and-stop recording operations in picture cache
mode.

Regardless of the setting of the F-RUN/SET/R-
RUN switch, the advance mode of the internal
timecode generator is always F-RUN.

In picture cache mode, you cannot set time data
by setting the F-RUN/SET/R-RUN switch to
SET.

To set time data, first exit picture cache mode.
If the remaining free capacity of the media in
the currently selected slot is less than the picture
cache time, and the media in the other slot has
enough remaining capacity, then data is
recorded to the media in the other slot.
However, no data is recorded when there is no
media in the other slot, and when the media in
the other slot does not have enough remaining
capacity. (A message appears in the viewfinder
to inform you that there is not enough remaining
capacity.)

Shot marks are not recorded if they are set
before the recording start operation.

When you select a video format that supports
i.LINK HDV output and play a clip that was
recorded in picture cache mode, two or more
frames with the same picture and timecode may
follow on each other.

i.LINK output is possible during picture cache
recording. However, the picture cache time is
limited.



If power is lost during recording

« If you set the camcorder’s POWER switch to
OFF, the camcorder is powered off
automatically after a few seconds, during which
the media is accessed to record the video and
audio data stored in the camcorder’s memory up
to that point.

« If power is lost because the battery was
removed, the DC cable was disconnected, or the
power was turned off on the AC adaptor side,
then the video and audio data stored in memory
is lost. The data stored in memory is not
recorded. Be careful to avoid this when
exchanging the battery.

Recording Time-lapse Video
(Interval Rec Function)

The camcorder’s Interval Rec function allows
you to capture time-lapse video to the
camcorder’s internal memory. This function is an
effective way to shoot slow-moving subjects.
When you start recording, the camcorder
automatically records a specified number of
frames at a specified interval time.

Interval time

I_l_l

//

umber of frames in one take

A pre-lighting function is available when Interval
Rec is enabled. This function automatically turns
on a video light before recording starts, which
allows you to record pictures under stable light
and color temperature conditions.

Interval Rec settings and shooting

Before recording in Interval Rec mode, you need
to perform the “Interval Rec,” “Number of
Frames,” “Interval Time,” and “Pre-Lighting”
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settings in the “OPERATION” menu (see

page 120).

The camcorder exits Interval Rec mode when it is
powered off, but the “Number of Frames,”
“Interval Time,” and “Pre-Lighting” settings are
maintained. You do not need to set them again the
next time you shoot in Interval Rec mode.

¢ The Interval Rec, Picture Cache Rec, Frame Rec, and
Slow & Quick Motion function cannot be used at the
same time. When you select one of those modes, the
previously selected function is disabled automatically.

The data stored in memory is cleared when you change
the system settings, for example by selecting a
different video format. Picture data from before the
change is not recorded even if you start recording
immediately after the change. The camcorder exits
picture cache mode automatically.

Interval Rec settings cannot be changed during
recording.

Interval Rec is disabled when the following formats

are selected.

- SP 1440/59.94i or SP 1440/50i, when the output

setting is HD and “OPERATION” > “Input/Output”

> “1.LINK I/O” in the setup menu is set to “Enable”

SP 1440/23.98P (pull-down recording)

- Other than HQ 1920/23.98P or HQ 1280/23.98P,
when the output setting is SD and “OPERATION” >
“Input/Output” > “i.LINK I/O” in the setup menu is
set to “Enable”

If you want to turn the video light on before the start of

recording, set the camcorder’s LIGHT switch to

AUTO. The video light’s switch must also be turned

on. When this is done, the video light turns on and off

automatically. However, the video light remains lit
when the time that it is off is five seconds or less.

If you set the LIGHT switch to MANUAL and turn the

video light’s switch on, the video light is always lit. (It

does not go on and off automatically.)

To shoot in Interval Rec mode

Make the settings and preparations described in
“Basic Operations” (page 84), secure the
camcorder so that it does not move, and begin
shooting.

When recording starts, the “Interval” indication
in the viewfinder changes from flashing to lit, and
“INT REC” and “INT STBY” appear
alternatively at the position of the REC
indication. The TALLY indicators and the tally
indicator on the front panel of the viewfinder light
as they do during normal recording.

If you are using the pre-lighting function, the
video light comes on before recording starts.



Limitations during recording

¢ The i.LINK (HDV/DV) connector cannot be
used.

* Regardless of the setting of the F-RUN/SET/
R-RUN switch, the advance mode of the
internal timecode generator is always R-RUN.

* Audio cannot be recorded.

* Recording review is not possible.

« If you press the SLOT SELECT button, the
camcorder completes recording of the specified
number of frames, creates a clip, and switches
to the other media.

* Genlock is not possible.

If power is lost during recording

« If you set the camcorder’s POWER switch to
OFF, the camcorder is powered off
automatically after a few seconds, during which
the media is accessed to record the video and
audio data stored in the camcorder’s memory up
to that point.

« If power is lost because the battery was
removed, the DC cable was disconnected, or the
power was turned off on the AC adaptor side,
then the video and audio data shot up to that
point may be lost (maximum 15 seconds). Be
careful to avoid this when exchanging the
battery.

Shooting Stop Motion Animations
(Frame Rec Function)

The Frame Rec function is useful for shooting
stop motion animations, such as animations with
puppets or clay figures.

Each time that you press the recording start
button, the camcorder shoots a specified number
of frames and then stops.

Frame Rec settings and shooting

Before recording in Frame Rec mode, you need to
perform the “Frame Rec” and “Number of
Frames” settings in the “OPERATION” menu
(see page 120).

The camcorder exits Frame Rec mode when it is
powered off, but the setting for the number of
frames setting is maintained. You do not need to
set it again the next time you shoot in Frame Rec
mode.
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The Interval Rec, Picture Cache Rec, Frame Rec, and
Slow & Quick Motion function cannot be used at the
same time. When you select one of those modes, the
previously selected function is disabled automatically.
The data stored in memory is cleared when you change
the system settings, for example by selecting a
different video format. Picture data from before the
change is not recorded even if you start recording
immediately after the change. The camcorder exits
Frame Rec mode automatically.

Frame Rec settings cannot be changed during
recording.

Frame Rec is disabled when the following formats are
selected.

- SP 1440/59.94i or SP 1440/50i, when the output
setting is HD and “OPERATION” > “Input/Output”
> “1.LINK I/O” in the setup menu is set to “Enable”
SP 1440/23.98P (pull-down recording)

Other than HQ 1920/23.98P or HQ 1280/23.98P,
when the output setting is SD and “OPERATION” >
“Input/Output” > “i. LINK I/O” in the setup menu is
set to “Enable”

To shoot in Frame Rec mode

Make the settings and preparations described in
“Basic Operations” (page 84), secure the
camcorder so that it does not move, and begin
shooting.

When recording starts, the “Frame Rec”
indication in the viewfinder changes from
flashing to lit, and “FRM REC” and “FRM
STBY” appear alternatively at the position of the
REC indication. The TALLY indicators and the
tally indicator on the front panel of the viewfinder
light as they do during normal recording.

Limitations during recording

¢ The i.LINK (HDV/DV) connector cannot be
used.

* Regardless of the setting of the F-RUN/SET/
R-RUN switch, the advance mode of the
internal timecode generator is always R-RUN.

* Audio cannot be recorded.

* Recording review is not possible.

* If you press the SLOT SELECT button, the
camcorder completes recording of the specified
number of frames, creates a clip, and switches
to the other media.

* Genlock is not possible.

If power is lost during recording
» If you set the camcorder’s POWER switch to
OFF, the camcorder is powered off



automatically after a few seconds, during which
the media is accessed to record the video and
audio data stored in the camcorder’s memory up
to that point.

« If power is lost because the battery was
removed, the DC cable was disconnected, or the
power was turned off on the AC adaptor side,
then the video and audio data shot up to that
point may be lost (maximum 15 seconds). Be
careful to avoid this when exchanging the
battery.

Shooting with Slow & Quick
Motion

When the video format (see page 44) is set to one

of the formats listed below, you can specify a

recording frame rate that is different from the

playback frame rate.

When the “Country” setting is “NTSC Area”/
”NTSC(J) Area”

Recording format System frequency

XAVC-1 1920/29.97P
1920/23.98P

1280/59.94P

XAVC-L50 1920/29.97P
1920/23.98P

1280/59.94P

XAVC-L35 1920/29.97P

1920/23.98P

HD422 50/1920/29.97P
50/1920/23.98P
50/1280/59.94P
50/1280/29.97P

50/1280/23.98P

HQ 1920/29.97P
1920/23.98P
1280/59.94P
1280/29.97P
1280/23.98P

When the “Country” setting is “PAL Area”

Recording format System frequency

XAVC-I 1920/25P
1280/50P

XAVC-L50 1920/25P
1280/50P

XAVC-L35 1920/25P

HD422 50/1920/25P

50/1280/50P
50/1280/25P

Recording format System frequency

HQ 1920/25P
1280/50P
1280/25P

Slow & Quick Motion settings and
shooting

Before recording in Slow & Quick Motion mode,
you need to perform the “Slow & Quick” and
“Frame Rate” settings in the “OPERATION”
menu (see page 119).

When you finish making these settings, the
system frequency and the frame rate appear at the
top of the viewfinder screen. You can change the
frame rate while viewing the display in the
viewfinder by turning the MENU knob.

The Slow & Quick Motion mode setting and the
frame rate are retained even after the camcorder is
powered off.

The Interval Rec, Picture Cache Rec, Frame Rec, and
Slow & Quick Motion function cannot be used at the
same time. When you select one of those modes, the
previously selected function is disabled automatically.
Slow & Quick Motion is disabled when the slow
shutter function (viewfinder display “SLS”) functionis
enabled. The slow shutter function is disabled when
the Slow & Quick Motion function is enabled.

Slow & Quick Motion is disabled when
“OPERATION” > “Input/Output” > “i.LINK I/O” in
the setup menu is set to “Enable.” When Slow & Quick
Motion is enabled, “i.LINK I/O” is fixed as “Disable.”
Slow & Quick Motion settings cannot be changed
during recording.

To shoot in Slow & Quick Motion mode
Shoot as described in “Basic Operations”
(page 84).

When recording starts, the “S&Q STBY”
indication in the viewfinder changes to the
“@S&Q REC” indication. The TALLY
indicators and the tally indicator on the front
panel of the viewfinder light as they do during
normal recording.

Limitations during recording

¢ The i.LINK (HDV/DV) connector cannot be
used.

* Regardless of the setting of the F-RUN/SET/
R-RUN switch, the advance mode of the
internal timecode generator is always R-RUN.



¢ Audio cannot be recorded when the recording
and playback frame rates differ.

Recording review is not possible.

If you change the recording frame rate to a value
faster than the current shutter speed, the shutter
speed is changed to the slowest value for which
shooting is possible.

Example: If the frame rate is 32 and the shutter
speed is 1/40, and you change the frame rate to
55, then the shutter speed is changed to /¢,

If is not possible to select a shutter speed that is
slower than the recording frame rate.

¢ Genlock is not possible.

Recording with the Clip
Continuous Rec Function

Normally, a clip is created as an independent file
each time that you start and stop recording. This
function allows you to start and stop recording
while continuously recording to the same clip, for
as long as the function remains enabled. This is
convenient when you do not want to generate a
large number of short clips, and when you want to
record without worrying about exceeding the clip
limit. It is still easy to find recording start points,
because a Rec Start essence mark is recorded at
the recording start point each time you start
recording.

Clip Continuous Rec settings and
shooting

The Clip Continuous Rec function cannot be used at
the same time as the Picture Cache, Interval Rec,
Frame Rec, or Slow & Quick Motion function. When
you select Clip Continuous Rec mode, the Picture
Cache, Interval Rec, Frame Rec, and Slow & Quick
Motion functions are disabled. When you select
picture cache, Frame Rec, Interval Rec, or Slow &
Quick Motion mode, the Clip Continuous Rec function
is disabled.

The Clip Continuous Rec function is disabled when the
recording mode is FAT.

To set Clip Continuous Rec

1 Select “OPERATION” > “Rec
Function” > “Clip Continuous Rec” in
the setup menu.

For details about menu operations, see “Basic
Setup Menu Operations” (page 110).
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2 Turn the MENU knob to select “On,”
and then press the knob.
The “CONT” indication flashes in the
viewfinder, and the function is enabled.

You can assign the Clip Continuous Rec on/off
function to one of the ASSIGN. 1/2/3 switches,
ASSIGNABLE 4/5 switches, and the COLOR
TEMP button.

For details, see “Assigning Functions to Assignable
Switches” (page 158).

To shoot in Clip Continuous Rec mode

Shoot as described in “Basic Operations”

(page 84).

When recording starts, the “CONT” indication in
the viewfinder changes to “@REC” indication.
The TALLY indicators and the tally indicator on
the front panel of the viewfinder light as they do
during normal recording.

During recording or in recording standby mode
(when the “CONT” indication is lit), if you
remove the media, the battery, or the power
source, the media needs to be restored. It is not
possible to restore media on a device other than
this camcorder.

Exit Clip Continuous Rec mode (see page 91) and
then remove the media.

When the “CONT” indication is flashing (at 1
flash/s), you can remove the media.

To stop shooting

Stop the recording. The camcorder changes to the
recording standby mode (STBY) and the
“CONT” indication lights up.

Stop the recording after the recording continues
for two or more seconds.

To exit Clip Continuous Rec mode

With the camcorder in recording standby mode,
set “OPERATION” > “Rec Function” > “Clip
Continuous Rec” in the setup menu to “Off.”

Limitations during recording

A single continuous clip cannot be created if you
perform one of the following operations while the
camcorder is in recording or recording standby
mode (a new clip will be created when you next
start recording.)

* Operate on a clip (lock, delete, or rename a clip)
* Change the slot



¢ Change the recording format The freeze mix display is canceled and the

¢ Turn off the POWER switch display returns to the normal camera picture.
 Playback « Start recording (see page 84).
* Switch to thumbnail mode Normal recording starts.

Framing Shots with the Freeze
Mix Function

The freeze mix function allows you to
temporarily overlap a still image (freeze picture)
from a clip shot in HD mode onto the current
camera picture. This makes it easier to frame the
shot.

The freeze mix function is not available in the following

cases.

¢ When the recording format is SP 1440/23.98P

* When the video formats of the recorded picture and the
camera picture differ

* When you are shooting in Slow & Quick Motion mode
or slow shutter mode

¢ When there is i.LINK input

To display a freeze mix picture

1 Play a clip or conduct a recording
review of a clip with the same format as
the camera picture.

2 Display the picture that you want to use
as the frame, and then turn on the
assignable switch to which the Freeze
Mix function has been assigned.

The recording review picture is frozen and
overlaps the camera picture.

The following functions are disabled at the freeze mix
times.

* Menu operations

¢ During Focus Mag display

¢ Marker display

* Zebra display

« Peaking display

» Skin detail display

To cancel the freeze mix display

Do one of the following.
* Press an assignable switch again to which the
Freeze Mix function has been assigned.
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Planning Metadata
Operations

Planning metadata is information about shooting
and recording plans, recorded in an XML file.

<?xmispversion="1.0'spencoding="UTF-8'?>

<PlanningMetadata

xmins="http://xmins.son; p
assignld="P0001" creationDate="2011-08-20T17:00:00+09:00"
lastUpdate="2011-09-28710:30:00+09:00" load="false" version="1.00">

P pertyld="assi update="2011-08: 00:00+09:00°
modifiedBy="Chris">

<TitlespusAscii="Typhoon" xml:lang="ja’> & & L B </Title>
</Properties>

</PlanningMetadata>

Example of a planning metadata file

You can shoot using clip names and shot mark
names defined in advance in a planning metadata
file.

The camcorder can display clip names and shot
mark names defined in the following languages.
¢ English

 Chinese

¢ German

« French D

e Italian

 Spanish

« Dutch

* Portuguese

* Swedish

* Norwegian

¢ Danish

« Finnish

1) Some characters may be displayed in a similar font.

If you define clip name and shot mark names in
languages other than the above, they may not be
displayed on the viewfinder screen.

Loading a Planning Metadata File
into Camcorder’s Internal Memory

To record planning metadata together with
recording clips, you need to load a planning

metadata file into the camcorder’s memory before

starting to shoot.

There are two ways to load files.

* Load afile that has been written to the following
directories on an SxS memory card or a USB
flash drive.

Recording Media Directory to

mode which files are
written
FAT SxS memory BPAV/General/
card Sony/Planning
SDHC PRIVATE/SONY/
BPAV/General/
Sony/Planning
exFAT SxS memory XDROOT/
card General/Sony/
Planning
USB flash drive General/Sony/
Planning
UDF SxS memory General/Sony/
card Planning

USB flash drive

* When a wireless LAN connection is made
between the camcorder and a computer, operate
the Web menu built in the camcorder from the
computer to transfer a file.

To load a planning metadata file by menu
operation

Do the following procedures with
“OPERATION” > “Planning Metadata” in the
setup menu.

To load a file in an SxS memory card

1 Insertan SxS memory card into the
memory card slot A or B, and set
“Load/Slot(A)” or “Load/Slot(B)” to
“Execute.”

A file list appears.

The file list displays up to 64 files. Even if the total
number of planning metadata files is 64 or less, all
of the planning metadata files may not appear if the
directory where they are located on the SxS
memory card (General/Sony/Planning) contains
512 or more files.

2 Turn the MENU knob to select a file to
load and press the knob.



To load a file in a USB flash drive (UDF, exFAT
modes)

1 Connect a USB flash drive formatted
with the FAT32 file system to the

external device connector (see page 65).

A file list appears.

The file list displays up to 64 files. Even if the total
number of planning metadata files is 64 or less, all
of the planning metadata files may not appear if the
directory where they are located on the USB flash
driver (General/Sony/Planning) contains 512 or
more files.

2 Turn the MENU knob to select a file to
load and press the knob.

To display detailed information in
planning metadata

After loading planning metadata into the
camcorder, you can check the detailed
information that it contains, such as file names,
date and time of creation, and titles.

Select “OPERATION” > “Plan.Metadata” >
“Properties” (see page 130) in the setup menu,
then select “Execute.”

To clear the planning metadata loaded

Select “OPERATION” > “Plan.Metadata” >
“Clear” (see page 130) in the setup menu, then
select “Execute.”

Defining Clip Names in Planning
Metadata

The following two types of clip name strings can

be written in a planning metadata file.

¢ The ASCII format name that appears in the
viewfinder

¢ The UTF-8 format name that is actually
registered as the clip name

Select “OPERATION” > “Plan.Metadata” >
“Clip Name Disp” (see page 130) in the setup
menu, then select which type of clip name is
displayed.

When a clip name is set with planning metadata,
the name is displayed under the depth of field
indication on the viewfinder screen.
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Clip name string example

Use a text editor to modify the two fields in the
<Title> tag that contain the clip name strings.
The shaded fields in the example are clip name
strings. “Typhoon” is described in ASCII format
(up to 44 characters). “Typhoon_Strikes_Tokyo”
is described in UTF-8 format (up to 44 bytes).
“sp” indicates a space and + indicates a carriage
return.

<?xmlgpversion="1.0"gpencoding="
UTF-8"7>¢=
<PlanningMetadatagpxmIns="http://
xmlns.sony.net/pro/metadata/
planningmetadata”passignld="
P0001"g,creationDate="
2011-08-20T17:00:00+09:00",
lastUpdate="
2011-09-28T10:30:00+09:00",
version="1.00">«
<Propertiesg,propertyld="
assignment"g update="
2011-09-28T10:30:00+09:00",
modifiedBy="Chris">«
<TitlegyusAscii="Typhoon ",
xml:lang="en">Typhoon_Strikes_Tokyo
</Title>+
</Properties>+
</PlanningMetadata>«

* When you create a file, enter each statement as a single
line with a CRLF only after the last character in the
statement line, and do not enter spaces except where
specified.

Up to 44 bytes (or characters) string is available for the
clip name.

If the UTF-8 format string exceeds 44 bytes, 44 bytes
string is used as the clip name.

If only ASCII format name is specified, 44 characters
string is used as the clip name.

When neither an ASCII format name string nor UTF-8
format name string can be used, the standard format
clip name is used.

To set clip names

Load a planning metadata file that contains clip
names into this camcorder, select
“OPERATION” > “Clip” > “Auto Naming” (see
page 128) in the setup menu, then select “Plan.”
Each time that you record a clip, the camcorder
automatically generates a name consisting of the




clip name defined in the planning metadata file,
with the addition of an underbar (_) and a four-
digit serial number (0001 to 9999).

Examples: Typhoon_Strikes_Tokyo_0001,
Typhoon_Strikes_Tokyo_0002, ...

* When the serial number reaches to 9999, it returns to
0001 with the next recording operation.

* When you load another planning metadata file, the
serial number returns to 0001.

Defining Shot Mark Names in
Planning Metadata

When you use planning metadata to set shot
marks, you can define names for Shot Mark 0 to
Shot Mark 9.

When you record shot marks, you can add the
shot mark name strings defined in the planning
metadata.

Shot Mark 1 and Shot Mark 2 can be recorded on the
camcorder. Shot Mark 3 to Shot Mark 9 and Shot Mark
0 can be recorded by operation from a computer which is
connected with the camcorder via wireless LAN.

Shot mark name string example

Use a text editor to modify the fields in the <Meta
name> tag.

The shaded fields in the example are essence
mark name strings. Names can be either in ASCII
format (up to 32 characters) or UTF-8 format (up
to 16 characters).

“sp” indicates a space and + indicates a carriage
return.

If a name string contains even one non-ASCII character,
the maximum length of that string is 16 characters.

<?xmlgpversion="1.0"g encoding="
UTF-8" 7>+

<PlanningMetadata xmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata”,assignld="
HO00123" g, creationDate="
2011-04-15T08:00:00Z" s, lastUpdate="
2011-04-15T15:00:00Z" g, version=
"1.00">«
<Propertiesgppropertyld=
"assignment",class="original",
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update="2011-04-15T15:00:00Z" g,
modifiedBy="Chris">«
<TitlegpusAscii="Football
Game"pxml:lang="en">
Football Game 15/04/2011</
Title>«
<Metag,name="_ShotMark1"y,
content="|Goal "/>«
<Metagpname="_ShotMark2",
content="{Shoot |"/>«
<Metag,name="_ShotMark3",
content="|Corner Kick |"/>«
<Metag,name="_ShotMark4",
content="Free Kick "/>+«
<Metagpname="_ShotMark5",
content="|Goal Kick "/>«
<Metag,name="_ShotMark6",
content="{Foul "/>«
<Metag,name="_ShotMark7"g,
content="[PK "/>«
<Metagpname="_ShotMark8",
content="{1st Half "/>«
<Metag,name="_ShotMark9",
content="2nd Half "/>«
<Metaspname:”_ShotMaIk0"
content="[Kick Off "/>+«
</Properties>+
</PlanningMetadata>«

‘When you create a definition file, enter each statement as
a single line with a CRLF only after the last character in
the statement line, and do not enter spaces except where
specified, except within shot mark name strings.

sp



A thumbnail screen appears if you press the THUMBNAIL button in E-E or playback mode. Thumbnail
screens display lists of the clips stored on SxS memory cards in the form of index pictures. (A message
appears if you insert a memory card that contains no clips.)

You can select any clip (see page 97) in a thumbnail screen and start playback of that clip (see page 97).
To exit the thumbnail screen, press the THUMBNAIL button again.

Thumbnail Screen

In thumbnail screens, the timecode of the index picture appears beneath the thumbnail for each clip. (An
OK mark also appears when a clip has been marked with an OK mark.)
The clip information on the cursor location is displayed at the bottom of the screen.

Cursor

(yellow) . R
The icon of the currently selected SxS memory card is highlighted.
(If the card is write protected, a lock mark appears on the left.)

Clip number/Number of clips

(@CAZ 1 )0011/0300
| o, oA

roR
01:10:50:00

© Index picture or the OK mark is on the clip, the lock mark 12
UDF, exFAT, FAT-HD mode: When a clip is appears.

recorded, its first frame is set automatically as the FAT-SD mode: When a clip is recorded, its first
index picture. You can change the index picture frame is set automatically as the index picture. If
to any frame (see page 106). If the clip is locked the file size is larger than 2 GB, and that the clip
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has been split before being saved, the take mark
(sv] appears. You can check the segment files on
the expand thumbnail screen (see page 104).

@ Date and start time of recording

© Clip name

The number after the clip name (delimited by /) is
the number of components. This appears only for
clips larger than 2 GB in size, which have been
split into smaller files for storage in the FAT-SD
mode.

O Lock mark (UDF, exFAT, and FAT-HD
mode only)

Indicates the selected clip is marked with an OK

mark.

© Independent AV file icon (UDF, exFAT,
and FAT-HD mode only)
Appears only when a clip is an independent AV
file. SxS memory cards may contain independent
files that have been added directly from a
computer. Because independent files lack the
associated management files, some operations
and information displays may not be available.

O Video format of recording

@ Special recording information (UDF,
exFAT, and FAT-HD mode only)
Displays the mode of clips that have been
recorded in a special mode (Slow & Quick
Motion, Interval Rec, Frame Rec).
For Slow & Quick Motion clips, the frame rates
are displayed to the right as “Recording frame
rate/Playback frame rate” fps.

O OK, NG, KP mark (UDF, exFAT, and
FAT-HD mode only)

UDF, exFAT: When an OK, NG, or KP flag is

added to the selected clip, the corresponding mark

is added to the clip.

FAT-HD mode: When an OK mark is added to

the selected clip, the OK mark is added to the clip.

© File format

Indicates the file format of the selected clip
(MXF, MP4, AVI). (File format does not indicate
when in UDF/HD mode.)
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@ Clip duration

@ Timecode
This is the timecode of the index picture.

Normal thumbnail screens display SD clips only or HD
clips only, even if the SxS memory card contains clips in
both formats. You can select the format to display by
selecting a mode with “OPERATION” > “Format” >
“HD/SD” (see page 115) in the setup menu.

If you want to display all recorded clips, regardless of the
HD/SD mode, switch to the all clips thumbnail screen
(see page 101). However, it is not possible to start
playback from the all clips thumbnail screen.

To switch between SxS memory cards

When two SxS memory cards are loaded, you can
switch between them by pressing the SLOT
SELECT button.

While an expand thumbnail screen (see page 104) or a
shot mark (essence mark) thumbnail screen (see

page 105) is displayed, SxS memory cards cannot be
switched.

Playing Clips

To select clip thumbnails

Do one of the following to move the yellow
cursor to the clip that you want to select.

« Press the arrow buttons (f}, &, <=, =>).
e Turn the MENU knob.

* Press the PREV or NEXT button.

To select the first thumbnail
With the F REV button held down, press the
PREYV button.

To select the last thumbnail
With the F FWD button held down, press the
NEXT button.

To play clips sequentially starting from a
selected clip

1 Select the thumbnail of the clip that you
want to play first.

2 Press the PLAY/PAUSE button.
Play begins from the top of the selected clip.



Play continues through all clips after the selected
clip.

When the last clip has been played to the end, the
camcorder enters pause (still image) mode at the
last frame of the last clip.

Press the THUMBNAIL button to return to the
thumbnail screen.

Playback also stops if you eject the memory card.
In this case, the camera picture appears in the
viewfinder.

There may be momentary picture breakup or still
image display at the transition from one clip to another.
During this time, the playback controls and the
THUMBNAIL button cannot be operated.

When you select a clip in the thumbnail screen and
begin playback, there may be momentary picture
breakup at the top of the clip. To view the top of the
clip without breakup, put the camcorder into playback
mode, pause, use the PREV button to return to the top
of the clip, and start playback again.

On SxS memory cards that contain both HD-mode and
SD-mode clips, you cannot play all clips in sequence.
For example, while an HD mode thumbnail screen is

displayed, only HD mode clips are played in sequence.

To cue up clips

To play from the top of the first clip
Simultaneously press the PREV and F REV
buttons. This jumps to the start of the first clip on
the SxS memory card.

To play from the start of the last clip
Simultaneously press the NEXT and F FWD
buttons. This jumps to the start of the last clip on
the SxS memory card.

To add a shot mark during play (HD mode
only)

You can add shot marks to clips during play by
using the same method used during recording (see
page 86).

» Shot marks cannot be recorded when the SxS memory
card is write protected.

« Shot marks cannot be added at the first frame of each
clip or last frame of the last clip.

Using Thumbnails to Search
Inside Clips

» Expand thumbnail screen
* Shot mark thumbnail screen (HD mode only)

Like the normal thumbnail screen and the OK clip
thumbnail screen, these screens allow you to
select clip thumbnails (see page 97) and to start
clip playback (see page 97).

To search clips with the expand
thumbnail screen

To display the expand thumbnail screen, select a
clip in the thumbnail screen and press the
EXPAND button (see page 16) or select
“THUMBNAIL” > “Thumbnail View” >
“Forward Expansion” in the setup menu. The
selected clip is displayed as follows.

HD mode: The clip is divided into 12 equally-
sized blocks, and a thumbnail of the first
frame in each block is displayed.

SD mode: Only in the case of clips that have been
split into partial files because the file size was
larger than 2 GB, a thumbnail of the first
frame of each partial file is displayed.

For details about the expand thumbnail screen, see
“Displaying the Expand Thumbnail Screen (UDF/
exFAT/FAT-HD Mode only)” (page 104).

To search for shot marks in clips with the
shot mark thumbnail screen (HD mode
only)

When a clip contains one or more shot marks, you
can easily find them with the shot mark thumbnail
screen. The shot mark thumbnail screen displays
a thumbnail of each shot mark frame in the clip.
To display the shot mark thumbnail screen, press
the ESSENCE MARK button (see page 17) or
select “THUMBNAIL” > “Thumbnail View” >
“Essence Mark Thumbnail” in the setup menu.
For details about the shot mark thumbnail screen,

see “Displaying the Shot Mark Thumbnail Screen
(UDF/exFAT/FAT-HD Mode Only)” (page 105).



Thumbnail Operations

You can use the THUMBNAIL menu to perform various operations on clips, to check clip properties, and
to change clip metadata.

THUMBNAIL Menu Configuration

Menu item Sub-item Description
Clip Properties — Displays detailed properties (see page 102).
Set Index Picture — Changes index pictures in the expand
|UDF |/|exFAT |/| FAT-HD | thumbna¥l screen or the essence mark
thumbnail screen (see page 106).
Thumbnail View Forward Expansion « Displays the expand thumbnail screen (see
page 104).

¢ In the expand thumbnail screen, increases the
number of divisions (see page 105).

Back Expansion In the expand thumbnail screen, decreases the
number of divisions.

Essence Mark Thumbnail ~Displays the essence mark thumbnail screen

[UDF |/[exFAT |/[FAT-HD (see page 105).
Clip Thumbnail Displays the normal thumbnail screen.
All Clip Thumbnail Displays the all clips thumbnail screen (see
page 101).
Set Shot Mark Add Shot Mark1 In the expand thumbnail screen or the essence
[UDF |/[exFAT |/[FAT-HD | mark thumbnail screen, adds a Shot Mark1

mark (see page 106).

Delete Shot Mark1 In the expand thumbnail screen or the essence
mark thumbnail screen, deletes a Shot Mark1
mark (see page 106).

Add Shot Mark2 In the expand thumbnail screen or the essence
mark thumbnail screen, adds a Shot Mark2
mark (see page 106).

Delete Shot Mark2 In the expand thumbnail screen or the essence
mark thumbnail screen, deletes a Shot Mark2
mark (see page 106).

Set Clip Flag OK Adds an OK mark.
/ NG Adds an NG mark.
KP(Keep) Adds a KP mark.
None Deletes an OK, NG. or KP mark.
Add OK Mark — Adds an OK mark and protects a clip (see
page 103).
Delete OK Mark — Deletes an OK mark and unlocks a clip (see

page 103).
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Menu item Sub-item Description

Lock Clip — Protects a clip.

/

Unlock Clip — Unlocks a clip.

I [exFAT |

Copy Clip Copy Clip(A)/Copy Copies a clip (see page 103).
Clip(B)/Copy Clip(USB)

Delete Clip — Deletes a clip (see page 104).

Divide Clip — Divides a clip (see page 106).

FAT-HD

Filter Clips — Displays the OK clip thumbnail screen (see

pase 100

Filter Clips OK Displays the OK clip thumbnail screen.
NG Displays the NG clip thumbnail screen.
KP(Keep) Displays the KP clip thumbnail screen.
None Displays a None clip (clip which has not been

marked OK, NG, or KP) thumbnail screen.

Lock All Clips — Protects all clips displayed.

I [exFAT |

Unlock All Clips — Unlocks all clips displayed.

I [exFAT |

Copy All All Clips Batch copies groups of clips/files (see
General Files page 103).
All Clips & General Files

Delete All Clips Execute/Cancel Deletes all unprotected clips (see page 104).
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Basic THUMBNAIL Menu
Operations

For menu operations, see “Basic Setup Menu
Operations” (page 110).

To display the THUMBNAIL menu

1 Press the THUMBNAIL button to
display the thumbnail screen.

2 Set the MENU ON/OFF switch to ON,
or press the MENU button.

3 Turn the MENU knob to select “TH,”
and then press the knob. Or press the 4
or i button to select “TH,” and then
press the SET button.

The THUMBNAIL menu appears.

To hide the THUMBNAIL menu, press the
MENU button again.

To select menu items and sub-items

Do one of the following.

¢ Turn the MENU knob to select an item or sub-
item, and then press the knob.

 Press the arrow buttons (1}, &, <=, =) t0
select an item or sub-item, and then press the
SET button.

According to the selected item or sub-item, a

selection list or a clip properties screen appears

(see page 102).

To return to the previous state, push the MENU

CANCEL/PRST/ESCAPE switch down to the

ESCAPE side.

* Some items cannot be operated, when an SxS memory
card is write protected.

« Some items cannot be selected, depending on the state
of the camcorder when the menu was displayed.

To hide the clip properties screen

Do one of the following.

Press the RESET/RETURN button: This
returns to the THUMBNAIL menu.

Press the THUMBNAIL button: The
camcorder enters E-E mode, and the camera
picture appears.
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Press the PLAY/PAUSE button: Playback from
the selected clip starts.

Changing the Thumbnail Screen
Type

To display OK clip thumbnails (HD mode
only)

When the normal thumbnail screen is displayed,
you can select “THUMBNAIL” > “Filter Clips”
to switch to the OK clip thumbnail screen.

For details about adding OK marks, see “Adding/
Deleting the OK Mark (FAT-HD Mode Only)”
(page 103).

OK/NG/KP/None-Clip thumbnail screen

Only the clips flagged OK/NG/KP, or clips with
no flag (“None”), among the clips on the current
SxS memory card are displayed. You can select
the type of flag to display with “THUMBNAIL”
> “Filter Clips” (see page 100).

To display the all clip thumbnail screen

When the normal thumbnail screen is displayed,
you can switch to the all clips thumbnail screen
by selecting “THUMBNAIL” > “All Clip
Thumbnail.”

Pressing the RESET/RETURN button returns
you to the normal thumbnails screen, where you
can perform playback and other clip operations.

You cannot start playback from the all clip thumbnail
screen.



Displaying Clip Properties

Select “Clip Properties” in the THUMBNAIL menu.

{ NN | PROPERTIES |

111, (&)@—

5
)
fos)f
)_
)_
)_

90609600000 ©

(3]

© Image of the current clip

@ Image of the previous clip
Press the PREV button to display the properties of
the previous clip.

© Image of the next clip
Press the NEXT button to display the properties
of the next clip.

O Clip name

‘When clip names are 12 characters or longer, only
the first five characters and the last five characters
are displayed. If you want to check the hidden
characters, press the MENU knob to display all
characters of the clip (long display mode).

Press the MENU knob again to exit long display
mode. Pressing the PREV or NEXT button to
display the previous or next clip also exists long
display mode.

In FAT-SD mode, only for clips that have been
divided because the file size was greater than 2
GB, the number of component clips appears after
the clip name.

© Lock mark (UDF, exFAT, and FAT-HD
mode only)

This appears when the clip is marked with an OK

mark or protected.
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0O OK, NG, KP mark (UDF, exFAT, and
FAT-HD mode only)

UDF/exFAT: When an OK, NG, or KP flag is
added to the selected clip, the corresponding mark
is added to the clip.

FAT: When an OK mark is added to the selected
clip, the OK mark is added to the clip.

@ Date and start time of recording

©® File format
The file format of the clip (MXF, MP4 or AVI)
appears.

© Special recording information (UDF,
exFAT, and FAT-HD mode only)
Displays the mode of clips that have been
recorded in a special mode (Slow & Quick
Motion, Interval Rec, Frame Rec).
For Slow & Quick Motion clips, the frame rates
are displayed to the right as “Recording frame
rate/Playback frame rate.”

@ Timecode of the displayed image

@ Timecode of the recording start point
@ Timecode of the recording end point
@® Duration

@ Recorded audio channels



@® Video format of recording

Adding/Deleting a Flag (UDF,
exFAT Modes)

You can add an OK/NG/KP flag to clips recorded
in UDF or exFAT mode. By adding flags, you can
set the camcorder to display only clips with
certain flag settings on the thumbnail screen (OK/
NG/KP/None-Clip thumbnail screen) (see

page 101).

When adding a flag, you can select from “OK,”
“NG,” “KP” (Keep) in “Set Clip Flag” of the
THUMBNAIL menu (see page 99) on the
thumbnail screen. When deleting a flag, select
“None.”

Flagged clips are not protected. To protect clips from
deletion, select “Lock Clip” in the THUMBNAIL menu
(see page 99) on the thumbnail screen. To remove the
protection, select “Unlock Clip.”

Adding/Deleting the OK Mark
(FAT-HD Mode Only)

By adding an OK mark to clips recorded in FAT-
HD Mode, you can set the camcorder to display
only the necessary clips on the thumbnail screen
(see page 101). Clips with an OK mark added are
blocked from being deleted or segmented. To
delete or segment them, remove the OK mark.
From the THUMBNAIL menu (see page 101) on
the thumbnail screen, you can select “Add OK
Mark” to add an OK mark, or “Delete OK Mark™
to delete the OK mark.

Copying Clips

You can copy clips to other SxS memory cards.
Clips are copied to destination SxS memory cards
using the same names as the original clips.

« If a clip with the same name already exists at the copy
destination SxS memory card, a one-digit number in
parentheses is added to the original name.
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The number in parentheses is the smallest number that
does not exist at the copy destination.

Examples:

ABCD0002—ABCD0002(1)
ABCDO0002(1)—ABCD0002(2)
ABCDO0005(3)—>ABCD0005(4)

If the parenthetical numbers (1) to (9) already exist at
the copy destination, it is not possible to copy any more
clips under that name.

A message appears if there is not enough free capacity
at the copy destination SxS memory card. Exchange
the card for one with more free capacity.

When multiple clips are recorded in a source SxS
memory card, it may not be possible to copy all clips
to the end. Depending on memory characteristics and
usage of the memory cards, this can occur even when
the source and destination memory cards have the
same capacity.

Copying a specified clip

You can copy a clip selected on the thumbnail
screen to another SxS memory card.

Select “THUMBNAIL” > “Copy Clip” >
“Execute” in the setup menu, then press the
MENU knob.

To cancel a copy operation
Press the RESET/RETURN button.

To batch copy groups of clips/files

Select “THUMBNAIL” > “Copy All” > “All
Clips” > “Execute” in the setup menu, then press
the MENU knob.

When both HD-mode and SD-mode clips exist on
the source SxS memory card, only clips in the
currently selected mode are copied. This is a
convenient way to extract clips in one of the
modes.

You can also copy of the files in the General
directory, either together with or separately from
clips.

To cancel the copy operation
Press the RESET/RETURN button.

To copy all files in the General directory

To copy all files only, without copying clips,
select “THUMBNAIL” > “Copy All” > “General
Files.” To copy all files together with all clips,
select “THUMBNAIL” > “Copy All” > “All
Clips & General Files.”

Copying to USB media
When USB media is connected, select a clip on a
thumbnail screen and select “Copy Clip” > “Copy



Clip(USB)” from the THUMBNAIL menu to
copy the clip to the USB media.

USB flash drives must be formatted with the
exFAT file system.

To format the drive in the camcorder, select
“USB Set” > “Format” > “exFAT” in the
MAINTENANCE menu.

A confirmation message prompting you to
execute formatting appears on the LCD monitor.
Select “Execute,” then press the MENU knob.
You can also copy all SxS memory card clips to
USB media by selecting “USB Set” > “Copy To
USB” in the MAINTENANCE menu. This copies
only clips for the selected mode in the same way
as selecting “Copy All” in the MAINTENANCE
menu.

Deleting Clips

You can delete clips that is selected in the
thumbnail screen.

Select “THUMBNAIL” > “Delete Clip” >
“Execute” in the setup menu, then press the
MENU knob.

HD clips with OK marks cannot be deleted.
If you want to delete such clips, first delete the OK marks
(see page 103).

To batch delete groups of clips

You can delete clips that are selected in the
thumbnail screen.

Select “THUMBNAIL” > “Delete All Clips” >
“Execute” in the setup menu, then press the
MENU knob.

¢ When both HD-mode and SD-mode clips exist on the
SxS memory card, only clips in the currently selected
mode are deleted.

« In HD mode, clips with OK marks are not deleted,
even when a deletion is executed for a group of clips
that includes them.

To cancel the deletion
Press the RESET/RETURN button.
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Displaying the Expand Thumbnail
Screen (UDF/exFAT/FAT-HD Mode
only)

The expand thumbnail screen allows you to
search inside clips by using thumbnails (see
page 98), to change index pictures (see

page 106), and to add and delete shot marks (see
page 106).

To display the screen

In the thumbnail screen, select a thumbnail and
press the EXPAND button (see page 16) or select
“THUMBNAIL” > “Thumbnail View” >
“Forward Expansion.”

An expand thumbnail screen for the selected clip
appears.

Expand thumbnail screen in HD mode

In HD mode, the selected clip is divided into 12
equally-sized blocks, and a thumbnail of the first
frame in each block is displayed.

Number of the selected frame

EXPAND alAZEl 1§

Clip properties are displayed at the bottom of the
screen.

Except for the items listed below, the information
displayed here is the same as the information
displayed in the normal thumbnail screen.

@ Frame information
This displays frame information using icons.

Index picture

il

Frame with Shot Mark1

Frame with Shot Mark2

5?)




The same icons are also displayed beneath the
thumbnails. However, when several icons could
be displayed for the same frame, one icon is
selected for display, in the order of priority Index
picture — Shot Markl — Shot Mark2.

© Timecode display
This displays the timecode of the selected frame
in the expand thumbnail screen.

Expand thumbnail screen in SD mode

In SD mode, only in the case of clips that have
been split into partial files because the file size
was larger than 2 GB, a thumbnail of the first
frame of each partial file is displayed.

Number of the selected frame

EXPAND alCAT

00:19:00:00

01/JAN/2013 10:53

JPANOO11_01 DVCAM30P SQ

Clip properties are displayed at the bottom of the
screen.

Except for the items listed below, the information
displayed here is the same as the information
displayed in the normal thumbnail screen.

© Timecode display
This is the timecode of the selected partial file.

©® Duration
This is the duration of the selected partial file.

DUR 00:09:30:00)

To increase the number of divisions

When you press the EXPAND button, or select
“THUMBNAIL” > “Thumbnail View” >
“Forward Expansion,” the divided clip or file is
further divided into 12 equally-sized blocks (a
clip or file that has been divided into 12 is further
divided into 12, for 12 x 12 = 144 divisions). You
can repeat the same operation to increase the
number of divisions.

To return to the previous division level

Press the EXPAND button with the SHIFT button
held down, or select “THUMBNAIL” >
“Thumbnail View” > “Back Expansion.” The
expand thumbnail screen returns to the previous
division level.

Displaying the Shot Mark
Thumbnail Screen (UDF/exFAT/
FAT-HD Mode Only)

You can search for shot marks in clips (see
page 98), change index pictures (see page 106),
and add and delete shot marks (see page 106).

1 In the thumbnail screen, select the
thumbnail of a clip, and press the
ESSENCE MARK button (see page 17)
or select “THUMBNAIL” >
“Thumbnail View” > “Essence Mark
Thumbnail.”

The shot mark thumbnail screen appears, and
a selection list is displayed.

2 Select the type of the essence mark

thumbnail screen.

All: Thumbnail display of all frames marked
with essence marks.

Shot Mark1: Display only frames marked
with Shot Mark1 marks.

Shot Mark2: Display only frames marked
with Shot Mark2 marks.

You can also select Shot Mark 0 and Shot

Mark 3 to Shot Mark 9.

If you have recorded clips by using planning

metadata that defined names for Shot Mark 0

to Shot Mark 9, the defined names are

displayed instead of the above item names in

the list.



Example shot mark thumbnail screen
(with Shot Mark1 selected)

Clip properties are displayed at the bottom of the
screen.

Except for the following item, the information
displayed here is the same as the information
displayed in the expand thumbnail screen.

@ Timecode display
This is the timecode of the selected frame in the
shot mark thumbnail screen.

Adding and Deleting Shot Marks
(UDF/exFAT/FAT-HD Mode Only)

To add shot marks

1 Select the frame where you want to add
a shot mark, and then select
“THUMBNAIL” > “Set Shot Mark™ >
“Add Shot Mark1” (or ‘“Add Shot
Mark2”).

The properties screen of the selected frame
appears, and a confirmation message appears
below the image.

Select “Execute,” and press the MENU
knob.

To delete shot marks

1 Select the frame where you want to
delete a shot mark, and then select
“THUMBNAIL” > “Set Shot Mark” >
“Delete Shot Mark1” (or “Delete Shot
Mark?2”).
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The properties screen of the selected frame
appears, and a confirmation message appears
below the image.

Select “Execute,” and press the MENU
knob.

Changing Clip Index Pictures
(UDF/exFAT/FAT-HD Mode Only)

1 Select the thumbnail of the frame that
you want to use as the index picture,
and then select “THUMBNAIL” > “Set
Index Picture.”

The properties screen of the selected frame
appears, and a confirmation message appears
below the image.

2

Select “Execute,” and press the MENU
knob.

Even if you set the index picture to a frame that is not the
first frame of a clip, playback of that clip from a
thumbnail screen always begins at the first frame.

Dividing Clips (FAT-HD Mode
Only)

1 Select the thumbnail of the frame where
you want to divide the clip, and then
select “THUMBNAIL” > “Divide Clip.”
The properties screen of the selected frame
appears, and a confirmation message appears
below the image.

Select “Execute,” and press the MENU
knob.

The clip is divided at the selected frame, and
two clips with different names are created.

The first four characters of the clip name are

taken from the name of the original clips, and the

last four characters are new serial numbers.

Example: When the name of a newly recorded
clip would be EFGHO0100, and a clip named
ABCDO0002 is divided, the names of the two
newly created clips are ABCDO0100 and
ABCDO101.



When there is not enough remaining capacity on the SxS
memory cards to store the divided clips, a message
appears to inform you that there is not enough capacity.
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Menu and Detailed Settings

Setup Menu
Organization and Levels

On this camcorder, settings for shooting and
playback are made in the setup menu, which
appears in the viewfinder.

The setup menu can also be displayed on an
external video monitor (see page 171).

Setup Menu Organization

The setup menu consists of the following menus.

Us: USER menu
Contains arbitrary items from other menus in a
user-defined order (see page 112).

Cu: USER MENU CUSTOMIZE menu
Used to configure the USER menu (see
page 112).

Op: OPERATION menu
Settings related to shooting, except settings
related to picture quality (see page 115).

Pa: PAINT menu

Settings related to picture quality (see page 132).

Th: THUMBNAIL menu
Settings related to clip thumbnails (see page 99).

The THUMBNAIL menu is used only when a thumbnail
screen (see page 96) is displayed. It is disabled when no
thumbnail screen is displayed.

Ma: MAINTENANCE menu

Settings related to audio and timecode (see

page 138).

Fi: FILE menu

Settings related to file operations (see page 153).
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Setup Menu Levels

See page 112 for the organization of the USER
MENU CUSTOMIZE menu.

See “THUMBNAIL Menu Configuration” (page 99)
for the organization of the THUMBNAIL menu.

USER menu (see page 112)
USER

Format Media

—— Rec Function

Input/Output
—— Clip
—— Assignable SW

L—— Camera Config

OPERATION menu (see page 115)
OPERATION

Format

Format Media

Input/Output

Super Impose

Rec Function
Assignable SW
VF Setting
——— Marker

Gain Switch
TLCS

Zebra

Display On/Off
Auto Iris

——— White Setting
Offset White
Shutter

Time Zone

Clip
Plan.Metadata
Flashband Reduce




PAINT menu (see page 132)

PAINT

——— Switch Status
—— White

—— Black

—— Flare

—— Gamma

—— Black Gamma
—— Knee

—— White Clip
—— Detail(HD Mode)
—— Detail(SD Mode)
—— Aperture

—— Skin Detail

—— Matrix

MAINTENANCE menu (see page 138)

MAINTENANCE

—— Multi Matrix
—— V Modulation
Low Key Sat.

—— Noise Suppress

White Shading
Battery

Audio

WRR Setting
Timecode
Essence Mark
Camera Config
Preset White
White Filter
Auto Iris2
Flicker Reduce
Genlock

ND Comp
Lens

Trigger Mode
Network Setting
Wi-Fi Setting
Clock set
Language
Hours Meter
Menu Scroll
USB Set

Version
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FILE menu (see page 153)
FILE

User

All

Scene

Reference

Lens

Import



Basic Setup Menu
Operations

To display the setup menu

Set the MENU ON/OFF switch to ON, or press
the MENU button.

The camcorder enters menu mode and the menu
list appears on the screen.

A cursor appears over the first two characters of
the most recently used menu, and the
corresponding menu item selection area appears
to the right.

Example: When the cursor is positioned at the
OPERATION menu

Menu list
OPERATION

Format
Format Media

Input/Output
Super impose
Rec Function

I

Menu item selection area

The setup menu cannot be used when the camcorder is in
focus magnification mode. Exit focus magnification
mode by pressing the assignable switch to which the
Focus Mag function has been assigned.

To make menu settings

1 Turnthe MENU knob, or press the {} or
{ button, to move the cursor to the item
that you want to set.

A list of selectable menu items appears in the
menu item selection area to the right of the
icon.

2 Press the MENU knob or the SET
button.
The cursor moves to the menu item selection
area.
You can also move the cursor to the menu

Sub-items area
* Displays sub-items and their current

item selection area by pressing the =>

button.

* The menu item selection area displays a
maximum of seven lines. You can scroll
through menus with more than seven lines
by moving the cursor up and down.
Triangles appear at the upper right and
lower right of the menu item selection area
to indicate that a menu is scrollable.

OPERATION
Format

Format Media
a ll Input/Output

Super impose
afliRec Function

Appears when more menu items
are available below the last line.
(A appears when more menu
items are available above the
first line.)

Menu item selection area

* P appears to the right when more detailed
sub-items are available.

» Settings appear to the right when a menu
item has no sub-items.

* You can select @) to return to the
previous level.

Turn the MENU knob, or press the {} or
{ button, to move the cursor to the item
that you want to set, and then confirm
by pressing the MENU knob or the SET
button.

The sub-items area appears to the right of the
menu item selection area, and the cursor
moves to the first sub-item.

OPERATION
File System

HD/SD : HD
HD System Line : 1080

Format

Format Media
Input/Output
Super impose
Rec Function
Assignable SW » |

System Frequency : 59.94i
Rec Format © XAVC-L50
t Ratio|{SD) : 16:9

»
3
3
3
3

settings

) —
* To return to the previous level, select «—,

press the <= button, or push the MENU
CANCEL/PRST/ESCAPE switch down to
the ESCAPE side.

4 Turnthe MENU knob, or press the {} or

{ button, to move the cursor to the sub-
item that you want to set, and then



confirm the selection by pressing the
MENU knob or the SET button.

The settings of the selected sub-item appear,
and the cursor moves to the currently
selected value.

OPERATION
2 2

File System

HD/SD

HD System Line
System Frequency :
Rec Format :

Format
Format Media

Super impose
Rec Function
Assignable SW » |_NAspect Ratio (SD)

»
»
Input/Output  »
»
»

Settings area

 The settings area displays a maximum of
seven lines. You can scroll through menus
with more than seven sub-items by moving
the cursor up and down. Triangles appear at
the upper right and lower right of the
settings area to indicate that a sub-item
menu is scrollable.

« For sub-items with a large settings range
(for example, —99 to +99), the settings area
is not displayed. Instead, the sub-item name
is highlighted to indicate that the sub-item
can be set.

5 Turnthe MENU knob, or press the {} or
{ button, to select the value to set, and
then confirm by pressing the MENU
knob or the SET button.

The setting is changed, and the display is
updated to show the new setting.

If you select “Execute” for an executable
item, the corresponding function is executed.

Items that require confirmation before execution
In step 3, the menu disappears and a confirmation
message appears if you select an item that
requires confirmation before execution. Follow
the instructions in the message to execute or
cancel the operation.

To enter text

Some items, such as time data or file names, must
be set by entering text. When you select one of
these items, the text entry area is highlighted, with
“SET” displayed to the right.

1 Turnthe MENU Kknob, or press the {} or
{ button, to select a character, and then
confirm by pressing the MENU knob or
the SET button.

The cursor moves to the next position.

To return to the previous position, push the
MENU CANCEL/PRST/ESCAPE switch
down to the ESCAPE side.

2 Select characters for all positions up to
the last.
The cursor moves to “SET.”

3 Press the MENU knob or the SET
button.
This confirms the setting.

To cancel the setting change

Push the MENU CANCEL/PRST/ESCAPE
switch down to the ESCAPE position.

To reset a setting to the initial value

1 Beforea setting is changed or after a
setting change is cancelled, push the
MENU CANCEL/PRST/ESCAPE
switch up to the CANCEL/PRST side.

2 When the message to confirm whether
the current setting is reset to the initial
value, push the MENU CANCEL/
PRST/ESCAPE switch up to the
CANCEL/PRST side again.

The current setting is reset to the initial value.

To exit the menu

Set the MENU ON/OFF switch to OFF or press the
MENU button.
The normal camera picture reappears.



Menu List

USER Menu

You can register arbitrary menu items from the OPERATION, PAINT, and MAINTENANCE menus in
the USER menu. You register items using the USER MENU CUSTOMIZE menu.

The USER menu consists of the following items when it is in the factory default state.

* Format Media (see page 117)

« Input/Output (see page 117)

¢ Rec Function (see page 119)

 Assignable SW (see page 120)

¢ Clip (see page 128)

» Camera Config D (see page 145)

1) Contains only User Menu Only as sub-item

USER MENU CUSTOMIZE menu

You can edit the USER menu, such as adding items, deleting items, and rearranging items, making the
USER menu more convenient to use.

You can select any item in the OPERATION menu, PAINT menu, or MAINTENANCE menu and add it
to the USER menu. Up to 20 items can be registered in the USER menu. There are six items registered in
the USER menu by factory default, one of which must always be present, allowing you to add up to 19
new items.

The USER MENU CUSTOMIZE menu has the following organization.

Item Sub-item Setting Description
Registered item or Ins Item T Inserts an item above the selected item.
blank (no item) Ins Subltem T Inserts a sub-item above the selected sub-item.
Ins Item l Inserts an item below the selected item.
Ins Subltem l Inserts a sub-item below the selected sub-item.
Edit Item Del Item/Ins Subltem/  Edits a registered item or sub-item.
Del Subltem Del Item: Delete item

Ins Subltem: Insert sub-item
Del Subltem: Delete sub-item

Customize Reset Execute/Cancel Restores the USER menu to factory default
state (execute using Execute)

The same item or sub-item cannot be registered twice.
Also, the name of the item or sub-item cannot be
changed.

To restore the USER menu to factory default state
Set “USER MENU CUSTOMIZE” > “Customize
Reset” in the setup menu to “Execute” and press
the MENU knob.
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Adding an item and all sub-items

1 Display the USER MENU

CUSTOMIZE menu.
The currently registered menu items are
displayed.

USER MENU CUSTOMIZE
Ush O
M Format
OpfiFormat Media

=)
’

»llins Subltem?

DR Ins Item!

*Hlins Subltem!
»REdit Item

Super Impose
MallRec Function
FillCustomize Reset

Select the item in the position where you
want to insert an item, then press the
MENU knob.

Select “Ins Item 1” or “Ins Item |,” then

press the MENU knob.

Ins Item T: Inserts an item above the selected
item.

Ins Item l: Inserts an item below the selected
item.

A list of the items that can be added is

displayed.

CUSTOMIZE: Ins |tem(Al| Subltems) T

Rec Function

Select the item you want to add, then
select “Execute” and press the MENU
knob.

The selected item and all its sub-items are
inserted in the position specified in steps 2
and 3.

Adding an item and selected sub-item

1 Display the USER MENU

CUSTOMIZE menu.
The currently registered menu items are
displayed.
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Select the item in the position where you
want to insert an item, then press the
MENU knob.

Select “Ins SubItem 1” or “Ins SubItem

|, then press the MENU knob.

Ins Subltem T: Inserts a sub-item above the
selected item.

Ins SublItem |: Inserts a sub-item below the
selected item.

A list of the items that can be added is

displayed.

Select the item you want to add, then
press the MENU knob.

A list of the sub-items that can be added is
displayed.

CUSTOMIZE: Ins Sublteml
Video Level Warnings
Brightness Display

IE x ecut o

Focus Position -

Lens Info

Select the sub-item you want to add,
then select “Execute” and press the
MENU knob.

The selected item and sub-item are inserted
in the position specified in steps 2 and 3.

Adding a sub-item to an existing item

A sub-item should always be added below an item that is
its parent in the source menu. A sub-item cannot be
inserted below a non-parent item.

1

Display the USER MENU
CUSTOMIZE menu.

The currently registered menu items are
displayed.

Select the item to which you want to add
a sub-item, then press the MENU knob.

Set “Edit Item” to “Ins SubItem.”
A list of the currently registered sub-items
for the selected item is displayed.



4 Select the sub-item in the position The currently registered menu items are
where you want to insert a sub-item, displayed.

select “Ins SubItem {”” or “Ins SubItem 2 Select the it P
l’” and press the MENU knob. elec € 1tem containing the sub-item

Ins SublItem 1: Inserts a sub-item above the you want to delete, then press the
selected sub-item. MENU knob.
Ins SublItem |: Inserts a sub-item below the 3

. Set “Edit Item” to “Del SubItem.”
selected sub-item.

A list of the sub-items that can be deleted is

displayed.
g”mmgf‘; 'ﬂ: Siblten 4 Select the sub-item you want to delete,
LLINK 1D then press the MENU knob.
1 B TIEETE The selected sub-item is deleted.

HDM| Out Ins Sublteml

SD| /HDMI Out Super

A list of the sub-items that can be added is
displayed.

5 Select the sub-item you want to add,
then select “Execute’” and press the
MENU knob.

The selected sub-item is inserted in the
position specified in step 4.

Deleting an item

“Camera Config” is registered by factory default and
cannot be deleted.

1 Display the USER MENU
CUSTOMIZE menu.
The currently registered menu items are
displayed.

2 Select the item you want to delete, then
press the MENU knob.

3 Set “Edit Item” to “Del Item.”
The selected item is deleted.

Deleting a sub-item

“User Menu Only” in “Camera Config” is registered by
factory default and cannot be deleted.

1 Display the USER MENU
CUSTOMIZE menu.
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OPERATION Menu

Settings in bold are the factory default values.

Item Sub-item Setting Description

Format File System UDF/exFAT/FAT Switches between UDF, exFAT, and

Specifies the camcorder’s FAT as the recording mode (execute

operating mode and using Execute).

recording format. HD/SD HD/SD Switches between HD or SD as the
operating mode (execute using
Execute).

HD System Line 1080/720 When the operating mode is HD, sets

the number of system lines to 1080 or
720 (execute using Execute).

System The available settings Selects the system frequency (execute
Frequency vary depending on the using Execute).
settings of “HD/SD,”
“HD System Line,”
and “Country.”
59.94i/29.97p/ When “HD/SD” is set to “HD,” “HD
23.98P System Line” is set to “1080,” and
“Country” is set to other than “PAL
Area.”
59.94P/29.97P/ When “HD/SD” is set to “HD,” “HD
23.98P System Line” is set to “720,” and
“Country” is set to other than “PAL
Area.”
59.94i/29.97P When “HD/SD” is set to “SD” and
“Country” is set to other than “PAL
Area.”
50i/25P e When “HD/SD” is set to “HD,” “HD
System Line” is set to “1080,” and
“Country” is set to “PAL Area.”
* When “HD/SD” is set to “SD” and
“Country” is set to “PAL Area.”
50P/25P When “HD/SD” is set to “HD,” “HD
System Line” is set to “720,” and
“Country” is set to “PAL Area.”
Rec Format The available settings Selects the recording format (execute

vary depending on the
settings in File
System, HD/SD, HD
System Line, and
System Frequency.

using Execute).

XAVC-I/XAVC-L50/
XAVC-L35/
XAVC-L25/

HD422 50/

HD420 HQ1920/
HD420 HQ1440

When the File System setting is
[exFAT], the HD/SD setting is [HD],
the HD System Line setting is [1080],
and the System Frequency setting is
[59.94i] or [50i].
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Item Sub-item Setting Description

Format Rec Format XAVC-I/XAVC-L50/ When the File System setting is

Specifies the camcorder’s XAVC-L35/ [exFAT], the HD/SD setting is [HD],

operating mode and HD422 50/ the HD System Line setting is [1080],

recording format. HD420 HQ1920/ and the System Frequency setting is
HD420 HQ1440 [29.97P], [25P], or [23.98P].

XAVC-I/XAVC-L50/

When the File System setting is

HD422 50/ [exFAT], the HD/SD setting is [HD],

HD420 HQ1280 the HD System Line setting is [720],
and the System Frequency setting is
[59.94P] or [50P].

HD422 50/ When the File System setting is

HD420 HQ 1280

[exFAT], the HD/SD setting is [HD],
the HD System Line setting is [720],
and the System Frequency setting is
[23.98P].

HD422 50 When the File System setting is
[exFAT], the HD/SD setting is [HD],
the HD System Line setting is [720],
and the System Frequency setting is
[29.97P] or [25P].

HD422 50/ When the File System setting is [UDF],

HD420 HQ1920/ the HD/SD setting is [HD], and the HD

HD420 HQ1440 System Line setting is [1080].

HDA422 50/ When the File System setting is [UDF],

HD420 HQ1280 the HD/SD setting is [HD], the HD
System Line setting is [720], and the
System Frequency setting is other than
[29.97P] or [25P].

HDA422 50 When the File System setting is [UDF],

the HD/SD setting is [HD], the HD
System Line setting is [720], and the
System Frequency setting is [29.97P] or
[25P].

HQ 1920/HQ 1440

When the File System setting is [FAT],
the HD/SD setting is [HD], the HD
System Line setting is [1080], and the
System Frequency setting is [29.97P] or
[25P].

HQ 1920/HQ 1440/
SP 1440

When the File System setting is [FAT],
the HD/SD setting is [HD], the HD
System Line setting is [1080], and the
System Frequency setting is other than
[29.97P] or [25P].

HQ 1280

When the File System setting is [FAT],
the HD/SD setting is [HD], and the HD
System Line setting is [720].

IMX50/DVCAM

When the File System setting is
[exFAT] or [UDF], and the HD/SD
setting is [SD]

DVCAM

When the File System setting is [FAT]
and the HD/SD setting is [SD]
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Item Sub-item Setting Description
Format Aspect Ratio 16:9/4:3 Selects the SD mode aspect ratio
Specifies the camcorder’s (SD) (execute using Execute).
operating mode and Audio 24bit/16bit Selects the audio bit rate for recording
recording format. Length(IMX) in IMX format.

Country NTSC Area/NTSC(J) Selects the area of use (execute using

Area/PAL Area Execute).

Format Media Media(A) Execute/Cancel Initializes the SxS memory card in slot
Executes a media format. A (execute using Execute).

Media(B) Execute/Cancel Initializes the SxS memory card in slot

B (execute using Execute).

Input/Output In FAT mode HD&HDV/ Selects the signals output from the
Makes settings related to  Output& i.LINK SD&HDV/SD&DV/  video connectors and the i. LINK (HDV/
1/0 signals. 480P/576P DV) connector.

In UDF/exFAT HD/SD/480P/576P ~ When the HD/SD setting is SD,

mode “SD&DV” or “SD” is selected.

Output

23.98P Output ~ PsF/Pull Down Selects whether to use progressive

output (PsF) or pulldown output (Pull
Down) when the video format is in the
following modes.
UDF/HD mode
HD22 50/1080/23.98P
HD420 HQ1920/1080/23.98P
HD420 HQ1440/1080/23.98P
exFAT/HD mode
XAVC-1/1080/23.98P
XAVC-L50/1080/23.98P
XAVC-L35/1080/23.98P
HD22 50/1080/23.98P
HD420 HQ1920/1080/23.98P
HD420 HQ1440/1080/23.98P
FAT mode
HQ 1920/1080/23.98P
HQ 1440/1080/23.98P

Source Select

Camera/i.LINK

Selects whether to use the video camera
picture (Camera) or the signal input
from the i.LINK (HDV/DV) connector
(i.LINK) as the video input source.

i.LINK I/O

Enable/Disable

Selects whether to enable or disable
input and output of signals via the
i.LINK (HDV/DV) connector.

When “Enable” is selected, you can
execute auto black balance adjustment
during i.LINK output. (When this
setting is set to “Enable,” The flashband
reduce function is set to “Off.”)

SDI Output

On/Off

Turns on/off the output of signals from
the two HD/SD SDI OUT connectors.

When the camcorder is connected to a

computer via USB, set to “Off.”

HDMI Output

On/Off

Turns on/off the output of signals from
the HDMI connector.
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Item Sub-item Setting Description
Input/Output SDI/HDMI Out ~ On/Off Turns on/off the superimposition of text
Makes settings related to  Super information on the output of the HD/SD

1/0 signals.

SDI OUT and HDMI connectors.

Video Out Super On/Off

Turns on/off the superimposition of text
information on the output of the VIDEO
OUT connector.

Down Converter Squeeze/Letter/
Crop

Selects the signal conversion mode for

output of SD signals.

Squeeze: Squeeze the 16:9 picture
horizontally and output as a 4:3
picture.

Letter: Mask the top and bottom of the
4:3 picture and display in the center
of the screen as a 16:9 picture.

Crop: Crop the edges of the 16:9
picture and output as a 4:3 picture.

Wide ID Through/Auto

Selects whether to add a wide ID signal

to the SD output signal.

Through: Output without adding a
wide ID signal.

Auto: Add and output a wide ID signal
when the Down Converter setting
is Squeeze.

Super Impose
Makes settings related to

Super(VF On/Off
Display)

superimposed text and

Super(Menu) On/Off

markers.

Super(Timecode) On/Off

When “Input/Output” > “SDI/HDMI
Out Super” or “Video Out Super” is set
to “On,” superimpose text information
on the output from the HD/SD SDI
OUT connector, HDMI connector, and
VIDEO OUT connector, as specified
(“On” or “Off”) for each item.

Super(Marker)  On/Off

When “Input/Output” > “Video Out
Super” is set to “On,” specifies whether
to superimpose markers on the output
from the VIDEO OUT connector.

Super(Rec Status  On/Off
Indicator)

Selects whether to superimpose (“On”)
or not impose (“Off”) the recording
status indication on the following two
outputs.

* Output from the VIDEO OUT connector
with “Input/Output” > “Video Out
Super” set to “On”

* Output from the SDI connector and the
HDMI connector with “Input/Output” >
“SDI/HDMI Out Super” set to “On”
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Item Sub-item

Setting

Description

Rec Function
Makes settings related to
special recording modes.

When Picture Cache is

Slow & Quick

On/Off

Turns the Slow & Quick Motion
function on/off.

(When this is set to “On,” “Clip
Continuous Rec,” “Picture Cache Rec,”
“Interval Rec,” “Frame Rec,” and
“Flashband Reduce” are set to Off.)

assigned to an assignable
switch, this item is disabled Frame Rate
(grayed out).

The available settings
vary depending on the
Format >HD System
Line setting.

When “Slow & Quick” is set to “On,”
sets the frame rate for Slow & Quick
Motion shooting.

When “Format” >
“Country” is set to
other than “PAL
Area” in UDF/exFAT
mode or when in FAT
mode:

1to 30

When “Format” >
“Country” is set to
“PAL Area” in UDF/
exFAT mode:

1to 25

When “HD System Line” is set to
“1080.”

‘When “Format” >
“Country” is set to
other than “PAL
Area” in UDF/exFAT
mode or in FAT
mode:

1 to 30/31 to 60
‘When “Format” >
“Country” is set to
“PAL Area” in UDF/
exFAT mode:

1 to 25/26 to 50

When “HD System Line” is set to
“720.”

Clip Continuous

Rec

On/Off

Turns the Clip Continuous Rec function
on/off. (When this is set to “On,” “Slow
& Quick,” “Picture Cache Rec,”
“Interval Rec,” and “Frame Rec” are set
to “Off.”)

Picture Cache
Rec

On/Off

Turn the picture cache function on/off.
(When this is set to “On,” “Slow &
Quick,” “Clip Continuous Rec,”
“Interval Rec,” “Frame Rec,” and
“Flashband Reduce” are set to “Off.”)

P. Cache Rec
Time

0-2sec/2-4sec/
4-6sec/6-8sec/
8-10sec/10-12sec/
12-14sec/13-15sec

When “Picture Cache Rec” is set to
“On,” sets the picture cache time.

When you set “OPERATION” > “Format”
> “Rec Format” to “XAVC-1,” only “0-
2sec” or “2-4sec” can be selected.
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Item Sub-item Setting Description
Rec Function Interval Rec On/Off Turns the Interval Rec function on/off.
Makes settings related to (When this is set to “On,” “Slow &
special recording modes. Quick,” “Clip Continuous Rec,”
“Picture Cache Rec,” and “Frame Rec”
m . . are set to “Off.”)
;Z:iegﬁef)dlclgl;?qca::il;;ile Frame Rec On/Off Turns the Frame Rec function on/off.
switch, this item is disabled (When this is set to “On,” “Slow &
(grayed out). Quick,” “Clip Continuous Rec,”
“Picture Cache Rec,” and “Interval
Rec” are set to “Off.”)
Number of The available settings When “Interval Rec” or “Frame Rec” is
Frames vary depending on the set to “On,” specifies the number of
settings in “Format” > frames to shoot in one Interval Rec or
“HD System Line and Frame Rec take.

Format” > “System
Frequency.”

2frame/6frame/
12frame

When “HD System Line” is set to
“720,” and “System Frequency” is set to
“59.94P” or “50P.”

1frame/3frame/
6frame/9frame

When “HD System Line” is set to other
than “720”, or “System Frequency” is
set to other than *“59.94P” or “50P.”

Interval Time

1/2/3/4/5/6/7/8/9/10/
15/20/30/40/50 (sec)
1/2/3/415/6/7/8/9/10/
15/20/30/40/50 (min)
1/2/3/4/6/12/24 (hour)

Set the interval for Interval Rec
shooting, when “Interval Rec” is set to
“On.”

Pre-Lighting

Off/2sec/5sec/10sec

If you want the video light to be turned
on before Interval Rec shooting, select a
number of seconds before the start of
shooting. If you do not want it to be
turned on, select Off.

see page 158

Assigns function to ASSIGN. 0 switch.

Assigns function to ASSIGN. 1 switch.

Assigns function to ASSIGN. 2 switch.

Assigns function to ASSIGN. 3 switch.

Assigns function to ASSIGNABLE 4
switch.

Assigns function to ASSIGNABLE 5
switch.

Assigns function to RET button on the
lens.

Assigns function to COLOR TEMP.
button.

Assignable SW <0>
Assigns functions to <1>
assignable switches. <>
For details about assigning <3>
functions, see “Assigning  <4>
Functions to Assignable
Switches” (page 158). <5>
RET
C. Temp
Zoom Speed

0 to 20 to 99

When Zoom has been assigned to the
ASSIGNABLE 4 or 5 switch, specifies
the zoom speed.

When the lens supplied with the PXW-
X320 is used, zooming may not operate
smoothly if the zoom speed is low.
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Item

Sub-item

Setting

Description

VF Setting
Makes settings related to
the viewfinder screen.

Color

—-99 to 0 to +99

Adjusts the density of the colors
displayed in the viewfinder screen.

Mode

Color/B&W

Selects “Color” or “B&W” as the
display mode of the viewfinder screen.
(Even when “B&W?” is selected, some
indications are always displayed in
color. Examples include tally
indications, thumbnails, and the skin
gate area.)

Peaking Type

Normal/Color/Both

Selects the peaking type.
Normal: Normal peaking
Color: Color peaking
Both: Both

Peaking
Frequency

Normal/High

Selects normal or high peaking
frequency.

Peaking Color

White/Red/Yellow/
Blue

When “Peaking Type” is set to “Color,”
selects the peaking color.

Peaking Level

Low/Mid/High

When “Peaking Type” is set to “Both,”
selects the color peaking level.

DXF Rec Tally

Upper/Both

When a separately sold viewfinder is
installed, specified whether to light the
tally indicator on the upper side only
(“Upper”), or on both the upper and
lower sides (“Both™).
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Item

Sub-item

Setting

Description

Marker

Makes settings related to
marker display in the

viewfinder screen.

Setting

On/Off

Turns the display of all markers on/off.

‘When Marker is assigned to the ASSIGN.
2 switch, this setting is disabled.

Center Marker

1/2/3/4/0ff

When the center marker is displayed,
selects the type. Select “Off” if you do
not want to display the marker.

When “Safety Zone,” “User Box,” and
“Guide Frame” are set to “On,” this setting
cannot be turned on.

Center H
Position

—40 to 0 to 40

Specifies the horizontal position of the
center marker.

Center V
Position

—40 to 0 to 40

Specifies the vertical position of the
center marker.

Safety Zone

On/Off

Turns the safety zone display on/off.

When “Center Marker,” “User Box,” and
“Guide Frame” are set to “On,” this setting
cannot be turned on.

Safety Area

80%/90%/92.5%/
95%

Selects the safety zone range.

Aspect Marker

Line/Mask/Off

When an aspect marker is to be

displayed, selects the display method.

Select “Off” if you do not want to

display the marker.

Line: Show as white lines.

Mask: Display by lowering the video
signal level of areas outside the
marker range.

Aspect Select

4:3/13:9/14:9/15:9/

1.66:1/1.85:1/2.35:1/

2.4:1

Selects the aspect ratio of the marker.

Aspect Mask

0% to 30% to 90%
(10% steps)

When “Aspect Marker” is set to
“Mask,” specifies the video signal level
of areas outside the marker range as a
percentage value relative to the video
signal level of areas inside the marker
range.

User Box

On/Off

Turns the box cursor display on/off.

When “Center Marker,” “Safety Zone,”
and “Guide Frame” are set to “On,” this
setting cannot be turned on.

User Box Width

40 to 500 to 999

Specifies the box cursor width (distance
from the center to the left and right
edges).

User Box Height

70 to 500 to 999

Specifies the box cursor height
(distance from the center to the top and
bottom edges).
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Item Sub-item Setting Description

Marker User Box H —479 to 0 to 479 Specifies the horizontal position of the
Makes settings related to  Position box cursor center.

marker display in the User Box V —464 to 0 to 464 Specifies the vertical position of the box
viewfinder screen. Position cursor center.

Guide Frame On/Off Turns display of the guide frame on/off.
[ Note
When “Center Marker,” “Safety Zone,”
and “User Box” are set to “On”, this setting
cannot be turned on.

Gain Switch Gain Low —-3dB/0dB/3dB/6dB/ Specifies the gain value for the L

Makes settings related to 9dB/12dB/18dB position of the GAIN switch.

the GAIN switch. Gain Mid —-3dB/0dB/3dB/6dB/ Specifies the gain value for the M
9dB/12dB/18dB position of the GAIN switch.

Gain High —3dB/0dB/3dB/6dB/  Specifies the gain value for the H
9dB/12dB/18dB position of the GAIN switch.

Gain Turbo —3dB/0dB/3dB/6dB/  Specifies the gain value for the Turbo
9dB/12dB/18dB/ Gain function, which can be assigned to
24dB an assignable switch.

Shockless Gain ~ On/Off Turns shockless gain (a function that
switches smoothly when the gain is
switched) on/off.

TLCS Mode Backlight/Standard/ Selects the auto iris mode used when the
Makes settings related to Spotlight TLCS system is activated.
total level control. Backlight: Backlight mode (lessens
the blackout of the main subject
that occurs under backlit
conditions)
Standard: Standard mode
Spotlight: Spotlight mode (lessens the
whiteout of the main subject that
occurs under a spotlight)

Speed -99 to 20 to +99 Specifies the control speed (speed of
reaction to changes in the video) used
when the TLCS system is activated.
(Larger values specify quicker reaction
times.)

AGC On/Off Turns the AGC (auto gain control)
function on/off.

AGC Limit 18dB/12dB/9dB/ Specifies the maximum gain used when

6dB/3dB AGC is on.

AGC Point F2.8/F4/F5.6 Specifies the F value where control by

auto iris switches to control by AGC,
used when AGC is on.

Auto Shutter

On/Off

Turns the auto shutter function on/off.

Auto Shutter
Limit

1/100/1/150/1/200/
1/250

Selects the maximum shutter speed used
when auto shutter is on.

Auto Shutter
Point

F5.6/F8/F11/F16

Specifies the F value where control by
auto iris switches to control by auto
shutter, used when auto shutter is on.
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Item Sub-item Setting Description
Zebra Zebra Select 1/2/BOTH Selects the zebra pattern type (Zebral,
Makes settings related to Zebra2, Both).
zebra displays. Zebral Level 50% to 70% to 107% Specifies the Zebral display level.
Zebral Aperture 1 to 10% to 20% Specifies the Zebral aperture level.
Level
Zebra2 Level 52% to 100% to Specifies the Zebra2 display level.
109%
Display On/Off Video Level On/Off Turns the warnings that appear when
Selects the items to Warnings the video level is too bright or too dark
display in the viewfinder on/off.
screen. Sending Clip On/Off Turn the uploading status of a clip when
Info connecting the CBK-WA101 Wireless
Adapter (not supplied) on/off.
Brightness On/Off Turns the numerical indication of the
Display video brightness on/off.
Histogram On/Off Turns the histogram display of video
Display signal levels on/off (in HD mode only).
Lens Info Meter/Feet/Off Selects whether or not to display the
depth of field indication and the unit for
display of the depth of field.
Meter: Displayed in meters
Feet: Displayed in feet
Off: Do not display
Focus Position ~ On/Off Turns the indication of the lens focus
position on/off.
Zoom Position  On/Off Turns the indication of the lens zoom
position on/off.
Audio Level On/Off Turns the display of the audio level
Meter meters on/off.
Timecode On/Off Turns the display of time data
(timecode, user bits, counter, duration)
on/off.
Battery Remain ~ On/Off Turns the indications of the remaining
battery time and input voltage on/off.
Media Remain ~ On/Off Turns the indication of the remaining
media capacity on/off.
TLCS Mode On/Off Turns the indication of the TLCS
operating mode on/off.
Focus Mode On/Off Turns the indication of the focus
operating mode on/off.
White Balance ~ On/Off Turns the indication of the white
Mode balance mode on/off.
Filter Position On/Off Turns the indication of the ND filter
setting on/off.
Iris Position On/Off Turns the indication of the iris position
on/off.
Gain Setting On/Off Turns the indication of the gain setting
on/off.
Shutter Setting ~ On/Off Turns the indications of the shutter

mode and shutter speed on/off.
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Item Sub-item Setting Description

Display On/Off Color Temp On/Off Turns the indication of the color
Selects the items to temperature on/off.

display in the viewfinder ~Video Format On/Off Turns the indication of the video format
screen. on/off.

System Line On/Off Turns the indication of the system lines
on/off.

Rec Mode On/Off Turns the indication of special
recording modes (Slow & Quick,
Interval Rec, Frame Rec) on/off.

Extender On/Off Turns the lens extender indication on/
off.

WRR RF Level — On/Off Turns the indication of the digital
wireless receiver reception level on/off.

Clip On/Off Turns the indication of clip information

Number(PB) on/off.

Wireless Status ~ On/Off Turn the status of radio wave of the
CBK-WA101 Wireless Adapter (not
supplied) on/off.

Ext Media On/Off Turn the remaining time indication for

Remain the media of the CBK-WA101 Wireless
Adapter (not supplied) on/off.

FlashbandReduce On/Off Turn the flashband reduce status
indication on/off.

ALAC On/Off Turn the ALAC status indication on/off.

Auto Iris Iris Override On/Off Turns iris override (a setting that opens
Makes settings related to or closes the iris more than normal) on/
auto iris. off.

Iris Speed -99 to 20 to +99 Specifies the control speed (speed of
reaction to changes in the video).
(Larger values specify quicker reaction
times.)

Clip High light ~ On/Off Turns on/off the function that disregards
highlights and forces a flatter reaction to
high luminance.

Iris Window 1/2/3/4/5/6/Var Selects the auto iris detection window
type.

Var: Variable
Iris Window On/Off Turns the indication of the auto iris

Indication

detection window frame on/off.
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Item Sub-item

Setting

Description

White Setting White
Makes settings related to  Switch<B>
auto white balance

adjustments.

Memory/ATW

Specifies the operating mode selected
by the B position of the WHITE BAL
switch.

Memory: Auto white balance

ATW: Auto tracing white balance

Shockless White  Off/1/2/3

Specifies the reaction speed when the
WHITE BAL switch setting is changed.
“Off” is an instant reaction, and “1” is
faster than “2” or “3.”

ATW Speed 1/2/3/4/5 Specifies the reaction speed when
“White Switch<B>" is set to “ATW.”
“1” is the fastest reaction.

ATW Mode Natural/Pure Natural: Depending on the brightness

of scenes, automatically adjusts the
white balance to natural ambience.

Pure: Not leaving the blue color or red
color, automatically adjusts the
white balance closer to original
colors.

AWB Fixed Area On/Off

Specifies whether auto white balance is

executed at the center of the screen.

On: Execute in an area corresponding
to 25% of the height and width of
the screen.

Off: Execute in an area corresponding
to 70% of the height and width of
the screen.

Filter White

Memory

On/Off

Specifies whether to allocate a white
balance memory area for each FILTER
knob position.

On: Allocation a white balance
memory area for each FILTER
knob position.

Off: Use A/B memory regardless of the
filter position.
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Item Sub-item Setting Description
Offset White Offset White On/Off Specifies whether to add (“On”) or not
Makes settings related to  <A> to add (“Off”) an offset value to the

white balance offset
values.

white balance value in memory A.

Warm Cool <A>

Approximate color
temperature

When “Offset White<A>” is set to
“On,” specifies (as a color temperature)
the offset to add to the white balance
value in memory A. (Note that the error
range becomes larger for higher offset
color temperatures. Adjust while
viewing the actual video.)

Warm Cool
Balance<A>

-99 to 0 to +99

Specifies a more precise color
temperature, for use when satisfactory
video cannot be obtained with the
“Warm Cool <A>" setting.

Offset White
<B>

On/Off

When this is set to “On,” the offset
adjusted set with this item is added to
the white balance of channel B.

Warm Cool <B>

Approximate color
temperature

When “Offset White<B>" is set to
“On,” specifies (as a color temperature)
the offset to add to the white balance
value in memory B. (Note that the error
range becomes larger for higher offset
color temperatures. Adjust while
viewing the actual video.)

Warm Cool
Balance<B>

-99 to 0 to +99

Specifies a more precise color
temperature, for use when satisfactory
video cannot be obtained with the
“Warm Cool <B>” setting.

Offset White
<ATW>

On/Off

When this item is set to “On,” the offset
value adjusted here is added to the
ATW white balance value.

Warm Cool
<ATW>

Approximate color
temperature

When “Offset White <ATW>" is set to
“On,” use color temperature to set an
offset value to add to the ATW white
balance value (the higher the offset
color temperature, the greater the error,
so make adjustment while observing the
video).

Shutter

Makes settings related to
shutter speed selection.

Shutter Select

Second/Degree

Specifies the unit used to select shutter
speeds.

Second: Select in units of seconds.
Degree: Select in units of degrees.

Slow Shutter

On/Off

Turns the SLS mode on/off. (When this
setting is set to “On,” The flashband
reduce function is set to “Off.”)

SLS Frames

2Frames/3Frames/
4Frames/5Frames/
6Frames/7Frames/
8Frames/16Frames/
32Frames/64Frames

Selects the number of accumulated
frames in slow shutter mode.
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Item Sub-item

Setting

Description

Time Zone
Specifies the time zone.

Zone

—12:00 to +0:00 to
+13:30 (in steps of 30
minutes)

Specifies a difference from UTC
(Greenwich Mean Time) in units of 30
minutes.

Clip

Make settings for clip
name or clip
management.

Do not assign clip names
that begin with the “.”
(period) symbol. Clips with
names in which the first
character is ““.”” cannot be
viewed on the application
software for computers.

Auto Naming

In Fat mode: Title/
Plan

In UDF/exFAT mode:
CoH##/Title/
Plan

Selects the clip naming format.

C****: XDCAM standard name (In
UDF/exFAT mode)

Title: Name specified by Title Prefix

Plan: Name specified in planning
metadata (if no name is specified in
planning metadata, the name
specified by Title Prefix is
selected.)
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Item Sub-item Setting

Description

Clip Title Prefix Text input
Make settings for clip

name or clip

management.

Do not assign clip names
that begin with the “.”
(period) symbol. Clips with
names in which the first
character is “.” cannot be
viewed on the application

software for computers.

Specifies the title part (4 to 46
alphanumeric characters) of clip titles.
When the currently specified title is
eight characters or fewer in length, the
entire title appears. When the title is
longer than eight characters, the first
seven characters appear and a “...”
symbol appears in place of the eighth
character.

Displays the Character Set screen.

Character Set screen configuration

¢ Character selection area (three lines)

Select the character to insert at the title

prefix cursor position.

1#$%()+.-.;=@[]"_~0123456789

abcdefghijklmnopqrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWX

YZ

« Cursor operation area (one line)

Space: Changes the character at the
cursor position to a space

INS: Inserts a space at the cursor
position

DEL.: Deletes the character at the cursor
position

<«—: Moves the cursor to the left

—»: Moves the cursor to the right

ESC: Cancels the change and return to
the normal menu

END: Executes the change and return to
the normal menu

« Title prefix area (one line)

An area to enter the title

To set titles

1 Turn the MENU knob or press the
arrow buttons to select a character,
highlighting it, in the character
selection area, and then press the
MENU knob or the SET button to
insert it at the cursor position in the
title prefix area. (The cursor moves
to the right.)

2 Repeat step 1 to add more characters
to the title (using Space, INS, and
DEL as required).

3 When you have finished entering the
title, select END to close the
Character Set screen.

Number Set 0001 to 9999

Specifies the initial value of the numeric
part (four digits) of clip names (unless
the name specified in planning metadata
with “Auto Naming” set to “Plan”).
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Item Sub-item Setting Description

Clip Name Display  Off/On Selects whether to display the name of

Make settings for clip the next clips to be recorded in E-E

name or clip mode (“On”) or not (“Off™).

management. Update Media<A>/ Updates the management files on the

m Media<B> media in the selected slot (execute using
Execute).

Do not assign clip names
that begin with the “.”
(period) symbol. Clips with
names in which the first
character is ““.”” cannot be
viewed on the application
software for computers.

Plan.Metadata Load/Slot(A) Execute/Cancel Executes load of planning metadata
Makes settings for from the SxS memory card in slot A.
operating planning Select “Execute” to show the list of the
metadata. planning metadata files stored in the slot

A SxS memory card and select a file to
execute the load.

Load/Slot(B) Execute/Cancel Executes load of planning metadata
from the SxS memory card in slot B.
Select “Execute” to show the list of the
planning metadata files stored in the slot
B SxS memory card and select a file to
execute the load.

Load/USB Execute/Cancel Executes load of planning metadata
(UDF/exFAT from the USB flash drive connected to
mode) the external device connector.

Select “Execute” to show the list of the
planning metadata files stored in the
USB flash drive and select a file to
execute the load.

Properties Execute/Cancel Displays the detailed information in the
planning metadata loaded on the
camcorder (execute using Execute).

Clear Execute/Cancel Clears the planning metadata loaded on
the camcorder (execute using Execute).
Clip Name Disp Title1(ASCII) Selects the display mode of the clip
Title2(UTF-8) name specified in planning metadata
(see page 94).

When you define both of ASCII format
name and UTF-8 format name with
planning metadata, the UTF-8 format
string is used as the clip name string. If you
define either of ASCII format name and
UTEF-8 format name with planning
metadata, the defined format name is
displayed though it is not selected by menu
setting.
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Item Sub-item Setting Description
Flashband Reduce Setting On/Off Turns the flashband reduce function on/
Reducing flashbanding. off.

This item is disabled
(grayed out) when “Picture
Cache Rec” is set to “On,”
“L.LINK I/O” is set to
“Enable,” and “Slow
Shutter” is set to “On.”

When the flashband reduce function is set
to on/off, video and audio may be distorted
and noise may appear momentarily.
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PAINT Menu

Settings in bold are the factory default values.

PAINT

Item Sub-item Setting Description
Switch Status Gamma On/Off Turns gamma correction on/off.
Turns various signal Black Gamma On/Off Turns black gamma correction on/off.
correction functions and a "Matrix On/Off Turns linear matrix correction and user
test signal on/off. matrix correction on/off.
Knee On/Off Turns knee correction on/off.
White Clip On/Off Turns white clip correction on/off.
Detail On/Off Turns detail correction on/off.
Aperture On/Off Turns aperture correction on/off.
Flare On/Off Turns flare correction on/off.
Test Saw On/Off Turns the test saw signal on/off.
White Color Temp <A> 1500K to 3200K to  Displays the white balance color
Sets the color 50000K temperature saved in memory A.
temperature, and Color Temp —-99 to 20 to +99 Specifies the white balance gain values
performs manual white ~ BAL <A> saved in memory A (linked R gain and
balance adjustment. B gain).
R Gain <A> —-99 to 20 to +99 Specifies the white balance R gain value
saved in memory A.
B Gain <A> -99 to 0 to +99 Specifies the white balance B gain value
saved in memory A.
Color Temp <B> 1500K to 3200K to  Displays the white balance color
50000K temperature saved in memory B.
Color Temp -99 to 20 to +99 Specifies the white balance gain values
BAL <B> saved in memory B (linked R gain and
B gain).
R Gain <B> —-99 to 20 to +99 Specifies the white balance R gain value
saved in memory B.
B Gain <B> —-99 to 0 to +99 Specifies the white balance B gain value
saved in memory B.
Black Master Black —-99 to 0 to +99 Specifies the master black level.
Specifies the black level R Black -99 to +0 to +99 Specifies the R black level.
(level of the B Black —99 to %0 to +99 Specifies the B black level.
unilluminated parts of the
video).
You can achieve a desired
look by adjusting the

black level for deeper or
shallower blacks.
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PAINT

Item Sub-item Setting Description

Flare Flare On/Off Turns flare correction on/off.

Makes settings related to  Master Flare -99 to #0 to +99 Sets the master flare correction level.
flare. R Flare -99 to 0 to +99 Sets the R flare correction level.
Flare is light genemted G Flare -99 to £0 to +99 Sets the G flare correction level.
fror,n a bright image B Flare -99 to +0 to +99 Sets the B flare correction level.
region that spreads

broadly across the image,

adding light to dark

regions and reducing

contrast. It is caused by

reflection inside the lens

system.

Gamma Gamma On/Off Turns gamma correction on/off.
Makes settings related to  Step Gamma 0.35t00.45t00.90  Specifies a gamma correction value in
gamma. (0.05 steps) steps of 0.05.

Gamma correction allows "Magter Gamma 99 to 0 to +99 Specifies the master gamma level.
you to significantly alter “R'Gymmy -99 to +0 to +99 Specifies the R gamma level.

the lrjnpressmn .maf'le by G Gamma -99 to +0 to +99 Specifies the G gamma level.

the video by adjusting the B Gamma —99 to 20 to +99 Specifies the B gamma level.

contrast.

Gamma Select

The available settings
vary depending on the
setting in “Gamma
Category” (see
“Description”).

Select the gamma table to use in gamma
correction.

When Gamma Category is STD:

1 DVW: DVW camcorder equivalent

2 x4.5: x4.5 gain

3 x3.5: x3.5 gain

4 240M: SMPTE-240M equivalent

5 R709: ITU-R709 equivalent (default
setting)

6 x5.0: x5.0 gain

When Gamma Category is HG:

1 3250: Condense 325% video input to
100% video output

2 4600: Condense 460% video input to
100% video output

3 3259: Condense 325% video input to
109% video output

4 4609: Condense 460% video input to
109% video output (default setting)

Gamma STD/HG Selects use of standard gamma (STD) or
Category HyperGamma (HG).
Black Gamma Black Gamma On/Off Turns black gamma correction on/off.
Makes settings related t0  Gamma Level ~ —99 to £0 to +99 Specifies the master black gamma level.
black gamma correction. "Range Low/L.Mid/H.Mid/  Selects the black gamma correction
Black gamma correction High effective range.

allows you to reproduce
gradations and color
nuances in black or near-
black (dark) parts of the
picture.

LOW: 0to 3.6%
L.MID: 0to 7.2%
H.MID: 0 to 14.4%
HIGH: 0 to 28.8%
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PAINT

Item Sub-item Setting Description

Knee Knee On/Off Turns knee correction on/off.
Makes settings related to  Knee Point 50.0% t0 90.0% to  Specifies the knee point.

knee correction. 109.0%

Knee correction is Knee Slope -99 to £0 to +99 Specifies the knee slope.
processing that prevents  “gce"Sauration  On/Off Turns the knee saturation function on/
washout by compressing off.

ﬂ?e bright p#ts of the Knee Saturation —99 to +0 to +99 Specifies the knee saturation level.
video according to an Level

upper limit for the

dynamic range of the

recorded and output

picture. The signal level

where knee processing

begins is called the “knee

point,” and the slope of

knee compression is

called the “knee slope.”

White Clip White Clip On/Off Turns white clipping adjustment on/off.
Makes settings related to  Level Country is set to Specifies the white clip level.
white clipping “NTSC Area” or

adjustments. “NTSC(J)Area”

White clipping is 90.0% to 108.0% to

processing that limits the
maximum level of video
output signals. The
maximum video signal
output value is called the
“white clip level.”

109.0%

Country is set to
“PAL Area”

90.0% to 105.0% to
109.0%
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PAINT

Item Sub-item Setting Description

Detail(HD Mode)/ Detail On/Off Turns detail adjustment on/off.
Detail(SD Mode) Level —99 to %0 to +99 Specifies the detail level.

Makes settings related to /v Ratio -99 to 20 to +99 Specifies the mix ratio between the H
details adjustments in HD detail level and the V detail level.
mOd? “‘“‘? SD m"d?- Crispening -99 to £0 to +99 Specifies the crispening level.

Detail a.djustmeflt 18 Level Depend On/Off Turns the level dependence adjustment
processing that improves function on/off.

the f:larlty O.f th'e video by Level Depend -99 to +0 to +99 Specifies the level dependence level.
adding detail signals to

the edges of the subject. Level .

Frequency -99 to 0 to +99 Specifies the central frequency for H
detail signals. Larger values give finer
details.

Knee Aperture ~ On/Off Turns the knee aperture function on/off.

Knee Aperture  —99 to +0 to +99 Specifies the knee aperture level.

Level

Limit -99 to 0 to +99 Specifies the detail limiter values for
both the white-side and black-side
direction.

White Limit -99 to 0 to +99 Specifies the white-side detail limiter
value.

Black Limit -99 to 20 to +99 Specifies the black-side detail limiter
value.

V-BLK Limit —-99 to 0 to +99 Specifies the black-side V detail limiter
value.

V Detail NAM/G/R+G/Y Selects the source signal used to

Creation generate the V detail signal.

NAM: A V detail signal created from
the R signal, or a V detail signal
created from the G signal, or a V
detail signal created from the B
signal, whichever is the signal with
the highest level
G: G signal
G+R: Composite signal comprising the
G signal and R signal in a 1:1 ratio
Y: Y signal
Aperture Aperture On/Off Turns aperture correction on/off.
Makes settings related to  Level -99 to =0 to +99 Sets the aperture level.

aperture correction.
Aperture correction is
processing to improve
resolution by adding
high-frequency aperture
signals to the video
signal, which corrects
degeneration due to high-
frequency characteristics.
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PAINT

Item

Sub-item

Setting

Description

Skin Detail
Makes settings related to
skin detail correction.

Skin Detail

On/Off

Turns skin detail correction on/off.

Area Detection

Color detection

Detects the color to be targeted by skin

screen detail correction.
Skin detail correction i “Area Indication  On/Off Turns on/off the function that displays a
processing that increases zebra pattern in the area targeted by skin
or decreases the detail detail correction.
level of a specified color o] -99 to +0 to +99 Specifies the skin detail level.
range (skin tone range), Saturation -99 to 20 to +99 Specifies the saturation of the color
for @e_ purpose 9f targeted by skin detail correction.
obtaining .attractlvg Hue 0 to 359 Specifies the hue of the color targeted
reproduction of skin . . .
tones. by skin detail correction.
Width 0 to 40 to 90 Specifies a range for the hue of the color
targeted by skin detail correction.
Matrix Matrix On/Off Turns the matrix correction function on/
Makes settings related to off.
matrix correction. Preset Matrix On/Off Turns the preset matrix function on/off.
Matrix correction allows preget Select 1/2/3/4/5/6 Selects a preset matrix.
you to adjust the color 1: SMPTE-240M equivalent
and vividness of the 2: ITU-709 equivalent
video. Depending on the 3: SMPTE WIDE equivalent
effect you want, you can 4: NTSC equivalent
select one from among a 5: EBU equivalent
number of preset 6: ITU-601 equivalent
m.atrixes, which define oo Matrix On/Off Turns the user matrix function on/off.
different parameter sets. User Matrix -99 to 0 to +99 Specifies a freely defined R-G user
Or you can select a user R-G matrix.
matrix with your own User Matrix -99 to 0 to +99 Specifies a freely defined R-B user
parameters. R-B matrix.
User Matrix -99 to 20 to +99 Specifies a freely defined G-R user
G-R matrix.
User Matrix -99 to 0 to +99 Specifies a freely defined G-B user
G-B matrix.
User Matrix -99 to +0 to +99 Specifies a freely defined B-R user
B-R matrix.
User Matrix -99 to 20 to +99 Specifies a freely defined B-G user
B-G matrix.
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PAINT

Item Sub-item Setting Description

Multi Matrix Multi Matrix On/Off Turns the multi matrix correction
Makes settings related to function on/off.

multi matrix correction.  Area Indication =~ On/Off Turns on/off the function that displays a

Multi-matrix correction
allows specific colors to
be selected for saturation
correction in a 16-axis

zebra pattern in the color area targeted
by multi matrix correction.

Color Detection

Color detection

Detects colors targeted by multi matrix

screen correction.
hue space. Preset Execute/Cancel Sets the Hue and Saturation presets.
Axis B/B+/MG-/MG/ Specifies a color targeted by multi
MG+/R/R+/YL-/YL/ matrix correction (16-axis mode)
YL+/G-/G/G+/CY/
CY+/B-
Hue -99 to 0 to +99 Specifies the hue of the color targeted
by multi matrix correction for each 16-
axis mode.
Saturation -99 to 20 to +99 Specifies the saturation of the color
targeted by multi matrix correction for
each 16-axis mode.
V Modulation V Modulation On/Off Turns V modulation shading on/off.
Makes settings related to Master V -99 to £0 to +99 Specifies the master V modulation
V modulation shading. Modulation level.
V modulation shading R V Modulation —99 to 20 to +99 Specifies the V modulation level of R
corrects vertical signals.
imbalances in sensitivity "Gy Modulation —99 to 0 to +99 Specifies the V modulation level of G
arising from the signals.
relatlonshl;') between a B V Modulation —99 to 20 to +99 Specifies the V modulation level of B
lens and prism. .

signals.
Low Key Sat. Low Key On/Off Turns low key saturation correction on/
Makes settings related to ~ Saturation off.
low key saturation Level -99 to 0 to +99 Specifies the saturation of colors in low
correction. luminance areas.
You can correct the Range Low/L.Mid/H-Mid/  Specifies the luminance level for which
saturation of colors in High low key saturation is enabled.
dark parts of the video
only.
Noise Suppress Noise Suppress ~ On/Off Turns noise suppression on/off.

Makes settings related to
noise suppression (noise
compression).

You can effectively
suppress noise
components while
preserving fine edge
components in the
subject.
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MAINTENANCE Menu

Settings in bold are the factory default values.

MAINTENANCE

Item Sub-item Setting Description
White Shading Channel Select ~ Red/Green/Blue Selects the target of white shading
Makes settings related to correction.
white shading. R/G/B White H  -99 to +0 to +99 Specifies a SAW white shading
White shading is required Saw correction value for the horizontal
for each different lens to direction.
correct irregularities R/G/B White H  -99 to %0 to +99 Specifies a parabola white shading
arising from lens Para correction value for the horizontal
characteristics. It corrects direction.
luminance and color R/G/B White V.. —99 to 20 to +99 Specifies a SAW white shading
irregularities in bright Saw correction value for the vertical
areas. direction.
R/G/B White V. -99 to +0 to +99 Specifies a parabola white shading
Para correction value for the vertical
direction.
White Saw/Para  On/Off Turns the white shading SAW and

parabola correction functions on/off.
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Item Sub-item Setting Description
Battery Info Before End  5%/10%/15%...95%/ Specifies a threshold value that triggers
Makes settings related to 100% a “Battery Near End” warning when a
batteries. BP-GLI95A battery pack is used.
Info End 0%/1%/2%/3%/4%/  Specifies a threshold value that triggers
5% a “Battery End” warning when a
BP-GLO95A battery pack is used.
Sony Before End 11.5V to 17V (0.1V  Specifies a threshold value that triggers
steps) a “Battery Near End” warning when a
BP-L60S/L80S battery pack is used.
Sony End 11.0Vto 11.5V (0.1V Specifies a threshold value that triggers
steps) a “Battery End” warning when a
BP-L60S/L80S battery pack is used.
Other Before 11.5Vto 11.8V to Specifies a threshold value that triggers
End 17.0V (0.1V steps) a “Battery Near End” warning when a
non-Sony battery pack is used.
Other End 11.0V to 14.0V (0.1V  Specifies a threshold value that triggers

steps)

a “Battery End” warning when a non-
Sony battery pack is used.

DC In Before
End

11.5Vto 11.8V to
17.0V (0.1V steps)

Specifies a threshold value that triggers
a “Battery Near End” warning when an
external power source is connected to
the DC IN connector.

DC In End 11.0V to 14.0V (0.1V  Specifies a threshold value that triggers
steps) a “Battery End” warning when an
external power source is connected to
the DC IN connector.
Detected Battery Info/Sony/Other/ Displays the results of automatic battery
DC IN pack type detection.
Type Detection ~ Auto/Other Auto: Detect the battery type

automatically.
Other: Fix battery type detection as
“Other.”

Segment No.10

11.0Vto17.0V (0.1V
steps)

Segment No.9

11.0V to 16.0V to
17.0V (0.1V steps)

Segment No.8

11.0V to 15.0V to
17.0V (0.1V steps)

Segment No.7 11.0V to 14.0V to
17.0V (0.1V steps)
Segment No.6 11.0V to 13.5V to
17.0V (0.1V steps)
Segment No.5 11.0V to 13.0V to
17.0V (0.1V steps)
Segment No.4 11.0V to 12.5V to

17.0V (0.1V steps)

Segment No.3

11.0V to 12.0V to
17.0V (0.1V steps)

Segment No.2

11.0V to 11.5V to
17.0V (0.1V steps)

Segment No.1

11.0Vt0 17.0V (0.1V
steps)

Specifies voltage threshold values that
cause remaining capacity segments to
go off in the display of remaining
battery capacity (see page 25). (The
segments go off below the specified
value.) These values are used when the
battery type has been found to be
“Other.”
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Item Sub-item Setting Description
Audio Front MIC Select Mono/Stereo Selects whether the front microphone is
Makes settings related to monaural (“Mono”) or stereo
audio. (“Stereo”).
Audio CH3/4 Ch1/2 / Switch Selects the input signals for the AUDIO
Mode IN CH-3/CH-4 connectors.
Ch1/2: The same signals as the AUDIO
IN CH-1/ CH-2 connectors.
Switch: The signals selected with the
AUDIO IN CH-3/CH-4 switches.
Front MIC CH1  —70dB/-60dB/ Selects the reference level for channel 1
Ref -50dB/-40dB/ of the front microphone.
—30dB/-20dB
Front MIC CH2 —70dB/-60dB/ Selects the reference level for channel 2
Ref -50dB/-40dB/ of the front microphone.
—-30dB/-20dB
Rear MIC CH1  -70dB/-60dB/ Selects the reference input level when
Ref —50dB/-40dB/ the setting of the AUDIO IN CH1
-30dB/-20dB switch is MIC.
Rear MIC CH2 -70dB/-60dB/ Selects the reference input level when
Ref —50dB/-40dB/ the setting of the AUDIO IN CH2
—30dB/-20dB switch is MIC.

Line Input Ref

+4dB/0dB/-3dB/
EBUL

Selects the reference input level when
the AUDIO IN CHI and AUDIO IN
CH2 switches are set to LINE.

Min Alarm Off/Set Selects the volume when the ALARM
Volume knob is turned all the way down.
Off: Almost inaudible
Set: Fairly audible
Speaker Off/3dB/6dB/9dB/ Selects the volume from the monitor
Attenuate 12dB speaker (does not affect earphone
volume).
Headphone Out  Mono/Stereo Selects whether the earphones are

monaural (“Mono”) or stereo
(“Stereo”).

Reference Level

—20dB/-18dB/

—16dB/-12dB/EBUL

Selects the output level of the 1 kHz test
signal.

Reference Out

0dB/+4dB/-3dB/
EBUL

Specifies the output level with respect
to the reference input level.

CH1&2 AGC
Mode

Mono/Stereo

For automatic adjustment of the input
level of analog audio signals recorded
on channels 1 and 2, specifies whether
to make the adjustments separately for
each channel (“Mono”) or in stereo
mode (“Stereo”).

CH3&4 AGC
Mode

Mono/Stereo

For automatic adjustment of the input
level of analog audio signals recorded
on channels 3 and 4, specifies whether
to make the adjustments separately for
each channel (“Mono”) or in stereo
mode (“Stereo”).

AGC Spec

—-6dB/-9dB/-12dB/

—-15dB/-17dB

Selects the AGC saturation level.
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Item

Sub-item Setting

Description

Audio
Makes settings related to
audio.

Off/-6dB/-9dB/
—-12dB/-15dB/-17dB

Limiter Mode

For manual audio level adjustments,
selects the saturation level for the
limiter applied to loud input signals.
Select “Off” if you do not wish to use
the limiter.

Output Limiter ~ On/Off

Turns the audio output limiter on/off.

CH1 Wind Filter On/Off

Turns the channel 1 wind filter on/off.

CH2 Wind Filter On/Off

Turns the channel 2 wind filter on/off.

CH3 Wind Filter On/Off

Turns the channel 3 wind filter on/off.

CH4 Wind Filter On/Off

Turns the channel 4 wind filter on/off.

Audio SG
(1KHz)

On/Off/Auto

Selects whether to output (“On”) or not

output (“Off”) a 1 kHz test signal in

color bar mode.

Auto: Output a test signal only when
the AUDIO SELECT CHI switch
is set to AUTO.

MIC CHI Level Sidel/Front/

Front+Sidel

For recording input audio from the front

microphone on channel 1, selects the

knob that adjusts the audio level.

Side1: The LEVEL knob (left) on the
side panel

Front: The MIC LEVEL control on the
front panel

Front+Side1: Adjust with both the
LEVEL knob (left) and the MIC
LEVEL control.

For recording input audio from the front

microphone on channel 2, selects the

knob that adjusts the audio level.

Side2: The LEVEL knob (right) on the
side panel

Front: The MIC LEVEL control on the
front panel

Front+Side2: Adjust with both the
LEVEL knob (right) and the MIC
LEVEL control.

MIC CH2 Level Side2/Front/
Front+Side2

Rearl/WRR Side1/Front/

Level Front+Sidel

Selects the knob that adjusts the audio

levels of a wireless microphone and a

device connected to the AUDIO IN

CH-1 connector on the rear panel.

Side1: The LEVEL knob (left) on the
side panel

Front: The MIC LEVEL control on the
front panel

Front+Side1: Adjust with both the
LEVEL knob (left) and the MIC
LEVEL control.
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Item Sub-item

Setting

Description

Audio Rear2/WRR
Makes settings related to  Level
audio.

Side2/Front/
Front+Side2

Selects the knob that adjusts the audio

levels of a wireless microphone and a

device connected to the AUDIO IN CH-

2 connector on the rear panel.

Side2: The LEVEL knob (right) on the
side panel

Front: The MIC LEVEL control on the
front panel

Front+Side2: Adjust with both the
LEVEL knob (right) and the MIC
LEVEL control.

Audio CH3
Level

Side3/Front/
Front+Side3

Selects the knob that adjusts the level of

audio recorded on channel 3.

Side3: The LEVEL knob on the side
panel

Front: The MIC LEVEL control on the
front panel

Front+Side3: Adjust with both the
LEVEL knob and the MIC LEVEL
control.

Audio CH4
Level

Side4/Front/
Front+Side4

Selects the knob that adjusts the level of

audio recorded on channel 4.

Side4: The LEVEL knob on the side
panel

Front: The MIC LEVEL control on the
front panel

Front+Side4: Adjust with both the
LEVEL knob and the MIC LEVEL
control.
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Item

Sub-item

Setting

Description

WRR Setting
Makes settings related to
the wireless tuner.

WRR Valid CH
Sel

All/CH1

Selects whether to enable channels 1
and 2 of the wireless receiver (“All”) or
channel 1 only (“CH1”).

WRR CH Select

TX1/TX2

Specifies the target channel for other
sub-items.

TX1: Channel 1

TX2: Channel 2

WRR Delay
Comp

On/Off

Enables (“On”) or disables (“Off”)
delay compensation for wireless audio
input. (When “On” is selected, the audio
in all E-E output is delayed by about 8
ms.)

X

Displays the name of the transmitter
whose signals are being received on the
channel selected by “WRR CH Select.”

TX Audio Peak

---/Peak

Displays whether the AF level of the
transmitter whose signals are being
received on the channel selected by
“WRR CH Select” are over peak.

TX Input Level

---/Mic/Line

Displays whether the input level of the
transmitter whose signals are being
received on the channel selected by
“WRR CH Select” is set to microphone
(“Mic”) or line (“Line”).

TX ATT Level

Sets the ATT level of the transmitter
whose signals are being received on the
channel selected by “WRR CH Select.”
(The setting range varies depending on
the transmitter.)

TX LCF Freq

Sets the low cut filter frequency of the
transmitter whose signals are being
received on the channel selected by
“WRR CH Select.” (The setting range
varies depending on the transmitter.)

TX System
Delay

Auto/0.0ms to 8.0ms

Specifies the amount of audio delay.

Auto: Automatically adjusts the
amount of delay so that the delay in
the audio received from the
wireless transmitter is zero.

0.0ms to 8.0ms: Sets the amount of
anticipated wireless system delay,
for cases in which several wireless
systems are being used over a
devices such as an audio mixer.
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Item Sub-item Setting

Description

Timecode TC Out Auto/Generator
Makes settings related to
timecode.

Selects the source for timecode output.

Auto: During recording, output values
generated by the timecode
generator, and during playback
output values obtained by the
timecode reader.

Generator: Output values generated
by the timecode generator during
both recording and playback.

DF/NDF DF/NDF

When “Country” is set to other than
“PAL Area,” selects drop-frame mode
(“DF”) or non-drop-frame mode
(“NDF”).

LTC UBIT Fix/Time

Specifies the data recorded in LTC user
bits.

Fix: Record user-specified data.

Time: Record the current time.

Counter Display Counter/Duration

Select the method used to reset the

counter value displayed on the

viewfinder screen.

Counter: Continue to increment until
the RESET button is pressed.

Duration: Reset each time that
recording is started.

Essence Mark Ret Shot Mark 1 On/Off
Makes settings related to

Specify whether to input Shot Mark1
marks using the RET button on the lens.

shot marks and clip index Ret Shot Mark 2 On/Off
picture thumbnails.

Specify whether to input Shot Mark2
marks using the RET button on the lens.

Index Picture Pos 0sec to 10sec
(in 1 sec steps)

Specifies which frame to use as the clip
thumbnail image

Find Mode Clip/Rec Start

Specify the frame to be cued up when

the PREV or NEXT button is pressed.

Rec Start: The next frame or the
previous frame where a Rec Start
essence mark is set.

Clip: Pressing the NEXT button moves
to the start frame of the next clip.
Pressing the PREV button moves
to the start frame of the current
clip. (Pressing the PREV button at
the start frame of the current clip
moves to the start frame of the
previous clip.)
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Item Sub-item Setting Description
Camera Config Rec Tally Blink  On/Off Turns warning flashes by the TALLY
Makes settings related to indicator on/off. The warnings alert you
various camcorder an almost exhausted battery pack or low
operations. remaining media capacity.

Rec Review 3sec/10sec/Clip Selects the recording review time.

Clip: Review all of the most recently
recorded clip.
SDI Rec Control Off / Remote I/F / Sets the function that enables
Para Rec synchronized recording with this

camcorder.

Remote I/F: To feed a REC trigger
signal to a recorder connected to
the SDI OUT connector.

Para Rec: Performs the recording
controls by interlocking to the
camcorder’s recording operation.

HD SDI Remote Chara/G-Tally/
I/F R-Tally

Selects the indication that shows
whether the external device is recording
when “SDI Rec Control” is set to
“Remote I/F.”

Chara: Indicate by the external device
control indication on the
viewfinder screen.

G-Tally: Indicate by the green tally
indicator on the viewfinder screen.

R-Tally: Indicates by the recording
mode/operation status indication
on the viewfinder screen.

When “SDI Rec Control” is set to “Para
Rec,” “Chara” is set automatically and this
item is grayed out.

Match Clip
Name

On/Off

Sets whether to add the clip name
information to the SDI output.

ALAC AUTO/OFF

Sets the ALAC (automatic lens

aberration correction) function.

AUTO: The ALAC function is set to on
when a compatible lens is attached.

OFF: Does not use the ALAC function.

CCU Operation Normal/Local

Enables switch operations for the inside
panel when the camera adapter is
mounted.

« If you change the switch operation
setting of the camcorder, the camcorder
will restart automatically.

¢ When main unit switch operation is
enabled, display of the CCU remote
controller and display of return videos
and tally and call operations from the
CCU are enabled, but remote control via
the CCU or via the REMOTE connector
is disabled.
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Item

Sub-item

Setting

Description

Camera Config

Makes settings related to

various camcorder
operations.

Color Bars Select

ARIB/100%/75%!
SMPTE

Selects the color bar type.

User Menu Only

On/Off

Selects whether to display the USER
menu only (“On”) or display the menu
list (“Off”) when the camcorder is
displaying the menu.

RM Common
Memory

On/Off

Selects whether to share (“On”) or not
share (“Off”) settings between times
when a remote control unit is connected
and times when the camcorder is used
locally.

RM Rec Start

RM/CAM/PARA

For times when a remote control unit is
connected, selects whether recording
start/stop buttons are enabled on the
camcorder or the remote control unit.
RM: Remote control unit

CAM: Camcorder

PARA: Both

Image Invert

On/Off

Turns the function that inverts images
vertically on/off.

Rec Start/Stop
Beep

On/Off

Specifies whether to generate (“On”) or
not generate (“Off”) a beep alarm when
recording starts/stops.

With this item set to “On,” a single beep
sounds when recording starts and a
double beep sounds when recording
stops.

Rec Status
Indicator

On/Off

Specifies whether to display the
recording status indicator in the
viewfinder.

Fan Control

Auto/Off in Rec

Sets the fan control mode.

Preset White

Makes settings related to

white balance preset
values.

Color Temp<P>

1500K to 3200K to
50000K

Specifies the white balance preset value.

Color Temp
Balance<P>

-99 to +0 to +99

Specifies finer color temperature
settings, for use when satisfactory video
cannot be obtained with “Color
Temp<P>.”

R Gain <P>

-99 to +0 to +99

Specifies the R gain preset value.

B Gain <P>

-99 to +0 to +99

Specifies the B gain preset value.

AWB Enable
<P>

On/Off

Turns on and off execution of the AWB
(auto white balance) function when the
WHITE BAL switch is set to PRST.
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Item Sub-item Setting Description
White Filter ND Filter On/Off Turns the function that assigns electrical
Makes settings related to  C.Temp CC filters to ND filters on/off.
filters. ND FLT 3200K/4300K/ Selects the color temperature for when
C.Temp<I> 5600K/6300K electrical CC filters are assigned to ND
filters.
ND FLT 3200K/4300K/ Selects the color temperature for when
C.Temp<2-4>  5600K/6300K electrical CC filters are assigned to ND
filters.
Electrical 3200K/4300K/ Selects the color temperature for when
CC<A> 5600K/6300K the electrical CC filter switching
function is assigned to an assignable
switch.
Electrical 3200K/4300K/ Selects the color temperature for when
CC<B> 5600K/6300K the electrical CC filter switching
function is assigned to an assignable
switch.
Electrical 3200K/4300K/ Selects the color temperature for when
CC<C> 5600K/6300K/----- the electrical CC filter switching
function is assigned to an assignable
switch.
Select “----” if you do not want to use C.
Electrical 3200K/4300K/ Selects the color temperature for when
CC<D> 5600K/6300K/----- the electrical CC filter switching

function is assigned to an assignable
switch.
Select “----” if you do not want to use D.
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Item

Sub-item

Setting

Description

Auto Iris2
Makes settings related to
auto iris.

Iris Window

1/2/3/4/5/6/Var

Selects the auto iris detection window

type.
Var: Variable

Iris Window Ind

On/Off

Turns the indication of the auto iris
detection window frame on/off.

Iris Level

-99 to +0 to +99

Adjusts the level of the auto iris target
value.

Iris APL Ratio

-99 to +0 to +99

Adjusts the mix ratio of auto iris
detection peak value and average value.
(Available when “OPERATION” >
“TLCS” > “Mode” is set to “Standard”)

Iris Var Width

40 to 500 to 999

Adjusts the width of the detection
window when “Iris Window” is set to
“VAR.”

Iris Var Height

70 to 500 to 999

Adjusts the height of the detection
window when “Iris Window” is set to
“VAR.”

Iris Var H
Position

—479 to 0 to +479

Specifies the horizontal position of the
detection window when “Iris Window”
is set to “VAR.”

Iris Var V
Position

—464 to 0 to +464

Specifies the vertical position of the
detection window when “Iris Window”
is set to “VAR.”

Iris Speed

—-99 to 0 to +99

Specifies the control speed (speed of
reaction to changes in the video).
(Larger values specify quicker reaction
times.)

Clip High Light

On/Off

Turns on/off the function that disregards
highlights and forces a flatter reaction to
high luminance.

Flicker Reduce

Makes settings related to
flicker reduction.
Reduces the flicker that
can occur when a subject
is shot under a light
source with a periodically
varying brightness, such
as fluorescent lights, due
to the relationship with
the camcorder’s
recording frame rate.

Mode

Auto/On/Off

Enables or disables flicker reduction.
On: Always enabled.

Auto: Enabled when flicker is detected.
Off: Disabled

Frequency

60Hz/50Hz

Set to the frequency of the lighting
fixture that is causing the flicker. (The
factory default setting is “50 Hz” when
“Country” is set to “PAL Area,”

“60 Hz” when “Country” is set to other
than “PAL Area.”)

Genlock
Makes settings related to
genlock.

H Phase(HD)

-999 to =0 to +999

Specifies the H phase of HD output
when genlock is enabled.

H Phase(SD)

-99 to +0 to +99

Specifies the H phase of SD output
when genlock is enabled.

Reference

Internal/Genlock

Displays the type of reference signal
used by the camcorder.
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Item Sub-item Setting Description
ND Comp ND Offset On/Off ND filter color compensation function.
Makes settings related to  Adjust
ND filter color Clear ND Offset Execute/Cancel Clears ND filter color compensation
compensation. values (execute using Execute).
Although the differences
are very slight, each of
the built-in ND filters has
different color
characteristics. When you
switch between ND
filters, the white balance
may be disturbed. You
can correct for these
slight color differences
automatically by
registering compensation
values for each filter.
Lens Auto FB Adjust  Execute/Cancel Executes auto flange back adjustment,
Executes auto flange back only for supported lenses (execute using
adjustment. Execute).
Trigger Mode i.LINK Trigger Internal/Both/ Select Internal when recording start and
Makes settings related to  Mode External stop operations target SXS memory
triggers for starting and cards only. Select External when they
stopping recording. target only devices connected to the
i.LINK (HDV/DV) or HD/SD SDI OUT
connectors. Select Both when they
target both memory cards and external
devices.
Network Setting 2) DHCP Enable/Disable Selects whether to acquire the IP
Makes settings for address automatically from a DHCP
network connection. server (“Enable”) or not (“Disable”).
m IP Address 0.0.0.0 to When “DHCP” is set to “Disable,” sets
 The IFU-WLM3 USB 255.255.255.255 the IP address.
Wireless LAN Module is (192.168.1.10)
required. Subnet Mask 0.0.0.0 to When “DHCP” is set to “Disable,” sets
* This item is not available 255.255.255.255 the subnet mask.
when using the Default Gateway 0.0.0.0 to When “DHCP” is set to “Disable,” sets
iﬁK'[WAlOl Wireless 255.255.255.255 the default gateway.
. Thiaspilzrr'n is disabled User Name admin Sets a desired user name in 1 to 31
(grayed out) during alphanumeric characters.
recording and play. Password pxw-x320 (model Sets a password (model name) in 0 to 31
For details about wireless name) alphanumeric characters.
LAN connection, see Set Execute/Cancel Confirms the settings in “Network

“Using Wireless LAN

Settings” (execute using Execute).

Connection” (page 79).

MAC Address

Displays the MAC address.

Net Config Reset Execute/Cancel

Resets the settings in “Network
Settings” to the preset values (execute
using Execute).
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Item

Sub-item

Setting

Description

Wi-Fi Setting
Makes settings for

wireless LAN connection.

* The IFU-WLM3 USB
Wireless LAN Module is
required.

Menus other than “Wi-
Fi” and “Wi-Fi Remote”
are not used when using
the CBK-WA101
Wireless Adapter.

This item is disabled
(grayed out) during
recording and play.

For details about wireless
LAN connection, see
“Using Wireless LAN
Connection” (page 79).

Scan Networks

Execute/Cancel

When “Wi-Fi” is set to “Enable,” scan

the available network connection.

SSID

Network name

Sets the network name of up to 32
characters.

Network Type

Infra/Adhoc

Selects the connection mode.
Infra: Infrastructure mode
Adhoc: Ad hoc mode

Ch

1to 11

When “Network Type” is set to
“Adhoc,” set the wireless channel.

Authentication

Open/Shared/WPA/
WPA2

Selects the network authentication.

Open: Open system authentication

Shared: Shared key authentication

WPA: WPA (Wi-Fi Protected Access)
authentication

WPA2: WPA2 (Wi-Fi Protected
Access 2) authentication when
“Network Type” is set to “Infra”

Encryption

Disable/WEP/TKIP/
AES

Selects whether to apply data
encryption and the type of data
encryption.

Disable: Do not apply data encryption.

WEP: Apply WEP (Wired Equivalent
Privacy) when “Authentication” is
set to “Open” or “Shared”

TKIP: Apply TKIP (Temporal Key
Integrity Protocol) when
“Authentication” is set to “WPA”
or “WPA2”

AES: Apply AES (Advanced
Encryption Standard) when
“Authentication” is set to “WPA”
or “WPA2”

WEP Key Index

1/2/3/4

When “Encryption” is “WEP,” selects
the key index.

Input Select

‘When “Encryption” is
set to “WEP”
ASCII5,

ASCII13,

HEX10,

HEX26

‘When “Encryption” is
set to “TKIP” or

Selects the input format depending on
the network key (or security key).
ASCII5: Five characters ASCII format
ASCII13: 13 characters ASCII format
HEX10: 10 hexadecimal digits
HEX26: 26 hexadecimal digits
ASCII8-63: 8 to 63 characters ASCIL
8-bit format
HEX64: 64 hexadecimal digits

“AES”

ASCII8-63,

HEX64
Key Sets the network key (or security key).
Set Enables settings for “Wi-Fi Setting”

when “Wi-Fi” is set to “Enable”
(execute using Execute).
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Item Sub-item Setting Description
Wi-Fi Setting Wi-Fi Status [ L[] Displays “Connecting” while
Makes settings for Connecting connection is being attempted. Displays

wireless LAN connection.

¢ The IFU-WLM3 USB
Wireless LAN Module is

black squares () to show the
connection status by the number of
squares when the camcorder is
connected to a computer or a LAN.

802.11b/802.11g/
802.11n

Displays an IEEE802.11 standard.

required. Wireless Mode
* Menus other than “Wi-
Fi” and “Wi-Fi Remote” Wi-Fi

are not used when using

Enable/Disable

Selects whether to enable or disable
wireless LAN connection.

;}:]ei ISIE::X;:;[%L Wi-Fi Remote On/Off Select “On” when using Wi-Fi remote

+ This item is disabled control.

rayed out) durin
Egco}rlding ar)ld playg. m

For details about wireless Unselectable when “Wi-Fi” is set to

LAN connection, see “Disable.”

“Using Wireless LAN

Connection” (page 79).

Clock Set Date/Time Sets the current date and time.

Sets the internal clock. 12H/24H 12H/24H Selects the 12-hour format (“12H”) or
the 24-hour format (“24H”) for display
of times.

Date Mode YYMMDD/ Selects the display format for dates.
MMDDYY/ YYMMDD: Year, Month, Day
DDMMYY MMDDYY: Month, Day, Year

DDMMYY: Day, Month Year

Language Language English/Japanese/ Selects the language for menus and

Selects the language for Chinese/Spanish/ messages.

menus and messages. Portuguese/Russian/  English: To display in English

Indonesian Japanese: To display in Japanese

Chinese: To display in Chinese

Spanish: To display in Spanish

Portuguese: To display in Portuguese

Russian: To display in Russian

Indonesian: To display in Indonesian

[ Notes |

* The language of the menus and messages
differs depending on the area.

* When set to “Japanese,” the menus are
displayed in English, and messages are
displayed in Japanese.

Hours Meter Hours(Sys) Displays the cumulative hours of use

Makes settings related to (cannot be reset).

the digital hours meter. ~ Hours(Reset) Displays the hours of use (can be reset).

Reset Execute/Cancel Resets “Hours(Reset)” to “0” (execute

using Execute.)
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MAINTENANCE

Item

Sub-item

Setting

Description

Menu Scroll
Selects the scroll method
for the menu.

Menu Scroll

Normal/Loop

Selects the scroll method for the menu.

Normal: The cursor stops when it
reaches to the top or bottom while
scrolling.

Loop: The cursor continues scrolling
from the bottom when it reaches to
the top, or from the top when it
reaches to the bottom.

USB Set

USB Thumbnail

Execute/Cancel

Displays the USB media thumbnail
screen.

Select Folder

Selects a folder on USB media as the
destination when copying clips and for
display on the thumbnail screen.

Select “<New>" to create a new folder.

Rename Folder

Renames the current folder.

Error Check

On/Off

Selects whether to perform error
checking when copying clips.

Format USB

exFAT/FAT32

Formats USB media.

exFAT: Format USB media for copying
clips.

FAT32: Format USB flash drive for
writing planning metadata (UDF/
exFAT mode).

Copy To USB

A to USB/B to USB/
A&B to USB

Copies SxS memory card clips to USB
media.

Available only when the thumbnail screen
is displayed.

Copy From USB

USB to A/USB to B

Copies USB media clips to SxS
memory card.

Available only when the thumbnail screen
is displayed.

With General

Enable/Disable

Enables/disables copying of files in the
General folder when copying clips.

Version
Displays the version of

Version

Displays the software version of the
camcorder (VX.XX).

the camcorder, and
updates the camcorder.

CBK-CEO1

Displays the software version of the
optional CBK-CEO1 (Vx.xx).

Version Up

Execute/Cancel

Updates the camcorder (execute using
Execute).

This cannot be selected unless an SxS
memory card is inserted.
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FILE Menu

Settings in bold are the factory default values.

FILE

Item

Sub-item Setting

Description

User
Makes settings relating to
user file operations.

User Load SxS  Execute/Cancel

Loads a user file saved on an SxS

memory card (execute using Execute).

When “Load Customize Data” is
“Off”: USER menu settings are
replaced by settings saved in a user
file (menu organization does not
change).

When “Load Customize Data” is
“On”: USER menu settings and
organization are replaced by
settings and organization saved in a
user file.

When “Load White Data” is “Off”:
Do not load white balance data
when loading a user file.

When “Load White Data” is “On”:
Load white balance data.

User Save SxS  Execute/Cancel

Saves current USER menu organization,
settings, and white balance data to a
user file on an SxS memory card
(execute using Execute).

User Load USB (UDF/exFAT mode)

Loads a user file saved on a USB flash
drive (execute using Execute).

User Save USB (UDF/exFAT mode)

Saves current USER menu organization,
settings, and white balance data to a
user file on a USB flash drive (execute
using Execute).

File ID Assigns a name to a user file. Names
can be up to 16 characters in length.

Recall User Execute/Cancel Returns the settings of menu items

Preset registered in the USER menu to the

preset values (execute using Execute).

Store User Preset Execute/Cancel

Stores the settings of menu items
registered in the USER menu items as
the preset values (execute using
Execute).

Clear User Preset Execute/Cancel

Returns the settings of menu items
registered in the USER menu to the
factory default values (execute using
Execute).

Load Customize Off/On
Data

Selects whether to load menu
organization and settings (“On”) or
menu settings only (“Off”) when
loading a user file.

Load White Data Off/On

Selects whether to load (“On”) or not
load (“Off”) white balance data when
loading a user file.
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FILE

Item Sub-item Setting Description
All Display Mode Date&Time/ Selects the items to be displayed in the
Makes settings related to Model Name list box that appears when a file is saved
ALL file operations. or loaded.
All Load SxS Execute/Cancel Loads a file from an SxS memory card
(execute using Execute).
All Save SxS Execute/Cancel Stores a file to an SxS memory card
(execute using Execute).
All Load USB Execute/Cancel Loads a file from a USB flash drive
(UDF/exFAT (execute using Execute).
mode)
All Save USB Execute/Cancel Stores a file to a USB flash drive
(UDF/exFAT (execute using Execute).
mode)
File ID Assigns a name to a file. Names can be
up to 16 characters in length.
All Preset Execute/Cancel Return all items to their preset values
(execute using Execute).
Store All Preset  Execute/Cancel Store the current settings of all items as
the preset values (execute using
Execute).
Clear All Preset Execute/Cancel Clear the preset values of all items
(execute using Execute).
3Sec Clr Preset ~ On/Off Turns on/off the function that clears

each preset value when the MENU
CANCEL/PRST/ESCAPE switch is
pushed up and held for three seconds on
the CANCEL/PRST side.

Network Data Off/On Selects whether to load (“On”) or not
load (“Oft”) network settings when
loading an ALL file.
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FILE

Item Sub-item Setting Description
Scene 01 Standard File number and file ID
Makes settings related to ]2 Standard File number and file ID
scene file operations. 03 Standard File number and file ID
04 Standard File number and file ID
0s Standard File number and file ID
[OStandard Standard settings
Display Mode Date&Time/ Selects the items to be displayed in the
Model Name list box that appears when a file is saved
or loaded.
Scene Recall Execute/Cancel Loads a file from internal memory
Mem (execute using Execute).
Scene Store Execute/Cancel Stores a file in internal memory
Mem (execute using Execute).
Scene Recall SxS Execute/Cancel Loads a file from an SxS memory card
(execute using Execute).
Scene Store SxS  Execute/Cancel Stores a file to an SxS memory card
(execute using Execute).
Scene Recall Execute/Cancel Loads a file from a USB flash drive
USB (execute using Execute).
(UDF/exFAT
mode)
Scene Store USB  Execute/Cancel Stores a file to a USB flash drive
(UDF/exFAT (execute using Execute).
mode)
File ID Assigns a name to a file. Names can be
up to 16 characters in length.
Reference Reference Store  Execute/Cancel Stores the current settings of reference
Makes settings related to file items in the reference file that is
reference file operations. maintained in internal memory (execute
using Execute).
Reference Clear Execute/Cancel Clears the reference file (execute using
Execute).
Reference Load  Execute/Cancel Loads a file from an SxS memory card
SxS (execute using Execute).
Reference Save  Execute/Cancel Stores a file to an SxS memory card
SxS (execute using Execute).
Reference Load  Execute/Cancel Loads a file from a USB flash drive
USB (execute using Execute).
(UDF/exFAT
mode)
Reference Save  Execute/Cancel Stores a file to a USB flash drive
USB (execute using Execute).
(UDF/exFAT
mode)
File ID Assigns a name to a file. Names can be
up to 16 characters in length.
Scene White On/Off Selects whether to load (“On”) or not
Data load (“Off”’) white balance data when

“Scene” > “Scene Recall” or “Scene” >
“Standard” is executed.
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FILE

Item Sub-item Setting Description
Lens Display Mode Date&Time/ Selects the items to be displayed in the
Makes settings related to Model Name list box that appears when a file is saved
lens file operations. or loaded.
Lens Recall Execute/Cancel Loads a file from internal memory
Mem (execute using Execute).
Lens Store Mem Execute/Cancel Stores a file in internal memory
(execute using Execute).
Lens Recall SxS Execute/Cancel Loads a file from an SxS memory card
(execute using Execute).
Lens Store SxS  Execute/Cancel Stores a file to an SxS memory card
(execute using Execute).
Lens Recall USB Execute/Cancel Loads a file from a USB flash drive
(UDF/exFAT (execute using Execute).
mode)
Lens Store USB  Execute/Cancel Stores a file to a USB flash drive
(UDF/exFAT (execute using Execute).
mode)
File ID Assigns a name to the most recently
loaded file. Names can be up to 16
characters in length.
Source Displays the number of the selected file.
Lens No Offset  Execute/Cancel Clears a file (execute using Execute).
Lens Auto Recall Off/On/Serial When the installed lens supports serial
Number communication, specifies whether to

automatically load that reference file.

Off: Do not use this function.

On: Load the reference for the model
name and reflect the contents of the
file.

Serial Number: For lenses that
support serial number
communication, load the lens file
that corresponds to the serial
number and model name, and
reflect the contents of that file. For
lenses that do not support serial
number communication, load the
reference for the model name (in
the same way as when On is
selected).

Serial Number

Displays the serial number of the
installed lens (only for lenses that
support serial communication).

Lens ID

Displays the model name of the
installed lens (only for lenses that
support serial communication).

L Manufacturer

Displays the name of the manufacturer
of the installed lens (only for lenses that
support serial communication).

M V Modulation —99 to #0 to +99

Sets a vertical SAW shading
compensation value in the lens file.
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FILE

Item Sub-item Setting Description
Lens Lens Center H ~ —40 to 0 to 40 Sets a center marker horizontal position
Makes settings related to in the lens file.
lens file operations. Lens Center V.. —40to 0 to 40 Sets a center marker vertical position in
the lens file.
Lens R Flare —-99 to 0 to +99 Sets a R flare level in the lens file.
Lens G Flare —-99 to 0 to +99 Sets a G flare level in the lens file.
Lens B Flare -99 to +0 to +99 Sets a B flare level in the lens file.
Lens W-R Offset —99 to +0 to +99 Sets a R white balance compensation
value in the lens file.
Lens W-B Offset —99 to +0 to +99 Sets a B white balance compensation
value in the lens file.
Shading Ch Sel  Red/Green/Blue Selects the white shading compensation
target.
LR/G/BH Saw —99 to #0 to +99 Sets a horizontal SAW white shading
compensation value in the lens file.
L R/G/B HPara —99 to #0 to +99 Sets a horizontal parabola white shading
compensation value in the lens file.
LR/G/BV Saw 99 to 20 to +99 Sets a vertical SAW white shading
compensation value in the lens file.
LR/G/BV Para 99 to #0 to +99 Sets a vertical parabola white shading
compensation value in the lens file.
Import File Import Execute/Cancel Loads a PMW-320 scene file.

Before performing import, select the card
slot for the SxS memory card to which the
scene file is stored.
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Assigning Functions to Assignable Switches

Using the Assignable SW item of the OPERATION menu, you can assign user-specified functions to the
ASSIGN. 0 to 3 switches, the ASSIGNABLE 4 and 5 switches, the COLOR TEMP. button, and the RET

button on the lens.

The following tables lists the functions that are assigned when the camcorder is shipped from the factory.

Switch or button Function Assignable SW setting
ASSIGN. 0 switch No assignment Off
ASSIGN. 1 switch Execute EZ mode, according to the setting of EZ Mode
“OPERATION” > “TLCS.”
ASSIGN. 2 switch No assignment Off
ASSIGN. 3 switch No assignment Off
ASSIGNABLE 4 switch ~ No assignment Off
ASSIGNABLE 5 switch  No assignment Off
RET button During recording or playback: Write a shot mark. Lens RET
In the other states: Conduct a recording review (if
playback is allowed).
COLOR TEMP. button Adjust the white balance with a 5600K preset value. Color Temp SW 5600K

Functions That Can Be Assigned to the ASSIGN. 0 Switch

Assignable SW setting  Function State when camcorder
is next powered on

Off No assignment —

Marker Turns the display of all markers on/off. Setting retained

ATW Hold Hold the white balance setting in the ATW (auto-tracking —

white balance) mode

Picture Cache

Turn the picture cache function on/off.

Setting retained

Freeze Mix Execute the freeze mix function. —

Focus Mag Turn the focus magnification function on/off. Setting not retained

Zebra Turn zebra display on/off. Setting not retained

Shot Mark1 Write Shot Mark1. —

Shot Mark2 Write Shot Mark2. —

OK Mark Add or delete an OK mark. —

Clip Flag OK Add/clear an OK flag to/from the clip being recorded or  Setting not retained
played.

Clip Flag NG Add/clear an NG flag to/from the clip being recorded or ~ Setting not retained
played.

Clip Flag Keep Add/Clear a KP flag to/from the clip being recorded or ~ Setting not retained
played.

Flashband Reduce Turn the flashband reduce function on/off. Setting not retained

Quick Backup

Back up all the clips in the selected SxS card to a USB

media.

Setting not retained

USB Thumbnail

Display the thumbnail screen of a USB media.

Setting not retained
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Functions That Can Be Assigned to the ASSIGN. 2 Switch
[ Note |

Immediately after you assign a function to the ASSIGN. 2 switch or you switch the recording format, the setting of the
switch at that point may not match the camcorder’s internal state. After assigning a function, switch the ASSIGN. 2
switch or power the camcorder off and on again.

Assignable SW setting  Function

Off No assignment

Front Mic Switch between stereo and monaural when a stereo microphone is connected.
Marker Turns the display of all markers on/off.

Picture Cache ) Turn the picture cache function on/off.

Zebra Turn zebra display on/off.

Clip Continuous Rec Turn the Clip Continuous Rec mode on/off.

Digital Extender b) Turn the screen magnification function on/off when the optional CBK-CEO1 50

Pin Interface and Digital Extender is installed.

a) When Picture Cache is assigned, “OPERATION” > “Rec Function” in the setup menu is disabled (grayed out) to
keep the setting unchanged.
b) When the digital extender function is turned on, it is not possible to show the return video.

Functions That Can Be Assigned to the ASSIGN. 1 and 3 Switches, the
ASSIGNABLE 4 and 5 Switches, and the COLOR TEMP. Button

Assignable SW setting  Function State when
camcorder is next
powered on

Off No assignment —

Front Mic Switch between stereo (On) and monaural (Off) when a Setting retained

stereo microphone is connected.

Marker Turns the display of all markers on/off. Setting retained

Last Clip Delete Delete the most recently recorded clip. —

ATW Turn ATW (auto tracing white balance) mode on/off. Setting not retained

ATW Hold Hold the white balance setting in the ATW mode. —

EZ Mode Execute EZ mode, according to the setting of Setting retained

“OPERATION” > “TLCS.”
Turbo Gain Execute Turbo Gain according to the setting of Setting not retained
“OPERATION” > “Gain Switch” > “Gain Turbo.”

Rec Review Execute recording review. —

Rec Start or stop recording. —

Picture Cache Turn the picture cache function on/off. Setting retained

Freeze Mix Execute the freeze mix function. Setting not retained

Spotlight Turn the spotlight function in auto iris mode on/off. Setting retained

Backlight Turn the backlight function in auto iris mode on/off. Setting retained

EVF Mode Switch the viewfinder screen between B&W (On) and color = Setting retained

(Off).
BRT Disp Turn the display of the brightness level on/off. Setting retained
Histogram Turn the histogram display on/off. Setting retained
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Assignable SW setting

Function

State when
camcorder is next
powered on

Lens Info

Switch the depth of field indication between off, displayed in

meters, and displayed in feet.

Setting retained

Zoom Tele/Wide

When a lens that supports serial communication is installed,

assign the Zoom Tele function to ASSIGNABLE 4, and
assign the Zoom Wide function to ASSIGNABLE 5
(displayed only when <4> and <5> are set).

Zoom Wide/Tele

When a lens that supports serial communication is installed,

assign the Zoom Wide function to ASSIGNABLE 4, and
assign the Zoom Tele function to ASSIGNABLE 5
(displayed only when <4> and <5> are set).

Manual Focus Assist

Turn the manual focus assist function on/off.

Setting retained

Focus Mag Turn the focus magnification function on/off. Setting not retained
Zebra Turn zebra display on/off. Setting not retained
Lens RET Display return video signals when the optional CBK-CEOI is —

installed and a camera control unit is connected.

‘When a camera control unit is not connected, function as
follows.

During recording or playback: Write a shot mark.

In the other states: Conduct a recording review (if playback

is allowed).

Return Video )

Display return video signals during operating the system,
when the optional CBK-CEO1 is installed and a camera
adaptor and camera control unit are connected.

Return Video2

Display return video signals during operating the system,
when the optional CBK-CEO1 is installed and a camera
adaptor is connected.

Return Video3

Display return video signals during operating the system,
when the optional CBK-CEO1 is installed and a camera
adaptor is connected.

Return Video4

Display return video signals during operating the system,
when the optional CBK-CEO1 is installed and a camera
adaptor is connected.

Shot Mark1 Write Shot Mark1. —

Shot Mark2 Write Shot Mark2. —

OK Mark Add or delete an OK mark. —

Clip Flag OK Add/clear an OK flag to/from the clip being recorded or Setting not retained
played.

Clip Flag NG Add/clear an NG flag to/from the clip being recorded or Setting not retained
played.

Clip Flag Keep Add/Clear a KP flag to/from the clip being recorded or Setting not retained
played.

Color Temp SW 3200K  Adjust the white balance with a 3200K preset value. Setting retained

Color Temp SW 4300K  Adjust the white balance with a 4300K preset value. Setting retained

Color Temp SW 5600K  Adjust the white balance with a 5600K preset value. Setting retained

Color Temp SW 6300K  Adjust the white balance with a 6300K preset value. Setting retained
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Assignable SW setting

Function

State when
camcorder is next
powered on

Electrical CC

Function that switches the electrical CC filter (3200K/
4300K/5600K/6300K) applied to white balance adjustment
values.

Each press of the switch or button switches in the order
3200K—»4300K—»5600K—6300K.

These can also be applied from a menu (apply with Electrical
CC<A><B><C><D>).

This function is not available when “MAINTENANCE” >
“White Filter” >ND Filter C.Temp” in the setup menu is set to
“On.”

If you set “ND Filter C.Temp” to “On” after assigning the
function, the assignable switch ceases to function.

Setting retained

CC5600K

Apply a 5600K electrical CC filter to white balance
adjustment values.

Setting retained

Clip Continuous Rec

Turn the Clip Continuous Rec mode on/off.

Setting retained

Slot Select

When both slots A and B have recording media inserted in
them, select the media to use.

Digital Extender a) Turn the screen magnification function on/off when the Setting not retained
optional CBK-CEOQ1 50 Pin Interface and Digital Extender is
installed.

Flashband Reduce Turn the flashband reduce function on/off. Setting not retained

Quick Backup Back up all the clips in the selected SxS card to a USB Setting not retained
media.

USB Thumbnail Display the thumbnail screen of a USB media. Setting not retained

a) When the digital extender function is turned on, it is not possible to show the return video.

Functions That Can Be Assigned to the RET Button on the Lens

Assignable SW setting

Function

State when

camcorder is next
powered on

Off

No assignment —

Lens RET

Display return video signals when the optional CBK-CE01 —
is installed and a camera control unit is connected.
‘When a camera control unit is not connected, function as
follows.
During recording or playback: Write a shot mark.
In the other states: Conduct a recording review (if

playback is allowed).

Return Video @)

Display return video signals when the optional CBK-CE01 —
is installed and a camera control unit is connected.

Rec Review

Execute recording review. —

Shot Mark1 Write Shot Mark 1. —
Shot Mark2 Write Shot Mark2. —
Clip Flag OK Add/clear an OK flag to/from the clip being recorded or ~ Setting not retained

played.
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Assignable SW setting  Function State when
camcorder is next

powered on

Clip Flag NG Add/clear an NG flag to/from the clip being recorded or ~ Setting not retained
played.

Clip Flag Keep Add/Clear a KP flag to/from the clip being recorded or Setting not retained
played.

OK Mark Add or delete an OK mark. —

Focus Mag Turn the focus magnification function on/off. Setting not retained

Flashband Reduce Turn the flashband reduce function on/off. Setting not retained

Quick Backup Back up all the clips in the selected SxS card to a USB Setting not retained
media.

USB Thumbnail Display the thumbnail screen of a USB media. Setting not retained

a) When the digital extender function is turned on, it is not possible to show the return video.
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Adjusting PMW-320 Image Quality

You can adjust the PMW-320 image quality to match the camcorder using the following menu settings.

Menu item Sub-item Setting
HD SD
PAINT >Matrix User Matrix R-G +65 +65
User Matrix R-B -24 -24
User Matrix G-R =20 =20
User Matrix G-B =25 =25
User Matrix B-R —-11 -11
User Matrix B-G +28 +28
PAINT >Detail(HD Mode)/Detail(SD Mode) Level -10 +0
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Saving and Loading User Setting Data

Saving and Loading
Settings

You can save setup menu settings in the
camcorder’s internal memory, on an SxS memory
card, or USB flash drive (in UDF/exFAT mode).
This allows you to quickly recall an appropriate
set of menu settings for the current situation.

When using a USB flash drive (UDF, exFAT
modes)

Before starting, connect a formatted USB flash
drive (see page 65) to the external device
connector.

Setting data is saved in the following categories.

User files: User files save the setting items and
data of the customizable USER menu. You
can save up to 64 user files on an SxS
memory card or USB flash drive (in UDF,
exFAT modes). By loading this file into the
camcorder memory, you can customize the
setup of the USER menu.

ALL files: ALL files save the setting data of all
menus. You can save up to 64 ALL files on
an SxS memory card or USB flash drive (in
UDF/exFAT mode).

Device specific data (shading, output levels, and
other data that requires adjustment for the specific
device) is not saved.

Scene files: Scene file save adjustments to
PAINT menu items for the purpose of
shooting a particular scene. You can save up
to five scene files in the camcorder’s internal
memory and up to 64 scene files on an SxS
memory card or USB flash drive (in UDF/
exFAT mode).

Reference files: Reference files save the
reference values that are set when you
execute “FILE” > “Scene” > “Standard” in
the setup menu. You can save one reference
file in the camcorder’s internal memory and
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one on an SxS memory card or USB flash
drive (in UDF/exFAT mode).

Lens files: Lens files save the setting data used to
compensate for lens characteristics, such as
flare, white shading, white balance and
center markers. You can save up to 32 lens
files in the camcorder’s internal memory and
up to 64 lens files on an SxS memory card or
USB flash drive (in UDF/exFAT mode).

The first settings stored in a file are called “preset

values.”

Even after loading files to set up the camcorder,

and overwriting original files with new settings,

you can still recover preset values and reset files

to their initial states (see page 166).

Saving Settings Data

Before starting, insert a writable SxS memory
card into a memory card slot.

For details about menu operations, see “Basic Setup
Menu Operations” (page 110).

1 Select “FILE” > “All” in the setup
menu.

To assign a name to the data before saving
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files”
(page 165).

Select “All Save SxS” > “Execute.”
When saving to a USB flash drive (UDF,
exFAT modes), select “All Save USB” >
“Execute.”

Press the MENU knob.

An All file list box appears.

File numbers where “No File” is displayed
are empty file numbers.

File numbers with a file name or a date and
time are the number of files that already
contain data.



4 Select the file number under which you
want to save the data, and then press the
MENU knob.

A confirmation message appears.

To execute the save, select “Execute,”
and then press the MENU knob.

To cancel the save, select “Cancel,” and
then press the MENU knob.

If you choose to execute the save, the
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot
section). A completion message appears and
the ACCESS lamp goes out when the data
has been saved to the SxS memory card.

If saving to a USB flash drive, the ACCESS
lamp does not light up.

If an error message appears

One of the following error messages may appear
during execution of the save, or as soon as you
select “Execute.” In this case, the file is not saved
to the SxS memory card.

Error message Problem Solution
NG:Cannot Save No recordable Insert
media is recordable
inserted. media.
NG:Media Full The media is Use media with
full. free capacity
remaining.

To assign names to files

Assigning a name before you save data in an ALL
file can make it easier to distinguish your files.
The following characters can be used in file
names.

Alphanumeric characters (a—z, A—Z, 0-9) and
special characters (! #$ % &' () *+,-./:;<=
>?7@([\]~)

elec > > “File in the
1 Select “FILE” > “AIl” > “File ID” in th
setup menu.

Turn the MENU knob to select a
character, and then press the MENU
knob.

Repeat step 3.

When you have finished entering
characters, press the MENU knob to
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move the cursor to “SET,” and then
press the MENU knob.

The specified name is displayed.

When you save the file (see page 164), the
data will be saved under this name.

Loading Settings Data
[ Note |

When you load a file from an SxS memory card or USB
flash drive (UDF, exFAT modes), the data saved in the
camcorder’s internal memory is overwritten.

For details about menu operations, see “Basic Setup
Menu Operations” (page 110).

1 Select “FILE” > “All” in the setup
menu.

2

Select “All Load SxS” > “Execute.”
When loading from a USB flash drive (UDF,
exFAT modes), select “All Load USB” >
“Execute.”

Press the MENU knob.

An All file list box appears.

File numbers where “No File” is displayed
are empty file numbers.

File numbers with a file name or a date and
time are the number of files that already
contain data.

Select the desired file number, and then
press the MENU knob.
A confirmation message appears.

To execute the load, select “Execute,”
and then press the MENU knob.

To cancel the load, select “Cancel,” and
then press the MENU knob.

If you choose to execute the load, the
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot
section). The ACCESS lamp goes out and a
completion message appears when the data
has been loaded from the SxS memory card.
If saving to a USB flash drive, the ACCESS
lamp does not light up.

If an error message appears

One of the following error messages may appear
during execution of the load, or as soon as you
select “Execute.” In this case, the file is not



loaded from the SxS memory card or USB flash
drive.

Error message Problem Solution
NG:No Data « There is no Insert the
readable media that
media .
contains the
¢ The specified £l i
file does not tle you want.
exist on the
media

Resetting a File after Changing Its
Contents

For details about menu operations, see “Basic Setup
Menu Operations” (page 110).

1 Select “FILE” > “All” in the setup
menu.

Select “All Preset,” and then press the
MENU knob.

To execute the reset, select “Execute,”
and then press the MENU knob.

To cancel the reset, select “Cancel,” and
then press the MENU knob.

If you choose to execute the reset, all settings
in the ALL file are reset to preset values.
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Saving and Loading
Scene Files

Scene files allow you to save the following types

of data.

* Values set in the PAINT menu

« Shutter speeds set in standard mode or ECS
mode

* White balance data
The data that is saved and loaded depends on the
setting of “FILE” > “Reference” > “Scene
White Data” in the setup menu.

Saving Scene Files

Insert an SxS memory card into a memory card
slot, then proceed as follows.

For details about menu operations, see “Basic Setup
Menu Operations” (page 110).

1 Select “FILE” > “Scene” in the setup
menu.

To assign a name to the data before saving
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files”
(page 165).

Select ““Scene Store SxS” > “Execute.”
When saving to internal memory, select
“Scene Store Mem” > “Execute.” When
saving to a USB flash drive (UDF, exFAT
modes), select “Scene Store USB” >
“Execute.”

Press the MENU knob.

A list box of scene files appears. File
numbers where “No File” is displayed are
empty file numbers.

File numbers with a file name or a date and
time are the number of files that already
contain data.

Select the file number under which you
want to save the data, and then press the
MENU knob.

A confirmation message appears.



9 To execute the save, select “Execute,”

and then press the MENU knob.

To cancel the save, select “Cancel,” and
then press the MENU knob.

If you selected Scene Store SxS in step 2, the
ACCESS lamp lights when you execute the
save (in blue on the right-side panel and in
orange in the card slot section).

When the data has been saved to the SxS
memory card, a completion message appears
and the ACCESS lamp goes out.

If saving to internal memory or a USB flash
drive, the ACCESS lamp does not light up.

Loading Scene Files

Insert an SxS memory card into a memory card
slot, then proceed as follows.

For details about menu operations, see “Basic Setup
Menu Operations” (page 110).

1

Select “FILE” > “Scene” in the setup
menu.

Select “Scene Recall SxS” > “Execute.”
When loading from internal memory, select
“Scene Recall Mem” > “Execute.” When
loading from a USB flash drive (UDF,
exFAT modes), select “Scene Recall USB” >
“Execute.”

Press the MENU knob.

A list box of scene files appears. File
numbers where “No File” is displayed are
empty file numbers.

File numbers with a file name or a date and
time are the number of files that already
contain data.

Select the desired file number, and then
press the MENU knob.
A confirmation message appears.

To execute the load, select “Execute,”
and then press the MENU knob.

To cancel the load, select “Cancel,” and
then press the MENU knob.

If you selected “Scene Recall SxS” in step 2,
the ACCESS lamp lights when you execute
the load (in blue on the right-side panel and
in orange in the card slot section).
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When the data has been loaded from the SxS
memory card, a completion message appears
and the ACCESS lamp goes out.

If saving to internal memory or a USB flash
drive, the ACCESS lamp does not light up.



Saving and Loading
Lens Files

Setting Lens File Data

Set the datain lens files on “FILE” (see page 156)
“Lens” in the setup menu .

You can set the following data and save it as a
lens file.

Settings data Sub-item

V modulation shading M V Modulation

compensation values

Lens Center H
Lens Center V

Center marker position

Lens R Flare
Lens G Flare
Lens B Flare

Flare level

Lens W-R Offset
Lens W-B Offset

White balance
compensation value

White shading L R/G/B H Saw
compensation value L R/G/B H Para
L R/G/B V Saw

L R/G/B V Para

For details about menu operations, see “Basic Setup
Menu Operations” (page 110).

Saving Lens Files

Insert an SxS memory card into a memory card
slot, then proceed as follows.

For details about menu operations, see “Basic Setup
Menu Operations” (page 110).

1 Select “FILE” > “Lens” in the setup
menu.

To assign a name to the data before saving
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files”
(page 165).

Select “Lens Store SxS” > “Execute,”
and press the MENU knob.

When saving to internal memory, select
“Lens Store Mem” > “Execute.” When
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saving to a USB flash drive (UDF, exFAT
modes), select “Lens Store USB” >
“Execute.”

Press the MENU knob.

A list box of lens file number appears. File
numbers where “No File” is displayed are
empty file numbers.

File numbers with a file name or a date and
time are the number of files that already
contain data.

Select the file number under which you
want to save the data, and then press the
MENU knob.

A confirmation message appears.

To execute the save, select “Execute,”
and then press the MENU knob.

To cancel the save, select “Cancel,” and
then press the MENU knob.

If you selected Lens Store SxS in step 2, the
ACCESS lamp lights when you execute the
save (in blue on the right-side panel and in
orange in the card slot section). When the
data has been saved to the SxS memory card,
a completion message appears and the
ACCESS lamp goes out.

If saving to internal memory or a USB flash
drive, the ACCESS lamp does not light up.

Loading Lens Files

Insert an SxS memory card into a memory card
slot, then proceed as follows.

For details about menu operations, see “Basic Setup
Menu Operations” (page 110).

1 Select “FILE” > “Lens” in the setup
menu.

2

Select “Lens Recall SxS” > “Execute.”
When loading from internal memory, select
“Lens Recall Mem” > “Execute.” When
loading from a USB flash drive (UDF,
exFAT modes), select “Lens Recall USB” >
“Execute.”

Press the MENU knob.

A list box of lens file number appears. File
numbers where “No File” is displayed are
empty file numbers.



File numbers with a file name or a date and
time are the number of files that already
contain data.

Select the desired file number, and then
press the MENU knob.
A confirmation message appears.

To execute the load, select “Execute,”
and then press the MENU knob.

To cancel the load, select ““Cancel,” and
then press the MENU knob.

If you selected “Lens Recall SxS” in step 2,
the ACCESS lamp lights when you execute
the load (in blue on the right-side panel and
in orange in the card slot section). When the
specified lens file has been loaded from the
SxS memory card, a completion message
appears and the ACCESS lamp goes out.

If saving to internal memory or a USB flash
drive, the ACCESS lamp does not light up.

Loading Lens Files Automatically

When you are using a lens that support serial

communication, you can set up the camcorder by

automatically loading the lens file that

corresponds to the lens settings (Lens Auto Recall

function).

To use the Lens Auto Recall function, set “FILE”

> “Lens” > “Lens Auto Recall” in the setup menu

to one of the following.

On: Load the lens file that corresponds to the
model name.

Off: Do not use the Lens Auto Recall function.

Serial Number: Load the lens file that
corresponds to the model name and serial
number (when the lens supports
communication of the serial number).

If the lens does not support communication of the

serial number, both settings load the lens file that

corresponds to the model name.
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Saving and Loading
User Files

You can save the USER menu setup status (menu
organization and settings) and current white
balance data as a user file.

Saving User Files

Insert an SxS memory card into a memory card
slot, then proceed as follows.

For details about menu operations, see “Basic Setup
Menu Operations” (page 110).

1 Select “FILE” > “User” in the setup
menu.

To assign a name to the data before saving
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files”
(page 165).

Select “User Save SxS” > “Execute.”
When saving to a USB flash drive (UDF,
exFAT modes), select “User Save USB” >
“Execute.”

Press the MENU knob.

A user file list box appears.

File numbers where “No File” is displayed
are empty file numbers.

File numbers with a file name or a date and
time are the number of files that already
contain data.

Select the file number under which you
want to save the data, and then press the
MENU knob.

A confirmation message appears.

To execute the save, select “Execute,”
and then press the MENU knob. To
cancel the save, select “Cancel,” and
then press the MENU knob.

If you choose to execute the save, the
ACCESS lamp lights (in blue on the right-



side panel and in orange in the card slot
section).

When the data has been saved, a completion
message appears and the ACCESS lamp goes
out.

If saving to a USB flash drive, the ACCESS
lamp does not light up.

To save USER menu settings as preset values
Select “Store User Preset” > “Execute” in step 2.

Loading User Files

‘When you load a file from an SxS memory card or USB
flash drive (UDF, exFAT modes), the data saved in the
camcorder’s internal memory is overwritten.

The data that is loaded varies depending on the

FILE > “User” > “Load Customize Data” and

“Load White Data” settings in the setup menu.

When “Load Customize Data” is “Off”’: USER
menu settings only are loaded.

When “Load Customize Data” is “On’’: USER
menu organization and settings are loaded.

When “Load White Data” is “Off”’: White
balance data is not loaded.

When “Load White Data” is “On’’: White
balance data is loaded.

For details about menu operations, see “Basic Setup
Menu Operations” (page 110).

1 Select “FILE” > “User” in the setup
menu.

2 Select “User Load SxS” > “Execute.”
When loading from a USB flash drive (UDF,
exFAT modes), select “User Load USB” >
“Execute.”

3 Press the MENU knob.
A user file list box appears.
File numbers where “No File” is displayed
are empty file numbers.
File numbers with a file name or a date and
time are the number of files that already
contain data.

4 Select the desired file number, and then
press the MENU knob.
A confirmation message appears.

9 To execute the load, select “Execute,”
and then press the MENU knob. To
cancel the load, select “Cancel,” and
then press the MENU knob.

If you choose to execute the load, the
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot
section).

When the data has been loaded, a completion
message appears and the ACCESS lamp goes
out.

If saving to a USB flash drive, the ACCESS
lamp does not light up.

To load USER menu settings as preset values
Select “Load User Preset” > “Execute” in step 2.



Chapler8

You can connect a control device such as an RM-B170/B750 Remote Control Unit or RCP-1001/1501
Remote Control Panel and operate this camcorder. For details about connection and operation of the
control device, see “Operating via the REMOTE Connector” (page 66).

Connecting External Monitors

Select the output signal and use an appropriate cable for the monitor to be connected.

HD/SD SDI
ouTt

BNC cable _J
(not supplied)

SDIIN

VIDEO IN

BNC cable (not supplied)

Regardless of whether the signal is HD or SD, the m
same status information and menus can be
displayed on the external monitor as those on the
viewfinder screen.

SD signals down-converted for output have the
following restrictions.

Images of 5S0P/50i/25P are output as PAL signals, those
of 59.94P/59.94i/29.97P are output as NTSC signals, and
those of 23.98P are output as 2-3 pulled-down NTSC
signals.
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HD/SD SDI OUT connectors (BNC type)

The camcorder has two HD/SD SDI OUT
connectors.

You can connect a monitor or switcher, or
recording device such as a VTR, etc., that
supports SDI.

The output from these connectors can be turned
on and off with “OPERATION” > “Input/
Output” > “SDI Output” in the setup menu (see
page 117).

For connection, use a BNC cable (not supplied).

HDMI connector

You can connect a monitor or recording device
such as a VTR, etc., that supports HDMI.

The output from this connector can be turned on
and off with “OPERATION” > “Input/Output” >
“HDMI Output” in the setup menu (see

page 117).

For connection, use an HDMI cable (not
supplied).

VIDEO OUT connector

You can connect a monitor or recording device
such as a VTR, etc., that supports analog
composite signals.

The analog composite signal output from this
connector is the same as the NTSC or PAL
encoded signal that is output from the HD/SD
SDI OUT connector when the setting of output is
SD signal (you can switch between NTSC and
PAL with “OPERATION” > “Format” >
“Country” in the setup menu (see page 115)).
To input the VIDEO OUT connector output
signal to an external analog composite device, it
may be necessary to change the input signal
setting of that external device to be matched with
the analog composite signal setting for the
VIDEO OUT connector.

To input camcorder output audio to an external
device such as a monitor or VIR or other
recording device, connect the audio output of the
AUDIO OUT connector to the audio input of that
external device.

For connection, use a BNC cable (not supplied).

i.LINK (HDV/DV) connector

The i.LINK (HDV/DV) connector supports HDV
and DV input/output. However, DV streams
cannot be recorded on this camcorder.

This connector can be used to connect a device
that supports i. LINK (HDV). The device type can
be a monitor, read/write device such as VTR or
HDD, or computer.

To input/output HDV signals

HDV input/output is supported when the video
format is an HDV compatible format (SP 1440/
59.94i, SP 1440/50i, or SP 1440/23.98P),
“OPERATION” > “Input/Output” >
“Output&i.LINK” in the setup menu is set to
“HD&HDV” or “SD&HDV,” and “Input/
Output” > “i.LINK I/O” is set to “Enable.”
When the video format is SP 1440/23.98P, a
59.94i HDV signal subjected to 2-3 pulldown
processing is output.

To input/output DV signals

DV input/output is supported under either of the

following conditions.

* “OPERATION” > “Input/Output” > “i. LINK I/
O” in the setup menu is set to “Enable” on SD
mode.

e In HD mode, the video format is other than DV
incompatible formats (HQ 1920/23.98P, HQ
1440/23.98P, and HQ 1280/23.98P),
“OPERATION” > “Input/Output” >
“Output&i.LINK” in the setup menu is set to
“SD&DV,” and “Input/Output” > “i.LINK I/O0”
is set to “Enable.”



Managing/Editing Clips
with a Computer

Using the ExpressCard Slot of a
Computer

If the computer is equipped with an ExpressCard/
34 or ExpressCard/54 slot, you can directly insert
the SxS memory card containing clips recorded
with this camcorder and access to the files.

Before operating clips, set the SxS memory card to the
read-only mode and make a backup copy to a computer
to protect data. Do the same when using a reader/
writer.

The SxS Device Driver Software and the UDF Driver
Software must be downloaded and installed on your
computer. For details about application software, see
“Software Downloads” (page 197).

« Operation is not guaranteed with all computers.

For support information for the driver, visit the
following URL:
http://www.sony.net/SxS-Support/

To the
ExpressCard slot

=

SxS memory
card Computer with SxS Device
Driver Software installed
On Windows

Check that a Removable Disk appears in My
Computer. This indicates normal status.

On Macintosh
An icon is displayed on the menu bar.

USB Connection with a Computer

Preparations

When you connect the camcorder to a computer
using a USB cable (not supplied), the memory
card in the slot is acknowledged as an extended
drive by the computer.

When two memory cards are mounted in this
camcorder, they are acknowledged as two
independent extended drives by the computer.

USB cable
(not supplied)

* When connecting the USB cable to the computer, be
careful to check the form and direction of the PC
connector.

¢ The camcorder does not work on the bus power from
the computer.

To start USB connection

When you connect a computer to the PC
connector with a USB cable (not supplied), the
message “Connect USB Now?” is displayed to
prompt you to confirm that you wish to enable the
USB connection.

If you select “Cancel” or push the MENU
CANCEL/PRST/ESCAPE switch down to the
ESCAPE side or if you disconnect the USB cable,
the message “Connect USB Now?” disappears.
If you select “Execute” and press the MENU
knob, the USB connection is enabled and this
camcorder is recognized as an extension drive.
You can carry out the same operations by using
the arrow buttons ({}, b, <=, =) (see page 16).
If the USB connection is enabled during
recording/playback operation, the operation is
stopped and the message “USB Connecting”
appears on the viewfinder screen.



At this time, the output signal from the VIDEO
OUT connector, HDMI connector, and HD/SD
SDI OUT connector changes to a black signal.

¢ The camcorder cannot be operated for recording,
playback, and so on while connected via USB.

* When the computer accesses the media loaded in the
camcorder, do not try to carry out the following
operations.

- Operating the camcorder (turning the power on/off,
switching the operation mode, etc.)

- Removing or loading a media from an active slot
(being accessed from the computer)

- Removing or connecting the USB cable

Disabling the USB connection

To disable the USB connection, follow the same
procedure as that for removing a device from the
computer.

To enable the USB connection again, first
disconnect the USB cable and then reconnect it.
The message “Connect USB Now?” appears
again.

If you connect the camcorder to the computer using an
i.LINK cable, you cannot use the computer to operate
files stored in a recording media loaded in the memory
card slot of this camcorder.

To remove an SxS memory card

On Windows

1 Click on the icon of “Safely Remove
Hardware” on the task bar of the
computer.

2 Select “Safely remove SxS Memory
Card - Drive(X:)” from the displayed
menu.

3 Check that the Safe To Remove
Hardware message appears then
remove the card.

0On Macintosh

Drag the SxS memory card icon on the desktop to
Trash.

If the SxS memory card icon is located in the
Finder, click on the eject icon on its side.

To use the application software

To copy clips to the local disk of your computer,
the dedicated application software must be
downloaded and installed on your computer. For
details about application software, see “Software
Downloads” (page 197).

Although the data regarding recorded materials
are stored over multiple files and folders, you can
easily handle the clips without considering such
data and directory structure by using the
dedicated application software.

If you operate, e.g. copy the clips on the SxS memory
card by using Explorer (Windows) or Finder
(Macintosh), the subsidiary data contained by the clips
may not be maintained.

To use a nonlinear editing system

For a nonlinear editing system, optional editing
software that corresponds to the recording
formats used with this camcorder is required.
Store the clips to be edited on the HDD of your
computer in advance, using the supplied
application Software.



Connecting an External
Device (i.LINK
Connection)

You can record the same images as those
recorded on the memory card in this camcorder
on an external device connected to the i. LINK
(HDV/DV) connector, or record the playback
picture of the external device on the memory card
in the camcorder.

When you connect the camcorder to a non-linear
editing system that supports HDV format, you
can edit the images recorded on the memory card
in the camcorder.

When you set “OPERATION” > “Input/Output” >
“Output&i.LINK” in the setup menu to “480P (570P),”
no signal is output from the HD/SD SDI OUT
connector.

Use the i.LINK (HDV/DV) connector only for one-to-
one i.LINK connection.

When you change a setting which affects output
signals from the i. LINK (HDV/DV) connector, such as
“HD/SD,” “HD System Line,” “System Frequency,”
and “Rec Format” under “OPERATION” > “Format”
in the setup menu or “i.LINK I/O” and “Down
Converter” under “OPERATION” > “Input/Output” in
the setup menu, disconnect the i.LINK cable and
change the setting.

Changing such a setting with the i.LINK cable
connected may cause improper operation of the
connected i.LINK device.

The external signal input via the i. LINK connection
that can be recorded on the camcorder is HDV streams
only. You cannot record DV streams via the i. LINK
connection.

Ani.LINK connection and USB wireless LAN module
cannot be used at the same time.

Do not connect an IFU-WLM3 to the external device
connector during i.LINK connections.

Recording the Camera Picture on
an External Device

The picture being shot with this camcorder is
output as an HDV or DV stream via the i. LINK
(HDV/DV) connector. It can be recorded on a
connected HDV or DVCAM recorder in
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synchronization with a recording start/stop
operation on this camcorder.

1 Perform the preparatory settings of the
camcorder.

* Set “OPERATION” > “Input/Output” >
“Output & i.LINK” in the setup menu (see
page 117) to “HD & HDV” or “SD &
HDV.”

HD & HDV or SD & HDV: To output an
HDV stream in HD mode when the
video format is set to an HDV
compatible format (SP 1440/59.94i,
SP 1440/50i, or SP 1440/23.94P)

SD & DV: To output a DV stream

Set “OPERATION” > “Input/Output” >

“i.LINK I/0” in the setup menu to

“Enable.”

Set “MAINTENANCE” > “Trigger Mode”

> “i.LINK Trigger Mode” in the setup

menu (see page 149) to “Both” or

“External.”

Both: To perform recording both on the
memory card in this camcorder and on
the external device

External: To perform recording only on
the external device

2 Set the external device to recording
standby status.

For operations of the external device, refer to
the operation manual of that device.

Start recording.
The external device starts recording in
synchronization.

The status of the external device is displayed in
the i.LINK status indication area (see page 26) on
the viewfinder screen.

Indicator Status of the external
device

STBY [0 In HDV recording standby

OREC §[II] In HDV recording

STBY i In DV recording standby

OREC ;[ In DV recording

* Operation may be different depending on the type of
external device.



When you execute the operation to make a recording

on the recording media loaded in the camcorder while
HDV signals are output from the i. LINK (HDV/DV)

connector, HDV signal output stops for about one

second before the recording starts, and then it resumes.

While you can record shot marks on the memory card
during recording, they are not added to the pictures
recorded on the external device.

Nonlinear Editing

You can transfer an HDV stream to a nonlinear
editing system connected via the i. LINK (HDV/
DV) connector.

The i.LINK (HDV/DV) connector of this camcorder is
a 6-pin connector. Check the number of pins of the
i.LINK connector on your computer and use an
appropriate i.LINK cable.

When searching pictures of this camcorder on the
computer, it may take some time until the display is
reflected on the computer.

If the playback clip is short or the playback starting
point is near the end of the clip, the i. LINK signal may
be interrupted between the clip and the next clip. When
you try to capture such a signal using the nonlinear
editing system, a malfunction may occur, depending
on the nonlinear editing software in use.

If you specify a search speed other than 4, 15, or 24
times normal with the nonlinear editing system, no
i.LINK signal is fed out. In such a case, the picture on
the viewfinder monitor may stay frozen.

High-speed playback picture may not be displayed on
the computer screen, depending on the nonlinear
editing software in use.

Setting on this camcorder
Set “OPERATION” > “Input/Output” > “i. LINK
I/O” in the setup menu to “Enable.”

For operations of the nonlinear editing software,
refer to the operation manual of the software.

Recording External Input Signals

The HDYV stream input from a device connected
via the i.LINK (HDV/DV) connector can be
recorded on an SxS memory card in this
camcorder. The timecodes superimposed on the
i.LINK input are recorded regardless of the
settings of the camcorder.

DV streams cannot be recorded.
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1 Set the external signal to a format that
can be recorded on the camcorder.
Select an HDV compatible format (SP 1440/
59.94i, SP 1440/50i, or SP 1440/23.94P) for
the video format.

Make the following settings with

“OPERATION” > “Input/Output” in

the setup menu (see page 117).

* Set “Output&i.LINK” to “HD&HDV”
or “SD&HDV.”

¢ Set “i.LINK I/0” to “Enable.”

* Set “Source Select” to “i.LINK.”

The input video is displayed on the

viewfinder screen or the monitor connected

to the VIDEO OUT connector.

Audio signals are output through the built-in

speaker, the headphones connected to the

EARPHONE connector, and the speakers of

the monitor connected to the VIDEO OUT

connector.

3 Start the recording.

¢ An error is generated in the following cases. In such a

case, cancel Recording mode.

- The video format of input signal does not match that
specified on the camcorder.

- A copy-protected stream is being fed in.

If the input to the camcorder becomes no signal during

recording, the TALLY indicators, the tally indicator on

the front of the viewfinder, and the REC indication

(@REC) on the viewfinder screen flash, indicating that

no signal is being recorded on the SxS memory card.

When an input signal is resumed, recording is

restarted, incrementing the clip number on the memory

card.

The operation of all devices is not guaranteed when
recording simultaneously using the camcorder and
i.LINK.



Connecting USB Media

You can connect USB storage media (such as a
HDD or flash memory) to the OPTION connector
of the unit to copy clips between SxS memory
cards and USB media.

Supported USB Media

USB media that can be used with this unit must
satisfy the following criteria.

Capacity: 3 GB to 2 TB

Media with capacity less than 3 GB is not
recognized. Media with capacity exceeding 2 TB
is recognized as 2 TB media.

Format: exFAT

Only media formatted on the PMW-1000,
PMW-400, PMW-RX50, PMW-50, or this unit
can be used. Media formatted using other devices
may not operate correctly.

The recommended USB media are as follows.
* Sony PSZ-HAIT (1 TB)

« Sony PSZ-HA50 (500 GB)

« Sony PSZ-SA25 (256 GB)

« Sony HD-E1 (1 TB)

« Sony HD-EGS5 (500 GB)

The operation of the following USB media has
been verified.

¢ Lacie LCH-RGO005T3 (500 GB)

¢ Buffalo HD-PNT2.0U3-GBC (2 TB)

When valid USB media is connected, the USB
icon (see page 27) is displayed on the LCD
monitor.

The correct operation of HDD or USB flash drives that
meet the above criteria is not guaranteed.

This unit is compatible with USB media that operates
froma 5.0 V/0.5 A power source. The unit may not
recognize the USB media, depending on the media
used. In such cases, supply a separate power source.
Shooting of images cannot be recorded directly to USB
media.

Do not disconnect USB media while copying or
playing back clips on the media.
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* Do not connect/disconnect USB media while the
camcorder is turned on. It may cause of a malfunction
of the camcorder or USB media.

Copying Clips

To copy from SxS memory cards to USB media
Copy clips recorded on SxS memory cards to
USB media by selecting “USB Set” > “Copy To
USB” in the MAINTENANCE menu when the
thumbnail screen is displayed.

The copy destination folder is specified using
“USB Set” > “Select Folder” in the
MAINTENANCE menu. If no folder is selected,
a new folder is created and files are copied to it.
The name of the new folder uses the recording
date of the first clip on the source SxS memory
card. If “A&B—USB?” is selected, clips on the
selected SxS memory card are saved in the folder
specified using “Select Folder,” and clips on the
unselected SxS memory card are saved in a new
folder.

You can also copy clips by selecting them on the
thumbnail screen. Select the clips and then select
“Copy Clip” > “Copy Clip(A)” or “Copy
Clip(B)” from the THUMBNAIL menu.

To copy all clips using an assignable switch
Assign the Quick Backup function to an
assignable switch, then press the assignable
switch to copy all clips on the selected SxS
memory card to USB media.

A new folder is created and files are copied to it.

To copy from USB media to SxS memory cards
Copy clips recorded on USB media to the selected
SxS memory card by selecting “USB Set” >
“Copy From USB” in the MAINTENANCE
menu, when selecting the folder by using “USB
Set” > “Select Folder” in the MAINTENANCE
menu.

Error checking

You can turn on error checking when copying
clips between USB media and SxS memory cards
by setting “USB Set” > “Error Check” to “On” in
the MAINTENANCE menu. If an error message
appears, try copying the clip again.

Copying with error checking enabled takes
approximately twice the time as when error
checking is disabled.



Displaying the USB Media
Thumbnail Screen

Select “USB Set” > “USB Thumbnail” in the
MAINTENANCE menu to display the thumbnail
screen for clips recorded on USB media. When
selecting the folder by using “USB Set” > “Select
Folder” in the MAINTENANCE menu, you can
also assign the USB Thumbnail function to an
assignable switch, then press the switch to display
the USB media thumbnail screen.
The operations that can be performed on the USB
media thumbnail screen are basically the same as
those for the SxS memory card thumbnail screen,
although with the following differences.
* Functions that are not available

- Adding and deleting shot marks

- Adding and deleting OK/NG/KP flags and

OK marks

- Setting index pictures

- Splitting clips
* Dropped frames and other issues may occur

when playing back clips recorded on USB

media.

THUMBNAIL menu

Item Function

Clip Properties  Displays the clip detailed
information screen (see
page 99).

Copy Clip (A) Copies the selected clips to the
Copy Clip (B) SxS memory card in slot A or
slot B (see page 103).

Copy Clip (USB) Copies the selected clips to a
USB media (see page 103).

Delete Clip Deletes the clip (see page 104).
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Configuring a Shooting and Recording System

If you install the optional CBK-CEO! on this camcorder, you can attach the CA-FB70/TX70 Camera
Adaptor and connect a camera control unit. This allows you to configure a shooting and recording system
by connecting multiple camcorders, camera control units, and remote control units.

For more information about the CA-FB70 and CA-TX70, refer to their respective operation manuals.

‘When using the camcorder in this system, do not connect a video light to the camcorder.

Tally and Call indication

The following table shows the tally or call indication when configuring system.

Recording | Receiving data via LED indicator of Character display in the viewfinder

status communication DXF

- Tally |Green |Call |Call from |[REC/ GREEN |“@” (red) |“@”(green) |“CALL”

Tally |from |otherthan |TALLY & TAKE |indicator indicator indicator
CA CA LED TALLY
LED

OFF |OFF |OFF |OFF OFF OFF No display |No display |No display
OFF |OFF |OFF |ON ON OFF “@” (red) |Nodisplay |“CALL” (red)
OFF |OFF |ON |OFF OFF OFF No display |No display |“CALL” (red)
OFF |OFF |ON |ON ON OFF “@” (red) |Nodisplay |“CALL” (red)
OFF |ON |OFF |OFF OFF ON No display |“@” (green) |No display
OFF |ON |OFF |ON ON ON “@” (red) |“@” (green) | “CALL” (red)
OFF |ON |ON |OFF OFF ON No display |“@” (green) | “CALL” (red)
OFF |[ON |ON |ON ON ON “@” (red) |“@” (green) | “CALL” (red)
ON |OFF |OFF |OFF ON OFF “@” (red) |Nodisplay |No display
ON |OFF |OFF |ON OFF OFF No display |No display |“CALL” (red)
ON |OFF |ON |OFF ON OFF “@” (red) |Nodisplay |“CALL” (red)
ON |OFF |[ON |ON OFF OFF No display |No display |“CALL” (red)
ON |ON |OFF |OFF ON ON “@” (red) |“@” (green) |No display
ON |ON |OFF |ON OFF ON No display |“@” (green) | “CALL” (red)
ON |ON |ON |OFF ON ON “@” (red) |“@” (green) | “CALL” (red)
ON |ON |ON |ON OFF ON No display |“@” (green) | “CALL” (red)

While the CA-FB70/TX70 Camera Adapter is connected, alarm indication by the tally lamp that is listed in “Warning
Indication” is not performed.
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Chapterg

Check the functions of the camcorder before
setting out for a shooting session, preferably by
recording and playing back video and audio
signals.

Cleaning the Viewfinder

Use a dust blower to clean the lens, the LCD
screen, and mirror inside the viewfinder barrel.

Never use organic solvents such as thinners.

Note about the Battery Terminal

The battery terminal of this unit (the connector for
battery packs and AC adaptors) is a consumable
part.

Power may not be supplied to the unit properly if
the pins of the battery terminal are bent or
deformed by shock or vibrations, or if they
become corroded due to prolonged outdoor use.
Periodic inspections are recommended to keep
the unit working properly and to prolong its
usable lifetime.

Contact a Sony service or sales representative for
more information about inspections.



Error/Warning System

If a problem occurs when the camcorder is powered or is being operated, a warning is issued by various

visible and audible indicators.

 Error/warning message (“A” in the “Layout of the table of warning messages” below)

¢ WARNING indicator (“B”), warning sound from the speaker and earphones (“C”), tally/REC indication
(“D”), and battery remaining indicator (“E”).

A warning message, and the REC indication appear on the viewfinder screen.

The volume of the warning sound can be adjusted with the ALARM knob. Set the ALARM knob to the

minimum position to suppress the sound.

How to read the table

WARNING indicator |Warning sound Tally/REC Battery remaining
B C D E
< Problem Operation in the Solution

recorder module

« The operation of the WARNING indicator, the tally/REC indication, and the battery indicator is
represented by graphic symbols as follows.
?\%: Continuous
8- : 1 flash/s
- : 4 flash/s
* The warning sounds are represented by graphic symbols as follows.
)M : Continuous beep
MM : 1 beep/s

Error Indication

recorder module

WARNING indicator |Warning sound Tally/REC Battery remaining
— )M —jo:))):— —
Problem Operation in the Solution

The camcorder is
abnormal.

Recording stops.

Turn off the power and confirm whether an error
occurs on the connected devices, the cables, and
the media or not.

(If power cannot be turned off by setting the
POWER switch to OFF, remove the battery pack
or the AC power source.)

If the problem continues after the camcorder is
restarted, contact your Sony service
representative.




Warning Indication

Media Near Full

Media Full

Battery Near End

Battery End

Temperature High

Voltage Low

WARNING indicator |Warning sound Tally/REC Battery remaining
{o::— )N B : S —
Problem Operation in the Solution

recorder module

Free space on the SxS

Recording continues.

Replace it with another at the earliest

memory card has become opportunity.

insufficient.

WARNING indicator |Warning sound Tally/REC Battery remaining
&% )M 50:))):— —

Problem Operation in the Solution

recorder module

No space is left on the
SxS memory card.
Recording, clip copying
and clip division cannot
be performed.

Recording stops.

Replace it with another.

WARNING indicator |Warning sound Tally/REC Battery remaining
5.::— )N 5#3 5#3
Problem Operation in the Solution

recorder module

The battery power will be
exhausted soon.

Recording continues.

Charge the battery pack at the earliest

opportunity.

WARNING indicator |Warning sound Tally/REC Battery remaining
?\% )M {0:)))3 {#3
Problem Operation in the Solution

recorder module

The battery pack is
exhausted. Recording
cannot be performed.

Recording stops.

Connect a power source via the DC IN connector
or stop operation to charge the battery pack.

WARNING indicator |Warning sound Tally/REC Battery remaining
{o::— )N e : - -
Problem Operation in the Solution

recorder module

The internal temperature
has risen above a safe
operation limit.

Recording continues.

Suspend operation, turn off the power, and wait
until the temperature falls.

WARNING indicator |Warning sound Tally/REC Battery remaining
g.:g )N 5#3 5#3
Problem Operation in the Solution
recorder module
The DC IN voltage has  |Recording continues. Check the power supply.

become low (stage 1).
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Insufficient Voltage

Please disconnect i. LINK

b
D
L =
I3
£
=R &
=
£5
I3
R 2
x
D
3
-9

Backup Battery End

Unknown Media(A)"

Need to Reboot

Please Change.

Please Change.

WARNING indicator |Warning sound Tally/REC Battery remaining
e )M ot > S
Problem Operation in the Solution

recorder module

The DC IN voltage is too

Recording stops.

Connect other power source.

low (stage 2).

Recording cannot be

performed.

WARNING indicator | Warning sound Tally/REC Battery remaining
Problem Operation in the Solution

recorder module

You cannot use both an
i.LINK connection and
an IFU-WLM3
connection at the same
time.

Recording continues.

Turn off the power, and disconnect either the
i.LINK or IFU-WLM3.

WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the
recorder module

Solution

An error was detected
with the battery pack.

Recording stops.

Replace the battery pack with a normal one.

WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the
recorder module

Solution

The remaining power of
the backup battery is

Recording continues.

Refer to a Sony service representative to replace
the battery with a new one.

insufficient.
WARNING indicator |Warning sound Tally/REC Battery remaining
Problem Operation in the Solution

recorder module

A partitioned memory
card or one that contains
recorded clips exceeding
the number permitted
with this camcorder is
loaded.

Recording continues.

It cannot be used with this camcorder. Replace it
with another card.

183



WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the
recorder module

Solution

The maximum number of
clips for a single memory
card is reached. No more
clip can be recorded on
the card.

Reached Clip Number Limit

Recording stops.

Replace it with another card.

WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the
recorder module

Solution

An error occurred with
the memory card. The
card requires restoration.

Media Error

Recording stops.

Remove the card, load it again, and restore it.

WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the
recorder module

Solution

Recording cannot be
done, as the memory card
is defective.

Media Error
Cannot Record to Media(A)D Media(A)l) Needs to be Restored | Cannot Record to Me ia(Av)l)

Recording stops.

As playback may be possible, it is recommended
to replace it with another card after copying the
clips, as required.

WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the
recorder module

Solution

Neither recording nor
playback can be done, as
the memory card is
defective.

Media Error

Recording stops.

It cannot be operated with this camcorder.
Replace it with another card.

WARNING indicator

Warning sound

Tally/REC Battery remaining

Problem

Operation in the
recorder module

Solution

A card of a different file
system was inserted.

Cannot Use Media(A)V
Unsupported File System| Cannot Use Media(A)l)

Recording stops.

It cannot be used with this camcorder. Replace it
with another card.
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Video Format Mismatch

Copy Protected Input

=
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o
75}
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=
=
—
=
<
O
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a

Media Error
Playback Halted

Media(A)” Error

Cannot Record

1=
=]
1
3
&~
N
S
=1
=
&
S}

WARNING indicator

Warning sound

Tally/REC

Battery remaining

Problem

Operation in the
recorder module

Solution

The external signal input
via the i.LINK
connection cannot be
recorded, as the Video
Format setting is
different from the signal
format of the external
input signal.

Recording stops.

external signal.

Change settings of “OPERATION” > “Format”
in the setup menu to match it to that of the

WARNING indicator |Warning sound Tally/REC Battery remaining
Problem Operation in the Solution
recorder module
The external signal input |Recording stops. Check the input signal.
via the i.LINK
connection cannot be
recorded, as the stream is
copy-protected.
WARNING indicator | Warning sound Tally/REC Battery remaining
Problem Operation in the Solution
recorder module
The external signal input |Recording stops. —
via the i. LINK
connection cannot be
recorded, as itis a DV
stream.
WARNING indicator | Warning sound Tally/REC Battery remaining
Problem Operation in the Solution

recorder module

An error occurred in
reading data from the
memory card, and

Recording stops.

If this frequently occurs, change the memory
card after copying the clips, as required.

playback cannot be

continued.

WARNING indicator | Warning sound Tally/REC Battery remaining
Problem Operation in the Solution

recorder module

Recording cannot be
done, as an error
occurred with the
memory card.

Recording stops.

card.

If this frequently occurs, change the memory
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WARNING indicator

Warning sound

Tally/REC

Battery remaining

)M

Problem

Operation in the
recorder module

Solution

The battery power of the
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Recording continues.

Replace it with another at the earliest

recorder module

connected HDD will be opportunity.

exhausted soon.

WARNING indicator | Warning sound Tally/REC Battery remaining
5(‘?2 )M 5’:)))3 -

Problem Operation in the Solution

The battery of the
connected HDD is
exhausted. Recording
cannot be performed.

HDD A? Battery End

Recording stops.

Stop operation to change the battery.

WARNING indicator

Warning sound

Tally/REC

Battery remaining

(EVa

Problem

ge Media

Operation in the
recorder module

Solution

There is not enough
capacity for copying.

Recording continues

(copying not supported).

Replace the card in slot A with another one.

WARNING indicator

Warning sound

Tally/REC

Battery remaining

Problem

Operation in the
recorder module

Solution

The card has already ten
clips having the same
name as that you tried to
duplicate.

Chan

Recording continues

(copying not supported).

Replace the card in slot A with another one.

Not Enough Capacity | Reached Duplication Limit | Not Enough Capacity
Cannot Divide

recorder module

WARNING indicator |Warning sound Tally/REC Battery remaining
Problem Operation in the Solution
recorder module
There is not enough Recording continues —
capacity for dividing a (division not supported).
clip.
WARNING indicator | Warning sound Tally/REC Battery remaining
Problem Operation in the Solution

Will switch to other slot
soon.
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Recording continues.

Make sure that a memory card is loaded in the

other slot.
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WARNING indicator |Warning sound Tally/REC Battery remaining
& _ _ _ —
O Problem Operation in the Solution
2 recorder module
There is no clip to be Recording continues. —
displayed.
WARNING indicator |Warning sound Tally/REC Battery remaining
& |— - - -
: Problem Operation in the Solution
=) recorder module
)
Z There is no clip with the |Recording continues. —
OK mark.
WARNING indicator | Warning sound Tally/REC Battery remaining
g _ _ _ _
Problem Operation in the Solution

recorder module

The card has already
clips having the same
name as that you tried to
duplicate.

Same File Already Exists
Change Medial

Recording continues

(copying not supported).

Replace the card in slot A with another one.

WARNING indicator

Warning sound

Tally/REC

Battery remaining

Problem

Operation in the
recorder module

Solution

§ The memory card comes

A to the end of its service
life.

Recording stops.

Make a backup copy and replace the card with
another one as soon as possible.
Recording/playback may not be performed
properly if you continue to use the card.

For details, refer to the operating instructions of

the memory card.

WARNING indicator

Warning sound

Tally/REC

Battery remaining

Problem

Operation in the
recorder module

Solution

The inserted memory
card contains clips
recorded in a format that
is not supported by this
camcorder.

Unsupported Clip Included | Media Reached Rewriting Limit
Cannot Use Media (A)D

The card in slot A cannot be used with this

camcorder.

1) (B) for the card in slot B
2) B for a HDD connected to slot B
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I Appendix

Important Notes on
Operation

To use the camcorder safely, please read the
attached “Before Using this Unit.”

Use and storage

Do not subject the camcorder to severe shocks

¢ The internal mechanism may be damaged or the
body warped.

« If an accessory mounted on the accessory shoe
is subjected to severe shock, the accessory shoe
may be damaged. In such a case, stop using it
and contact your dealer or a Sony service
representative.

Do not cover the camcorder while operating
Putting a cloth, for example, over the camcorder
can cause excessive internal heat build-up.

After use
Always turn off the POWER switch.

Before storing the camcorder for a long period
Remove the battery pack.

Shipping

* Remove the media before transporting the
camcorder.

« If sending the camcorder by truck, ship, air or
other transportation service, pack it in the
shipping carton of the camcorder.

Care of the camcorder

Remove dust and dirt from the surfaces of the
lenses or optical filters using a blower.

If the body of the camcorder is dirty, clean it with
a soft, dry cloth. In extreme cases, use a cloth
steeped in a little neutral detergent, then wipe dry.
Do not use organic solvents such as alcohol or
thinners, as these may cause discoloration or
other damage to the finish of the camcorder.

In the event of operating problems
If you should experience problems with the

camcorder, contact a Sony service representative.
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Use and storage locations

Store in a level, ventilated place.

Avoid using or storing the camcorder in the

following places.

* Inexcessive heat or cold (operating temperature
range of 0 °C to 40 °C (32 °F to 104 °F)
Remember that in summer in warm climates the
temperature inside a car with the windows
closed can easily exceed 50 °C (122 °F).

* In damp or dusty locations

* Locations where the camcorder may be exposed
to rain

* Locations subject to violent vibration

* Near strong magnetic fields

* Close to radio or TV transmitters producing
strong electromagnetic fields.

* In direct sunlight or close to heaters for
extended periods

To prevent electromagnetic interference from
portable communications devices

The use of portable telephones and other
communications devices near this camcorder can
result in malfunctions and interference with audio
and video signals.

It is recommended that the portable
communications devices near this camcorder be
powered off.

Note on laser beams

Laser beams may damage the CMOS image
Sensors.

If you shoot a scene that includes a laser beam, be
careful not to let the laser beam be directed into
the lens of the camcorder.

Fitting the zoom lens

It is important to fit the lens correctly, as
otherwise damage may result. Be sure to refer to
the section “Mounting and Adjusting the
Supplied Lens” (page 36).

Viewfinder

Do not leave the camcorder with the eyepiece
pointing directly at the sun.



The eyepiece lens can concentrate the sun’s rays
and melt the interior of the viewfinder.

About the LCD panels

The LCD panel fitted to this unit is manufactured
with high precision technology, giving a
functioning pixel ratio of at least 99.99%. Thus a
very small proportion of pixels may be “stuck”,
either always off (black), always on (red, green,
or blue), or flashing. In addition, over a long
period of use, because of the physical
characteristics of the liquid crystal display, such
“stuck” pixels may appear spontaneously. These
problems are not a malfunction. Note that any
such problems have no effect on recorded data.

Condensation

If the unit is suddenly taken from a cold to a warm
location, or if ambient temperature suddenly
rises, moisture may form on the outer surface of
the unit and/or inside of the unit. This is known as
condensation. If condensation occurs, turn off the
unit and wait until the condensation clears before
operating the unit. Operating the unit while
condensation is present may damage the unit.

Phenomena specific to CMOS image
sensors

The following phenomena that may appear in
images are specific to CMOS (Complementary
Metal Oxide Semiconductor) image sensors.
They do not indicate malfunctions.

White flecks

Although the CMOS image sensors are produced

with high-precision technologies, fine white

flecks may be generated on the screen in rare

cases, caused by cosmic rays, etc. This is related

to the principle of CMOS image sensors and is

not a malfunction.

The white flecks especially tend to be seen in the

following cases:

* when operating at a high environmental
temperature

« when you have raised the master gain
(sensitivity)

* when operating in Slow-Shutter mode

The problem may be alleviated by executing

automatic black balance adjustment.
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Aliasing
When fine patterns, stripes, or lines are shot, they
may appear jagged or flicker.

Flicker

If recording is made under lighting produced by
discharge tubes, such as fluorescent, sodium, or
mercury-vapor lamps, the screen may flicker,
colors may vary, or horizontal stripes may appear
distorted.
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In such cases, set the flicker-reduction function to
auto mode (see page 148).

If the frame rate selected for recording is close to
the power-supply frequency, flicker may not be
reduced sufficiently even if you activate the
Flicker-Reduction function. In such cases, use the
electronic shutter.

Focal plane

Owing to the characteristics of the pickup
elements (CMOS image sensors) for reading
video signals, subjects that quickly move across
the screen may appear slightly skewed.

Flashband

The luminance at the top and bottom of the screen
may change when shooting a flashlight beam or a
light source that quickly flashes.

You can use the supplied application software to
correct clips that contain frames with flash bands.

Note on data compatibility with other
XDCAM EX-series products

When you use a PMW-EX1/EX3/EX30 to play
materials recorded on the camcorder, any media
in which clips of formats not supported by the
PMW-EX1/EX3/EX30 have been recorded
cannot be used.

The PMW-EX1/EX3/EX30 cannot divide a clip
recorded on this camcorder, even if the clip is in a
video format supported by the PMW-EX1/EX3/
EX30.



Fragmentation

If pictures cannot be recorded/reproduced
properly, try formatting the recording medium.
While repeating picture recording/playback with
a certain recording medium for an extended
period, files in the medium may be fragmented,
disabling proper recording/storage. In such a
case, make a backup of clips in the medium then
perform formatting of the medium using
“OPERATION” > “Format Media” (see

page 117) in the setup menu.
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Exchanging the Battery
of the Internal Clock

The camcorder’s internal clock is powered by a
lithium battery. If the message “BackUp Battery
End” appears in the viewfinder, this battery must
be exchanged. Contact a Sony service
representative.



Output Formats and Limitations

Video Formats and Output Signals

Output formats of the HD/SD SDI OUT connector and HDMI output connector

Output signal that is output from the SDI OUT connector or HDMI output connector corresponds to the
setup menu setting or format of played clip.

When recording: Format of the
OPERATION menu

When playing back: Video format of
the played video clip

Output format

Input/Output setting of the OPERATION menu

HD
HD&HDV

SD
SD&HDV
SD&DV

XAVC-I 1920/59.94i
XAVC-L50 1920/59.94i
XAVC-L35 1920/59.94i
XAVC-L25 1920/59.94i
HD422 1920/59.94
HD420 HQ1920/59.94i
HD420 HQ1440/59.94i
HQ1920/59.94i
HQ1440/59.94i
SP1440/59.94i

1920x1080/59.94i

720x480/59.94i

XAVC-I 1920/29.97P
XAVC-L50 1920/29.97P
XAVC-L35 1920/29.97P
HD422 1920/29.97P
HD420 HQ1920/29.97P
HD420 HQ1440/29.97P
HQ1920/29.97P
HQ1440/29.97P

1920x1080/29.97PsF

720x480/29.97PsF

XAVC-I 1920/23.98P
XAVC-L50 1920/23.98P
XAVC-L35 1920/23.98P
HD422 1920/23.98P

HD420 HQ1920/23.98P
HD420 HQ1440/23.98P
HQ1920/23.98P
HQ1440/23.98P

(23.98P Output: 2-3 Pull Down)

1920x1080/23.98PsF ©)
1920x1080/59.94i

720x480/59.94i 1

SP1440/23.98P
(23.98P Output: 2-3 Pull Down)

1920x1080/59.94i

720x480/59.94i 1

XAVC-I 1280/59.94P
XAVC-L50 1280/59.94P
HD422 1280/59.94P
HD420 HQ1280/59.94P

1280x720/59.94P

720x480/59.94i 2
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When recording: Format of the
OPERATION menu

When playing back: Video format of
the played video clip

Output format

Input/Output setting of the OPERATION menu

HD SD
HD&HDV SD&HDV
SD&DV

HD422 1280/29.97P
HD420 HQ1280/29.97P

1280x720/59.94P ¥ 720x480/29.97PsF

HD422 1280/23.98P
HD420 HQ1280/23.98P
(23.98P Output: 2-3 Pull Down)

1280x720/59.94P 4 720x480/59.94i 1

HQ1280/59.94P

HQ1280/29.97P

HQ1280/23.98P

720x480/59.94P 720x480/59.94i %)

720x480/29.97PsF

720x480/59.94i 1)

IMX 512/59.94i
DVCAM 480/59.94i
DVCAM 59.94i

720x480/59.94i

IMX 512/29.97P
DVCAM 480/29.97P
DVCAM 29.97P

720x480/29.97PsF

XAVC-I 1920/501
XAVC-L50 1920/50i
XAVC-L35 1920/50i
XAVC-L25 1920/50i
HD422 1920/50i
HD420 HQ1920/50i
HD420 HQ1440/50i
HQ1920/50i
HQ1440/50i
SP1440/50i

1920x1080/50i 720x576/501

XAVC-I 1920/25P
XAVC-L50 1920/25P
XAVC-L35 1920/25P
HD422 1920/25P
HD420 HQ1920/25P
HD420 HQ1440/25P
HQ1920/25P

HQ 1440/25P

1920x1080/25PsF 720x576/25PsF

XAVC-I 1280/50P
XAVC-L50 1280/50P
HD422 1280/50P
HD420 HQ1280/50P

HD422 1280/25P
HD420 HQ1280/25P

1280x720/50P 720x576/501

720x576/25PsF

HQ1280/50P

HQI280/25P

720x576/50P 720x576/50i V)

720x576/25PsF

IMX 608/50i
DVCAM 480/50i
DVCAM 50i

720x576/50i
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When recording: Format of the Output format

OPERATION menu Input/Output setting of the OPERATION menu
When playing back: Video format of
the played video clip HD SD

HD&HDV SD&HDV

SD&DV

IMX 608/25P 720x576/25PsF
DVCAM 480/25P
DVCAM 25P

1) Converted from 23.98P by 2-3 pull-down processing.

2) Converted from 59.94P.

3) Converted from 29.97P by displaying each 2 same pictures of 29.97P.

4) Converted from 23.98P by displaying each 2 or 3 same pictures of 23.98P.

5) Converted from 50P.

6) No signal is output from the HDMI OUT connector when 1920x1080/23.98PsF is output from the SDI OUT
connector.

Output formats of the VIDEO OUT connector

When the output signal from the SDI OUT or HDMI OUT connector is HD, the Y signal whose format is
the same as the output signal from the SDI OUT or HDMI OUT connector, is output from the VIDEO
OUT connector. When the output signal from the SDI OUT or HDMI OUT connector is SD, an analog
composite signal is output from the VIDEO OUT connector.

Output formats of the i.LINK (HDV/DV) connector

The output signal from the i. LINK (HDV/DV) connector corresponds to the setup menu setting or format
of the played clip, and output in the following format.

When you set “OPERATION” > “Format” > “File System” to “UDF” and “exFAT” in the setup menu,
no signal is output from the i.LINK (HDV/DV) connector.

When recording: Format of the  Output format

OPERATION menu Input/Output setting of the OPERATION menu
When playing !)ack: Yideo format HD&HDV SD&HDV SD&DV
of the played video clip
HQ1920/59.94i Input/output is not possible. DV (720x480/59.941)
HQ1440/59.94i
SP1440/59.94i HDV (1440x1080/59.94i) DV (720x480/59.941)
HQ1920/29.97P Input/output is not possible. DV (720x480/29.97PsF)
HQ1440/29.97P
HQ1920/23.98P Input/output is not possible.
HQ1440/23.98P
SP1440/23.98P HDV HDV DV (720x480/59.94i 2-3 pull-
(1440x1080/ (1440x1080/ down)
59.94i 2-3 pull-  59.94i 2-3 pull-
down) down)
HQ1280/59.94P Input/output is not possible. DV (720x480/59.94i Converted
from P to i)
HQ1280/29.97P Input/output is not possible. DV (720x480/29.97PsF)
HQ1280/23.98P Input/output is not possible.
DVCAM 59.94i - - DV (720x480/59.941)
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When recording: Format of the  Output format

OPERATION menu Input/Output setting of the OPERATION menu

When playing Pack: Yideo format HD&HDV SD&HDV SD&DV

of the played video clip

DVCAM 29.97P - - DV (720x480/29.97PsF)

HQ1920/50i Input/output is not possible. DV (720x576/50i)

HQ1440/501

SP1440/501 HDV (1440x1080/501) DV (720x576/501)

HQ1920/25P Input/output is not possible. DV (720x576/25PsF)

HQ 1440/25P

HQ1280/50P Input/output is not possible. DV (720x576/50i Converted from
Ptoi)

HQ1280/25P Input/output is not possible. DV (720x576/25PsF)

DVCAM 50i - - DV (720x576/501)

DVCAM 25P - - DV (720x576/501)

194



Output Signals and Operation Restrictions When a
Camcorder System is Configured (in HD Mode Only)

The table below shows output signals from the camcorder and operation restrictions to the camcorder
when it is connected with a camera adaptor and camera control unit to configure a shooting and recording

system.

When the camcorder is equipped with the CA-FB70/CA-TX70 HD Camera Adaptor, full HD signals
complying with the HD-SDI standard are transferred to the camera adaptor.

When configuring a camcorder system with a camera adaptor and camera control unit, install the optional CBK-CEO1 50
Pin Interface and Digital Extender. Set “OPERATION” > “Format” > “HD/SD” to “HD” in the setup menu.

Settings of Rec Format and SDI outputs to the

System Frequency under

OPERATION >Format in

the setup menu

camera adaptor

System format of the

camera adaptor and

camera control unit

Operation restrictions to the

camcorder

Genlock

Return video

display

XAVC-I 1920/59.94i
XAVC-L50 1920/59.94i
XAVC-L35 1920/59.94i
XAVC-L25 1920/59.94i
HD422 1920/59.94i
HQ1920/59.94i

HQ1440/59.94i

SP1440/59.94i

1920x1080/59.94i

XAVC- 1920/29.97P
XAVC-L50 1920/29.97P
XAVC-L35 1920/29.97P
HD422 1920/29.97P
HQ1920/29.97P

HQ1440/29.97P

1920x1080/29.97PsF

SP1440/23.98P

1920x1080/59.94i (2-
3PD)

1920x1080/59.94i

Available

Available

XAVC-T 1920/23.98P
XAVC-L50 1920/23.98P
XAVC-L35 1920/23.98P
HD422 1920/23.98P
HQ1920/23.98P

Output disabled

Not supported

Unavailable

Unavailable

HQ1920/23.98P®

1920x1080/59.94i (2-
3PD)

1920x1080/59.94i

Available

Unavailable

HQ1440/23.98P

Output disabled

Not supported

Unavailable

Unavailable

HQ1440/23.98P ™

1920x1080/59.94i (2-
3PD)

1920x1080/59.94i

Available

Unavailable
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Settings of Rec Format and SDI outputs to the System format of the Operation restrictions to the

System Frequency under  camera adaptor camera adaptor and camcorder

OPERATION >Format in camera control unit  Genlock Return video
the setup menu display
XAVC-I 1920/50i 1920x1080/50i 1920x1080/50i Available Available

XAVC-L50 1920/50i
XAVC-L35 1920/50i
XAVC-L25 1920/50i
HD422 1920/50i
HQ1920/50i
HQ1440/501
SP1440/50i
XAVC-I1920/25P 1920x1080/25PsF
XAVC-L50 1920/25P
XAVC-L35 1920/25P
HD422 1920/25P
HQ1920/25P
HQ1440/25P

XAVC-I 1280/59.94P 1280x720/59.94P 1280x720/59.94P Available Available
XAVC-L50 1280/59.94P

HD422 1280/59.94P

HQ1280/59.94P

XAVC-I 1280/50P 1280x720/50P 1280x720/50P Available Available
XAVC-L50 1280/50P

HD422 1280/50P

HQ1280/50P

a) PsF output
b) PD output
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Software Downloads

‘When the unit is used with a PC connection,
download any device drivers, plug-ins, and
application software you require from the
following websites.

Sony Professional products website:

US.A. http://pro.sony.com

Canada http://www.sonybiz.ca
Latin America http://sonypro-latin.com
Europe http://www.pro.sony.eu/pro

Middle East, Africa
http://sony-psmea.com

Russia http://sony.ru/pro/

Brazil http://sonypro.com.br
Australia http://pro.sony.com.au
New Zealand http://pro.sony.co.nz
Japan http://www.sonybsc.com
Asia Pacific http://pro.sony-asia.com
Korea http://bp.sony.co.kr
China http://pro.sony.com.cn
India http://pro.sony.co.in

Sony Creative Software, software download
page:

http://www .sonycreativesoftware.com/
download/software_for_sony_equipment
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Specifications

General

Power requirements
12V DC

Power consumption
Approx. 25 W

Main unit (camcorder) + LCD viewfinder + auto

focus lens + microphone
Power source for HD recording: 12 V DC

Approx. 30 W

Main unit (camcorder) + LCD viewfinder + auto

focus lens + microphone + CBK-WA101
Wireless Adapter
Power source for recording: 12 V DC

* Do not use a video light with power
consumption of over 50 W.

* When connecting a device to the DC OUT
connector, use one with current consumption

of 0.5 A or less.

Operating temperature
0 °C to 40 °C (32 °F to 104 °F)

Storage temperature
—20 °C to +60 °C (-4 °F to +140 °F)

Recording/playback formats

Video (XAVC)

XAVC-I mode: GBG, 112 Mbps max,
MPEG-4 AVC/H.264

XAVC-L50 mode: VBR, 50 Mbps max,
MPEG-4 AVC/H.264

XAVC-L35 mode: VBR, 35 Mbps max,
MPEG-4 AVC/H.264

XAVC-L25 mode: VBR, 25 Mbps max,
MPEG-4 AVC/H.264

Video (MPEG-2 Long GOP)

HD 422 mode: CBR, 50 Mbps max,
MPEG-2 422P@HL

HQ mode: VBR, 35 Mbps max,
MPEG-2 MP@HL

SP mode: CBR, 25 Mbps MPEG-2 MP@H-14

SD mode: MPEG IMX, DVCAM



Audio

<exFAT>

XAVC-I mode: LPCM 24-bit, 48 kHz,
4 channels

XAVC-L mode: LPCM 24-bit, 48 kHz,
4 channels

HD 422 50 mode: LPCM 24-bit, 48 kHz,
4 channels

HD 420 HQ mode: LPCM 16-bit, 48 kHz,
4 channels

SD MPEG IMX mode: LPCM 16/24-bit,
48 kHz, 4 channels

SD DVCAM mode: LPCM 16-bit, 48 kHz,
4 channels

<UDF>

HD 422 50 mode: LPCM 24-bit, 48 kHz,
4 channels

HD 422 HQ mode: LPCM 16-bit, 48 kHz,
4 channels

SD MPEG IMX mode: LPCM 16/24-bit,
48 kHz, 4 channels

SD DVCAM mode: LPCM 16-bit, 48 kHz,
4 channels

<FAT>

HD mode: LPCM 16-bit, 48 kHz, 4 channels

SD DVCAM mode: LPCM 16-bit, 48 kHz,
2 channels

Recording/playback time

<exFAT>

XAVC-I mode:
When using SBP-128B (128 GB):
Approx. 120 minutes
When using SBS-64G1A/SBP-64B
(64 GB): Approx. 60 minutes
When using SBS-32G1A (32 GB):
Approx. 30 minutes

XAVC-L50 mode:
When using SBP-128B (128 GB):
Approx. 240 minutes
When using SBS-64G1A/SBP-64B
(64 GB): Approx. 120 minutes
When using SBS-32G1A (32 GB):
Approx. 60 minutes

XAVC-L35 mode:
When using SBP-128B (128 GB):
Approx. 340 minutes
When using SBS-64G1A/SBP-64B
(64 GB): Approx. 170 minutes
When using SBS-32G1A (32 GB):
Approx. 85 minutes
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XAVC-L25 mode:
When using SBP-128B (128 GB):
Approx. 440 minutes
‘When using SBS-64G1A/SBP-64B
(64 GB): Approx. 220 minutes
‘When using SBS-32G1A (32 GB):
Approx. 110 minutes

HD 422 50/SD MPEG IMX mode:
‘When using SBP-128B (128 GB):
Approx. 240 minutes
‘When using SBS-64G1A/SBP-64B
(64 GB): Approx. 120 minutes
When using G49SBS-32G1A (32 GB):
Approx. 60 minutes

HD 420 HQ mode:
‘When using SBP-128B (128 GB):
Approx. 360 minutes
When using SBS-64G1A/SBP-64B
(64 GB): Approx. 180 minutes
‘When using SBS-32G1A (32 GB):
Approx. 90 minutes

SD DVCAM mode:
When using SBP-128B (128 GB):
Approx. 440 minutes
‘When using SBS-64G1A/SBP-64B
(64 GB): Approx. 220 minutes
‘When using SBS-32G1A (32 GB):
Approx. 110 minutes

<UDF>

HD 422 50/SD MPEG IMX mode:
When using SBP-128B (128 GB):
Approx. 240 minutes
‘When using SBS-64G1A/SBP-64B
(64 GB): Approx. 120 minutes
‘When using G49SBS-32G1A (32 GB):
Approx. 60 minutes

HD 420 HQ mode:
‘When using SBP-128B (128 GB):
Approx. 360 minutes
‘When using SBS-64G1A/SBP-64B
(64 GB): Approx. 180 minutes
When using SBS-32G1A (32 GB):
Approx. 90 minutes

SD DVCAM mode:
‘When using SBP-128B (128 GB):
Approx. 440 minutes
When using SBS-64G1A/SBP-64B
(64 GB): Approx. 220 minutes
‘When using SBS-32G1A (32 GB):
Approx. 110 minutes



<FAT>

HD HQ mode
‘When using SBP-128B (128 GB):
Approx. 400 minutes
When using SBS-64G1A (64 GB):
Approx. 200 minutes
When using SBS-32G1A (32 GB):
Approx. 100 minutes

HD SP mode:
When using SBS-64G1A (64 GB):
Approx. 560 minutes
When using SBS-64G1A/SBP-64B
(64 GB): Approx. 280 minutes
When using SBS-32G1A (32 GB):
Approx. 140 minutes

SD DVCAM mode:
When using SBP-128B (128 GB):
Approx. 520 minutes
When using SBS-64G1A/SBP-64B
(64 GB): Approx. 260 minutes
When using SBS-32G1A (32 GB):
Approx. 130 minutes

The actual recording/playback time may differ
slightly from the values shown here, depending
on usage conditions, memory characteristics,

etc.

Recording frame rate

<exFAT>

XAVC-I mode: CBG, 112 Mbps max,
MPEG-4 AVC/H.264
1920x1080/59.941, 50i, 29.97p, 25p,
23.98p
1280x720/59.94p, 50p

XAVC-L50 mode: MPEG-4 AVC/H.264,
50Mbps/VBR
1920x1080/59.94i, 501, 29.97p, 25p,
23.98p
1280x%720/59.94p, 50p

XAVC-L35 mode: MPEG-4 AVC/H.264,
35Mbps/VBR
1920x1080/59.941, 50i, 29.97p, 25p,
23.98p

XAVC-L25 mode: MPEG-4 AVC/H.264,
25Mbps/VBR
1920x1080/59.94i, 501

HD 422 50 mode: MPEG-2 422@HL,
50Mbps/CBR
1920x1080/59.94i, 50i, 29.97p, 25p,
23.98p
1280x720/59.94p, 50p, 29.97p, 25p,
23.98p

HD 420 HQ mode: MPEG-2 MP@HL,
35Mbps/VBR
1920x1080/59.94i, 50i, 29.97p, 25p,
23.98p
1440x1080/59.941, 50i, 29.97p, 25p,
23.98p
1280x720/59.94p, 50p, 23.98p
(2-3 pull down)

SD MPEG IMX mode:
720%x486/59.94i, 29.97PsF
720%x576/50i, 25PsF

SD DVCAM mode:
720%x480/59.94i, 29.97PsF
720%x576/50i, 25PsF

<UDF>

HD 422 50mode: MPEG-2 422P@HL,
50 Mbps/CBR
1920x1080/59.941, 50i, 29.97p, 25p,
23.98p
1280x720/59.94p, 50p, 29.97p, 25p,
23.98p



HD 420 HQ mode: MPEG-2 MP@HL,
35 Mbps/VBR
1920%1080/59.94i, 50i, 29.97p, 25p,
23.98p
1440%1080/59.941, 50i, 29.97p, 25p,
23.98p
1280%720/59.94p, 50p, 23.98p (2-3 pull
down)

SD MPEG IMX mode:
720%486/59.941, 29.97PsF
720%x576/50i, 25PsF

SD DVCAM mode:
720%x480/59.94i, 29.97PsF
720%x576/50i, 25PsF

<FAT>

HD HQ 1920 mode: MPEG-2 MP@HL,
35 Mbps/VBR
1920%1080/59.94i, 50i, 29.97p, 25p,
23.98p

HD HQ 1440 mode: MPEG-2 MP@HL,
35 Mbps/VBR
1440%1080/59.941, 50i, 29.97p, 25p,
23.98p

HD HQ 1280 mode: MPEG-2 MP@HL,
35 Mbps/VBR
1280%720/59.94p, 50p, 29.97p, 25p,
23.98p

HD SP 1440 mode: MPEG-2 MP@H-14,
25 Mbps/CBR
1440%1080/59.94i, 50i, 23.98p (2-3 pull
down)

SD DVCAM mode:
720%x480/59.94i, 29.97PsF
720%x576/50i, 25PsF

Continuous operation time
Approx. 194 min. (with the BP-L80S)

Mass
Main body only: 3.4 kg (7 1b 7.9 0z)

Dimensions

See page 203

Supplied accessories
See page 202

Camera

Imaging element
1/,-inch type CMOS
Effective picture elements: 1920 (H) x 1080 (V)

Format
3-chip RGB

Optical system

F1.6 prism system

Built-in filters
1: Clear
2:1/,ND
3:1/,(ND
4:1/,ND

Sensitivity
F11 (1920x1080/59.941)
F12 (1920x1080/50i)

Minimum illumination
0.04 1x
with 1920x1080/59.94i
(F1.6, 64-frame accumulation, +24 dB)

S/N ratio
60 dB (Y)

Horizontal resolution
1000 TV lines or more (1920x1080i mode)

Gain
-3,0,3,6,9,12,18,24dB

Shutter speed
1/60 to 1/2000 sec. + ECS (Extended Clear
Scan)

Shutter speed (Slow shutter (SLS))
2 to 8, 16, 32, 64 frames

Slow & Quick Motion
720: Frame rate is selectable from 1 fps to 60 fps
1080p: Frame rate is selectable from 1 fps to
30 fps

‘White balance
Preset (3200K), Memory A, Memory B/ATW
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Audio

Sampling frequency
48 kHz

Quantization
16 bits

Headroom
20 dB (factory default) (20, 18, 16, 12 dB)

Frequency response
MIC: 50 Hz to 20 kHz (within +3 dB)
LINE: 20 Hz to 20 kHz (within +3 dB)
WRR Analog: 50 Hz to 20 kHz (within +3 dB)
WRR Digital: 20 Hz to 20 kHz (within +3 dB)

Dynamic range
90 dB (typical)

Distortion
0.08% max. (with input level 40 dBu)

Built-in speaker
Monaural
Output: 300 mW

Display

Viewfinder

3.5-inch color LCD monitor: 960 (H) x 540 (V),
1/4 HD size

LCD screen
Black and white LCD (displays audio level, TC,
and remaining of the battery and media)

Media

Card slots
Type: ExpressCard/34
Number of slots: 2
Connector: Conforms to PCMCIA ExpressCard
Standard

Writing rate
200 Mbps or more

Reading rate
200 Mbps or more
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Inputs/Outputs

Input/Output connectors

Inputs

Audio input: XLR type, 3-pin, female (2)
Line/Mic/Mic +48 V selectable
—60 dBu/+4 dBu
(0 dBu =0.775 Vrms)

Microphone input: XLR type, 5-pin, female
—60 dBu

GENLOCK input: BNC type (1)
1.0 Vp-p, 75 ohms, unbalanced

Timecode input: BNC type (1)
0.5 V to 18 Vp-p, 10 kilohms

Outputs

Video output: BNC type (1), HD-Y or analog
composite

HDMI: Type A, 19-pin (1)

SDI output: BNC type (2), HD-SDI/SD-SDI
selectable

Audio output: XLR type, 5-pin, male
0 dBu

Timecode output: BNC type (1)
1.0 Vp-p, 75 ohms

Earphone output (stereo minijack) (1)
8 ohms, —eo to —18 dBs variable

Others

DC input: XLR type, 4-pin, male
11 Vto 17 VDC

DC output: 4-pin
11 V to 17 V DC, maximum rated current:
0.5 A

Lens: 12-pin
Supplies power to lens
11 Vto 17 V DC, maximum rated current:
1.0A

Remote: 8-pin

LIGHT: 2-pin

USB: 4-pin, Type B (1), Host Type A (1)

i.LINK: 6-pin (1), IEEE1394 compliant
HDV (HDV1080i)/DVCAM stream input/
output, S400

VF: 26-pin, rectangular, 20-pin round

For wireless receiver: D-sub 15-pin




Lens

Lens mount

Sony l/Z—inch type bayonet mount

Focal length
5.8 mm to 93 mm
(35 mm equivalent: 31.4 mm to 503 mm)

Zoom

Servo/Manual selectable

Zoom ratio
16x

Maximum relative aperture
1:1.9

Iris
Auto/Manual selectable
F1.9 to F16 and C (close)

Focus range
Auto/Manual selectable
Ranges:

800 mm (31 '/, inches) to eo (Macro OFF, wide

angle)

50 mm (2 inches) to e (Macro ON, wide angle)

782 mm (30 7/8 inches) to o (Macro ON,
telephoto)

Filter thread
M82 mm, 0.75 mm pitch

Macro
ON/OFF switchable

Supplied Accessories

Viewfinder (1)

Shoulder strap (1)

Stereo microphone (1)

Windscreen (1)

Cold shoe kit (1 set)

Lens mount cap

Flangeback (focal distance) adjustment chart
Auto focus lens (1)

Before Using this Unit (1)

Operating Instructions (CD-ROM) (1)
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Related Equipment

Power supply and related equipment

AC adaptor
AC-DN10/DN2B

Battery pack
BP-L80S

Battery charger
BC-L160/L500/L70

Lens, viewfinder and related equipment

Lens

]/Z—inch type bayonet mount lenses only

Viewfinder
DXF-20W/C50WA
CBK-VF02

Viewfinder rotation bracket
BKW-401

The BKW-401 can only be used with the viewfinder

supplied with the camcorder or the DXF-20W.
Equipment for remote control

Remote control unit
RM-B170/B750
RCP-1000/1500/1530
RCP-751/921
RCP-1001/1501

The command network unit (CNU) is not
supported.

50-pin interface and digital extender
CBK-CEO1

HD camera adaptor

CA-FB70/TX70 (when an optional CBK-CEO1

is installed)

‘When using SDIOUT2 with the CA-FB70
attached to the camcorder, use an L angle
bracket.

MPEG TS adaptor

HDCA-702 (when an optional CBK-CEO1 is

installed)

SDIOUT? cannot be used when the MPEG TS

adaptor is attached.




Wireless adaptor
CBK-WA101

USB wireless LAN module
IFU-WLM3

Media adaptor

MEAD-SDO?2 (for SDHC card)

XQaD ExpressCard adaptor

QDA-EX1 (for XQD memory card)

Recording media

SxS memory card
SxS PRO+ series
SxS PRO series
SxS-1 series

Dimensions

Audio equipment

Microphone
ECM-678/674/673/680S

Microphone holder
CAC-12

Wireless microphone
DWR-S02D
WRR-8555/860C/861/862

Other peripheral devices

Tripod adaptor
VCT-14/U14

Video light
UC-D200A (PROTECH)
Ultralight (Anton Bauer)

Pad

CBK-SP01 Soft Type Shoulder Pad

Equipment for maintenance and handling

Hard carrying case
LC-H300

Soft carrying case
LC-DS300SFT
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¢ Always make a test recording, and verify that it was
recorded successfully.

SONY WILL NOT BE LIABLE FOR DAMAGES
OF ANY KIND INCLUDING, BUT NOT
LIMITED TO, COMPENSATION OR
REIMBURSEMENT ON ACCOUNT OF
FAILURE OF THIS UNIT OR ITS RECORDING
MEDIA, EXTERNAL STORAGE SYSTEMS OR
ANY OTHER MEDIA OR STORAGE SYSTEMS
TO RECORD CONTENT OF ANY TYPE.
Always verify that the unit is operating properly
before use. SONY WILL NOT BE LIABLE FOR
DAMAGES OF ANY KIND INCLUDING, BUT
NOT LIMITED TO, COMPENSATION OR
REIMBURSEMENT ON ACCOUNT OF THE
LOSS OF PRESENT OR PROSPECTIVE
PROFITS DUE TO FAILURE OF THIS UNIT,
EITHER DURING THE WARRANTY PERIOD
OR AFTER EXPIRATION OF THE WARRANTY,
OR FOR ANY OTHER REASON WHATSOEVER.
SONY WILL NOT BE LIABLE FOR CLAIMS OF
ANY KIND MADE BY USERS OF THIS UNIT OR
MADE BY THIRD PARTIES.

SONY WILL NOT BE LIABLE FOR THE LOSS,
REPAIR, OR REPRODUCTION OF ANY DATA
RECORDED ON THE INTERNAL STORAGE
SYSTEM, RECORDING MEDIA, EXTERNAL
STORAGE SYSTEMS OR ANY OTHER MEDIA
OR STORAGE SYSTEMS.

SONY WILL NOT BE LIABLE FOR THE
TERMINATION OR DISCONTINUATION OF
ANY SERVICES RELATED TO THIS UNIT
THAT MAY RESULT DUE TO
CIRCUMSTANCES OF ANY KIND.

XDCAM, SxS, SxS PRO, SxS-1, XQD, i.LINK, and
i are registered trademarks of Sony Corporation.
The terms HDMI and HDMI High-Definition
Multimedia Interface, and the HDMI Logo are
trademarks or registered trademarks of HDMI
Licensing LLC in the United States and other
countries.

The ExpressCard word mark and logos are owned by
the Personal Computer Memory Card International
Association (PCMCIA) and any use of such marks by
Sony Corporation is under license. Other trademarks
and trade names are those of their respective owners.

The products or system names appearing in this

document are trademarks or registered trademarks of
their respective owners.
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Peripheral Devices and Accessories

HD monitor/SD monitor

Portable light
ECM-6805/678/673

[MT™1 Microphone

— CAC-12
Microphone Holder

CBK-VF02, DXF-20W
Viewfinder

DXF-C50WA
Viewfinder

PMW-RX50, PDW-HR1 XDCAM
HD series recorder

HDCAM series recorder

WRR-8555/860C/861/862
UHF Synthesized Tuner Unit

DWR-S02D Digital Wireless Receiver

‘ SxS memory card
| I_ MEAD-SD02 Media Adaptor

RE 7T~
PXW-X320

RM-B170/B750

5| RCP-1001/1501

33%| RCP-751/921

00| RCP-1000/1500/1530
Remote Control Unit

VCT-14/U14
Tripod adaptor

Tripod

LC-DS300 SFT @
) Soft Carrying Case

Hard carrying case
LC-H300

QDA-EX1 XQD ExpressCard Adaptor

IFU-WLMS3 USB Wireless LAN Module

——— | ﬁ CBK-WA101 Wireless Adaptor

CBK-CEO01 50-Pin Interface and Digital
Extender + HDCA-702 MPEG TS Adaptor

CBK-CEO01 50-Pin Interface and Digital Extender +
CA-FB70/TX70 HD Camera Adaptor

CCU (Camera Control Unit)

q :

BP-L80S BC-L70
Battery Pack Battery gct-tu 60
attery
Charger Charger

AC-DN10/DN2B BC-L160
AC Adaptor Battery
Charger

Demand Converter Box

a) The carrying case is large enough to hold the camcorder with lens and microphone mounted. However,
remove them if they protrude more than 25 cm (9 7/8 inches) from the front of the main unit.
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consumers. Disc replicators or sellers of the

About License PACKAGED MEDIA need to obtain licenses for

their own business from MPEG LA. Please
contact MPEG LA for any further information.
MPEG LA. L.L.C., 250 STEELE STREET,
SUITE 300, DENVER, COLORADO 80206
http://www.mpegla.com

MPEG-4 AVC Patent Portfolio ;
License About Bitmap Fonts

THIS PRODUCT IS LICENSED UNDER THE

AVC PATENT PORTFOLIO LICENSE FOR

THE PERSONAL USE OF A CONSUMER OR

OTHER USES IN WHICH IT DOES NOT

RECEIVE REMUNERATION TO This product uses RICOH Bitmap Fonts
produced and sold by Ricoh Company, Ltd.

(i) ENCODE VIDEO IN COMPLIANCE WITH

THE AVC STANDARD (“AVC VIDEO”) AND/

OR

(ii) DECODE AVC VIDEO THAT WAS

ENCODED BY A CONSUMER ENGAGED IN

A PERSONAL ACTIVITY AND/OR WAS

OBTAINED FROM A VIDEO PROVIDER

LICENSED TO PROVIDE AVC VIDEO.

NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE
OBTAINED FROM MPEG LA, L.L.C. SEE
HTTP://WWW .MPEGLA.COM

MPEG-2 Video Patent Portfolio
License

ANY USE OF THIS PRODUCT OTHER THAN
CONSUMER PERSONAL USE IN ANY
MANNER THAT COMPLIES WITH THE
MPEG-2 STANDARD FOR ENCODING
VIDEO INFORMATION FOR PACKAGED
MEDIA IS EXPRESSLY PROHIBITED
WITHOUT A LICENSE UNDER
APPLICABLE PATENTS IN THE MPEG-2
PATENT PORTFOLIO, WHICH LICENSE IS
AVAILABLE FROM MPEG LA, L.L.C., 250
STEELE STREET, SUITE 300, DENVER,
COLORADO 80206.

“PACKAGED MEDIA” means any storage

media storing MPEG-2 video information such as
DVD movie which are sold/distributed to general
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About OpenSSL

Because it uses the OpenSSL Toolkit, this product uses software developed by the OpenSSL Project
(http://www.openssl.org/).

OpenSSL License

/*
* Copyright (c) 1998-2008 The OpenSSL Project. All rights reserved.
%

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

F

* 1. Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.

3

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in

*  the documentation and/or other materials provided with the

*  distribution.

F3

* 3. All advertising materials mentioning features or use of this

* software must display the following acknowledgment:

*  "This product includes software developed by the OpenSSL Project

* for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

E3

* 4. The names "OpenSSL Toolkit" and "OpenSSL Project” must not be used to

* endorse or promote products derived from this software without

*  prior written permission. For written permission, please contact

*  openssl-core @openssl.org.

3

* 5. Products derived from this software may not be called "OpenSSL"

* nor may "OpenSSL" appear in their names without prior written

* permission of the OpenSSL Project.

E3

* 6. Redistributions of any form whatsoever must retain the following

* acknowledgment:

*  "This product includes software developed by the OpenSSL Project

*  for use in the OpenSSL Toolkit (http://www.openssl.org/)"

3

* THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “"AS IS" AND ANY
* EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
* PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
*ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
* SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
* NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
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* LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

* OF THE POSSIBILITY OF SUCH DAMAGE.

*

*

* This product includes cryptographic software written by Eric Young
* (eay @cryptsoft.com). This product includes software written by Tim
* Hudson (tjh@cryptsoft.com).

E3

%

Original SSLeay License

/* Copyright (C) 1995-1998 Eric Young (eay @cryptsoft.com)

* All rights reserved.

ES

* This package is an SSL implementation written

* by Eric Young (eay @cryptsoft.com).

* The implementation was written so as to conform with Netscapes SSL.
E3

* This library is free for commercial and non-commercial use as long as

* the following conditions are aheared to. The following conditions

* apply to all code found in this distribution, be it the RC4, RSA,

* lThash, DES, etc., code; not just the SSL code. The SSL documentation
* included with this distribution is covered by the same copyright terms

* except that the holder is Tim Hudson (tjh@cryptsoft.com).

E3
* Copyright remains Eric Young's, and as such any Copyright notices in

* the code are not to be removed.

* If this package is used in a product, Eric Young should be given attribution
* as the author of the parts of the library used.

* This can be in the form of a textual message at program startup or

* in documentation (online or textual) provided with the package.

%

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the copyright

* notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in the

* documentation and/or other materials provided with the distribution.

* 3. All advertising materials mentioning features or use of this software

* must display the following acknowledgement:

*  "This product includes cryptographic software written by

*  Eric Young (eay @cryptsoft.com)"

* The word 'cryptographic' can be left out if the rouines from the library

*  being used are not cryptographic related :-).

* 4. If you include any Windows specific code (or a derivative thereof) from
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* the apps directory (application code) you must include an acknowledgement:

*  "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

E3

* THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ““AS IS" AND

* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL

* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

* SUCH DAMAGE.

E3

* The licence and distribution terms for any publically available version or

* derivative of this code cannot be changed. i.e. this code cannot simply be

* copied and put under another distribution licence

* [including the GNU Public Licence.]

*/

About JQuery,Sizzle.js

This product uses the following software, released under MIT License.

jQuery JavaScript Library v1.7.2
http://jquery.com/
Copyright 2011, John Resig

Sizzle.js

http://sizzlejs.com/

Copyright 2011, The Dojo Foundation
Date: Wed Mar 21 12:46:34 2012 -0700

MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR

IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL
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THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE,
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.
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Index

A

AC power 29

ACCESS lamp 15,18, 61

Accessories 205

Accessory shoe 11

Adaptor connector 10

ALARM knob 13

Area setting 35

Arrow buttons (<=, =>, 4, &) 16

ASSIGN. 0 switch 13

ASSIGN. 1/2/3 switches 13

ASSIGNABLE 4/5 switches 18

Assignable switches 158

ATW (Auto Tracing White Balance) 14

Audio control section 16
protective cover 15

AUDIO IN CH-1/CH-2/CH-3/CH-4 switches
17

AUDIO IN CH1/CH2 connectors 20

AUDIO IN selector switches 20

Audio input system 38

Audio level
adjusting playback level 13
adjusting recording level 56
meters 21, 27

AUDIO LEVEL CH-1/CH-2/CH-3/CH-4

knobs 17

AUDIO OUT connector 20

AUDIO SELECT CH-1/CH-2 switches 17

AUDIO SELECT CH 3-4 switches 17

Auto focus lens 21

AUTO W/B BAL switch 12

BACKLIGHT button 16
Battery changing 190
Battery pack 29
attachment shoe 10
remaining capacity 21, 25
voltage display 25
BKW-401 33

Black balance, adjusting 48
BRIGHT control 23
Brightness adjustment 23
Brightness level indicator 27

C

Camera adaptor 10
Clip
batch copy 103
batch delete 104
copying 103
cueup 98
defining names 94
deleting 85, 104
dividing 106
managing/editing on a computer 173
operations 96
playback 85,97
properties 102
searching on expand thumbnail screen
98
searching on shot mark thumbnail screen
98
setting index picture 106
thumbnail selection 97
Clock 35
changing battery 190
COLOR TEMP. button 13
Color temperature
indicator 25
switching 50
Computer 173
Connection 171, 173
computer 173
i.LINK (HDV/DV) 175
monitor 171
Connector 23
Contrast adjustment 23
CONTRAST control 23

D

Date, setting 35

DC IN connector 10

DC OUT 12V connector 10

DCC (Dynamic Contrast Control) function
14

Depth of field indicator 26

Diopter adjustment ring 23



DISPLAY switch 16, 23

E

EARPHONE jack 19
E-E (Electric-to-Electric) 15

Electric color temperature filter indicator

Electrical CC filter
switching 50
Electronic shutter 51
ESSENCE MARK button 17
EXPAND button 16
Expand thumbnail screen
displaying 104
increasing number of divisions
Extender indicator 24
External device
connection 171
control indicator 26
recording 175
External device connector 18
External input
recording 176
setting indicator 27
External power input 25
Eyecup 23

F

F FWD button/indicator 15

F REV button/indicator 15

F-RUN/SET/R-RUN switch 17

Filter indicator 27

FILTER selector 12

Flange focal length, adjusting 36
button 22

Focus 55
mode indicator 26
position indicator 25
ring 22

FOCUS switch 21

Formatting (initializing) 62

Frame Rec function 89

Framing 92

Freeze mix function 92

G

GAIN selector 13
Gain value indicator 27
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GENLOCK IN connector 19
Green tally indicator 25

H

HD/SD SDI OUT connector 20, 172
HDMI output connector 18, 172
Histogram display 27

HOLD button 16

i.LINK
connection 175
i.LINK (HDV/DV) connector 20, 172
Independent AV file 97
Index picture 96
changing 106
Initial setting 111, 166
Input source indicator 27
Interval Rec function 88
Iris
auto setting 53
IRIS switch 22
position indicator 28
ring 22
IRIS switch 22

L
LCD Panel 15
Lens 21

cable clamp 11
locking lever 11
mount 11
mountcap 11
mount securing rubber 11
mounting 36
LENS connector 11
Lens files
loading 168
loading automatically 169
saving 168
setting 168
Level meters 27
LIGHT connector 11
LIGHT switch 10



MACRO switch 22
Maintenance 180
Media
protection (lock) 21
remaining capacity 21
remaining capacity indicator 27
status indicator 25
Menu
basic operations 110
MENU button 16
MENU CANCEL/PRST/ESCAPE switch
MENU knob 12
MENU ON/OFF switch 14
MIC IN (+48 V) connector 11
MIC LEVEL control 12
Microphone 38
Microphone holder 24
attachment shoe 11
MIRROR switch 24
Monitor 171
MONITOR knob 13
MONITOR switches 13

ND filter 12

NEXT button 15
Nonlinear editing 174, 176
Number of system lines 26

0

OK mark
setting 86
OK/NG/KP marks 102
Operation status indicator 25
i.LINK connection device 26
OUTPUT/DCC switch 14

P

PC connector 18

Peaking adjustment 23
PEAKING control 23
Peripheral devices 205
Picture Cache function 87
Planning metadata 93

PLAY/PAUSE button/indicator 15, 97
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Power supply 29

POWER switch 10
PRESET/REGEN/CLOCK switch 17
PREV button 15

PUSH AF button 21

PUSH AUTO button 22

R

REC START button 12
Recording 175
external device 175
external input signals 176
Recording mode 47
indicator 25
special mode indicator 26
special mode setting indicator 26
Recording review 84
REMOTE connector 20
Remote control unit 66
Remote control unit connection 66
Reset 111, 166
RESET/RETURN button 16
RET button 23
RM-B750 66

S

Scene files
loading 167
saving 166
SET button 16
Settings data
loading 165
saving 164
Settings/status monitoring 60
Setup menu 108
basic operations 110
FILE menu 153
MAINTENANCE menu 138
menu list 112
OPERATION menu 115
PAINT menu 132
THUMBNAIL menu 99
SHIFT button 17
Shooting 61
Shot mark
adding 106
adding during playback 98
defining names 95



deleting 106
recording 86
Shot mark thumbnail screen 105
Shoulder pad 11
adjusting position 43
Shoulder strap
attaching 42
attachment point 11
Shutter 51
Shutter speed 52
indicator 27
SHUTTER switch 12
Slide stopper 23
Slow & Quick 90
Slow & Quick motion shooting 90
Speaker 15
Specifications 197
Standard settings 111
STATUS ON/SEL/OFF switch 14
Status screen 60
assignable switches 60
audio 60
battery and media 60
camera 60
video 60
STOP button 15
Stop motion animation 89
Switch cover 14
SxS device driver software 173
SxS memory card 61
ejecting 61
exchanging 62
formatting 62
loading 61
remaining capacity 62
restoring 63
switching 61
SxS memory card slots 18
EJECT button 18
slot cover 18
SLOT SELECT button 18

T

TALLY indicator 19
Tally indicator 23
TALLY switch 19,23
TC IN connector 19
TC OUT connector 19
Testing 180
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Thumbnail
indicator 16
operations 99
THUMBNALIL button 16
THUMBNAIL menu 99
basic operations 101
Thumbnail screen
all clip thumbnail screen 101
changing screen type 101
control section protective cover
OK clip thumbnail screen 101
operations section 16
Time counter display 20
Time data 57
Time-lapse recording 88
Time, setting 35

Timecode
Indicator 27
Setting 57

synchronizing 58
TLCS control mode indicator 26
Tripod

mount 11

mounting 41

u

UHF portable tuner, attaching 40
USB connection 173

User bits setting 58

User files 169

v

VF connector 11

Video format 44, 103
indicator 26

Video level indicator 27

Video light 42

VIDEO OUT connector 19

Viewfinder 23
5-inch viewfinder 34
adjusting focus 32
adjusting position 30
adjusting screen 32
adjusting the angle 31
attachment shoe 11
cable 24
cleaning 180
front-to-back positioning knob

15
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left-to-right positioning ring 11
lifting up the barrel and eyepiece 31
positioning lever 11
rotation bracket 33
screen display 24

Voltage display 25

VTR button 23

w

WARNING indicator 15
Warning system 181
WHITE BAL switch 14
White balance
adjusting 49
memory indicator 27
Wi-Fi remote control 82
Wireless receiver reception level 25

z

Zebra pattern 23
ZEBRA switch 23
Zoom 54
control connector 22
position indicator 25
power zoom lever 22
ring 22
ZOOM switch 22
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